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About this Manual

Notations

The following notations may be used in this manual.

Microsoft Windows 8.1 64-bit Edition operating system — Windows 8.1(64bit version)*
Microsoft Windows Server 2012 R2 64-bit Edition operating system — Windows Server 2012
R2

Microsoft Windows 8 64-bit Edition operating system — Windows 8 (64bit version)*
Microsoft Windows Server 2012 64-bit Edition operating system — Windows Server 2012
Microsoft Windows 8.1 operating system — Windows 8.1*

Microsoft Windows Server 2012 R2 operating system — Windows Server 2012 R2*
Microsoft Windows 8 operating system — Windows 8*

Microsoft Windows Server 2012 operating system — Windows Server 2012*

Microsoft Windows 7 64-bit Edition operating system — Windows 7 (64bit version)*
Microsoft Windows Vista ™ 64-bit Edition operating system — Windows Vista (64bit
version)*

Microsoft Windows Server 2008 R2 64-bit Edition operating system — Windows Server 2008
R2

Microsoft Windows Server 2008 64-bit Edition operating system — Windows Server 2008
(64bit version)*

Microsoft Windows Server ™ 2003 x64 Edition operating system — Windows Server 2003
(x64 version)*

Microsoft Windows 7 operating system — Windows 7*

Microsoft Windows Vista ™ operating system — Windows Vista*

Microsoft Windows Server 2008 operating system — Windows Server 2008*

Microsoft Windows Server ™ 2003 operating system — Windows Server 2003*

Generic name for Windows, Windows 8.1, Windows Server 2012 R2, Windows 8, Windows
Server 2012, Windows 7, Windows Vista, Windows Server 2008 R2, Windows Server 2008,
Windows Server 2003 — Windows

If there is no special description, 64 bit version is included inWindows 8.1, Windows 8,
Windows Server 2012, Windows 7, Windows Vista, Windows Server 2008 and Windows
Server 2003.

MacOS 9.0/9.0.4/9.1/9.2/9.2.1/9.2.2 - MacOS

MacOS X 10.3 and later — Mac OS X

Generic name for MacOS 9.0/9.0.4/9.1/9.2/9.2.1/9.2.2, and Mac OS X 10.3 or later —
Macintosh

Terms

(Note') Cautions or restrictions that are required to operate this software correctly.

Be sure to read sections with this mark to ensure operations are performed correctly.

memo | INndicates information that is useful to know or refer to when using the software. You should

read sections with this mark.



Important

Trademark Information

OKI is a registered trademark of Oki Electric Industry Co., Ltd.

Microsoft, Windows, Windows Server, Windows Vista, Excel, and Active Directory are the
trademarks or registered trademarks of Microsoft Corporation in the United States and other
countries.

Macintosh and Mac OS are the trademarks or registered trademarks of Apple Computers Inc.
in the United States and other countries.

PageMaker is the trademark or registered trademark of Adobe Systems Incorporated in the
United States and other countries.

SD Memory Card is the trademark or registered trademark of SD Association.

Other product names and brand names are registered trademarks or trademarks of their
proprietors.

About This Manual

1. Unauthorized copying of this manual in whole or in part is strictly forbidden.

2. The contents of this manual may be changed at any time without prior notice.

3. Every effort has been made to ensure that the information in this document is complete,
accurate and up-to-date. However, in the unlikely event you find a mistake or missing entry,
please contact your local vendor.

4. While all reasonable efforts have been made to make this document as accurate and helpful
as possible, we make no warranty of any kind, expressed or implied, as to the accuracy or
completeness of the information contained herein.

Manual Copyright

Oki Data Corporation owns the entire copyright to this manual. Unauthorized reproduction,
transcription, and translation of this document are prohibited. You must obtain written
permission from Oki Data Corporation to reproduce, transcribe, or translate any sections of
this manual.

© 2013 Oki Data Corporation



License Agreement

Please read the following license agreement before using this software. This software includes
Print Job Accounting, Print Job Accounting Enterprise, Print Job Accounting Client, and all related
explanatory materials provided by Oki Data Corporation (hereinafter Oki Data). By using this
software, you are consenting to be bound by this agreement with Oki Data, and agree to the
conditions outlined herein.

. This software can only be used with the corresponding Oki Data printer.

The user is only permitted to install one copy of Print Job Accounting (or Print Job Accounting
Enterprise) on one computer. You are required to purchase additional software in order to use
this software on two or more computers.

Print Job Accounting Client can be installed an used on any number of computers.

. Ownership of all copyrights associated with this software and any copies therein belong to Oki
Data and any licenser who has been granted licensing rights by Oki Data. The customer is not
granted any rights to this software other than the rights described in this agreement. Other
than the installation described in article 1 above, the customer is not permitted to duplicate
this software in whole or in part, or to permit a third part to duplicate this software in whole
or in part. The customer agrees not to revise, modify, translate, reverse engineer, reverse
compile, or disassemble this software.

. The customer agrees not to rent, loan, lease, distribute, copy, or transfer this software in
any way. The customer also agrees not to forward, transfer, export or re-export this software
outside Japan, and not to use this software for any unlawful activities.

. If the customer violates any of the terms of this agreement, Oki Data can instruct the customer
to stop using the software and terminate the license agreement. In such a case in which the
license agreement is terminated, the customer shall cease use of the original software and all
copies, and destroy all copies of the software.

. Within a period of 90 (ninety) days from the purchase of this software, if a physical defect to
the recording media on which this software is stored prevent proper use of the software, Oki
Data will provide a replacement equivalent item. If the software does not operate correctly
for any other reason, Oki Data will provide a refund to the customer that is limited to the
equivalent cost paid for the software. However, Oki Data provides no warranty whatsoever
for any cases in which the software does not operate that are caused by accidents, improper
handling, or misuse of the software by the customer. Furthermore Oki Data provides no
warranty whatsoever against problems that arise due to interference from other software on
the customer's computer.

. The selection, use, and results of using this software are entirely the responsibility of the
customer.

. This software may be changed or improved with no prior warning. However, irrespective of
customer wishes, Oki Data is not obliged to provide any kind of maintenance service such as
bug fixes, modified contents, or revised editions of this software. Furthermore, Oki Data is not
obliged to provide the customer with bug information, details of modified contents, or other
such revision information of this software.

. Oki Data is not obliged to provide any kind of bug fixes or maintenance service for any
software manufactured by a different company that is provided with this software.
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1. Before Setup

1. Before Setup

This section explains the mechanisms and configuration of Print Job Accounting, and the
contents that need to be decided before setup.

What is Print Job Accounting?

Print Job Accounting sets detailed print restrictions on print jobs printed from computers
according to individual users and printers, and acquires and summarizes print job information
in a log.

Special Features of Print Job Accounting

Management of Print Restrictions
e Multiple users and printers can be put together into groups, and settings for allowing and disallowing
printing or color printing for each group can be configured.

e Settings for allowing or disallowing the printing or color printing of the login name, application name,
document name or host name can be configured.

e Upper limits for the number of prints can be set according to user, printer, user group and printer
group.

e Printing costs can be charged according to user and user group. Printing costs can be set according to
such factors as quantity and paper size. Also, different fees can be set for individual printers.

e Settings for allowing or disallowing printing or color printing can be configured for users or groups
registered in the Active Directory. (Only Enterprise edition)

e Printing costs can be charged according to users and groups in the Active Directory. (Only Enterprise
edition)
Log Acquisition and Summary

e Information included the printed date and time, user name, quantity and paper size can be acquired
and summarized in the log.

e The log can be output as a CSV file for use in commercially available spread sheet software.

e Information such as log information can also be saved in an SQL database and browsed from a web
browser. (Only Enterprise edition)

A CSV file is a text file separated by commas, and is a file format that is commonly used for
converting data between spread sheets and database management software.

Support for both Windows and Macintosh operating environments

e Both Windows and Macintosh operating environments are supported as client environments.

-12 -



1. Before Setup

Print Job Accounting Mechanisms

@ When the user sends a print job, @ the job information is stored as a log on the printer's
built-in hard disk or flash memory, and the (3) Print Job Accounting server software obtains
the log. The information obtained by the server software is deleted from the printer. @ The
log obtained in @ is saved to the SQL database. (Only Enterprise edition) @ User or group
information registered in the Active Directory is referenced. (Only Enterprise edition)

Client Computer @Printer PrintJob Accounting SQL Database Active Directory
Server Server Server

- 13 -



1. Before Setup

Print Job Accounting Configuration

Print Job Accounting server software (Windows)

This is a management tool for the system administrator. Registration of printers and users, and print

limitation settings can be configured. Also, the log is obtained and saved from the printer at a set
schedule.

This is called server software.

Print Job Accounting Client Software (Windows)

Install onto the Windows client computer.

Set the setting method (Job Accounting Mode) for setting the User Name and Job Account ID in the client
computer.

This is called Client Software.
Print Job Accounting Client Plugin (Mac 0OS)

This is automatically installed when the Mac OS PS printer driver is installed. A panel for setting the
UserName and JobAccountingID is added to the print dialog.

This is called a plugin.

Print Job Accounting Client Software (MacOS X)

This is installed in the Mac OS X client computer.

Set the Username and JobAccountingID on the client computer.
Only the Mac OS X PS printer driver is enabled.

This is called Client Software.

- 14 -



1. Before Setup

Print Job Accounting Installation Process

Setting up server software

Prepare Job Account ID, name and User Name

information.

¥

Installing the server software.

¥

If required, configure software that is related to the
server software. (Only Enterprise edition)

¥

Configure the printer in the server software.

¥

Register the Job Account ID and name.

Setting up Client Software

For Windows For Mac OS For Mac OS X
Install the Client Configure the plugins. Install the Client
Software. Software.

¥

Select Job Accounting
Mode.

- 15 -
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1. Before Setup

Preparing User Information

In Print Job Accounting, set the user for the server software and Client Software/plugin.
Before setup, it is necessary to decide which users will use the printer.
(Note!) e Users can be added/deleted at a later date. For details, see "Job Account ID management"
(page 48).

e When using in combination with Active Directory, it is not necessary to decide which
users will use the printer. For details, see "Syncing with Active Directory user information”
(page 102). (Only Enterprise edition)

Information required for settings

In order to configure user settings, Job Account ID, name and User Name information is
required.

Read the explanation below carefully, and prepare the Job Account ID, name and User Name
information according to the objectives of the print restrictions and log.

Server software

Setting Details Registration range
information

Job Account ID This number is used to recognize users 1~999999999
in Print Job Accounting. Assigned to each
user, settings such as print restrictions

and cost burden are set for each Job
Account ID on the server software.

Name This name is applied to make the Job Up to 80 characters
Account ID easy to distinguish. (Names cannot include a ” symbol.)

Client Software/Plugin

Setting Details Registration range
information

Job Account ID This number is used to recognize users 1~999999999
in Print Job Accounting.

When print restrictions or logs are
configured for each department, the
same ID is assigned to all users within
the department.

When printing is performed without
setting the Job Account ID, printing is
performed by an unregistered user and
0 remains as the Job Account ID in the

log.

- 16 -



1. Before Setup

Setting Details Registration range
information
Name This setting is for recognizing the actual |Up to 80 characters

user who ordered the print job from

the client computer. This information is
stored in the "User" section of the log.
When printing is performed from a
Windows or Mac OS X computer that is
not configured with the Client Software,
the user is an unregistered user, Job
Account ID is 0, and the user name used
to log on to either Windows or Mac OS X
remains in the log as the User Name.
When printing is performed from a Mac
OS computer that is not configured with
the "Job Accounting” panel, the user is
an unregistered user, JobAccountingID
is 0, and UserName remains as a blank
space in the log.

(Names cannot include a ” symbol.)

(Note!) Depending on applications such as the Windows version of PageMaker, data that does not use
printer drivers may be created.
In this case, the user is an unregistered user, Job Account ID is 0, and User Name is remains
as a blank space in the log.
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1. Before Setup

Example of assigning the Job Account ID

The following usage methods are possible depending on how the settings and limitations are
configured and the logging method.

Example of Use

Server software settings

Client Software/Plugin
Settings

When you want to
permit printing for
only some users.

Set the Job Account ID
and name only to users
who are permitted to
print. Unregistered IDs are
prohibited from printing.

Set the Job Account IDs that are
permitted to print.

When you want
to permit color
printing for only
some users.

Set the Job Account ID and
name only to users who

are permitted to print in
color. Unregistered IDs are
prohibited from color printing.

Set the Job Account IDs that are
permitted to print.

When you want
to keep a record
of the printing
limitations and log
for each user.

Set a unique Job Account ID
and name for each user so
there are no duplications.

Set the User Name and Job
Account ID for each user so there
are no duplications.

When you want
to keep a record
of the printing
limitations and
log for each
department.

Set a Job Account ID and
name for each department.
When information is totaled
for [Job Account ID], the log
for each department can be
obtained.

Set the Job Account ID assigned
to the department, and set the
name of the user that is printing
as the User Name.

When you want

to place print
restrictions on each
department, but
log printing in each
person's name.

Set a Job Account ID and
name for each department.
When information is totaled for
[User Name], the log for each
user can be obtained.

Set the Job Account ID assigned
to the department, and set the
name of the user that is printing
as the User Name.

When you want

to apply print
limitations and
obtain logs for
each department,
yet also apply
limitations and
obtain logs for each
user.

Set a unique Job Account ID
and name for each user so
there are no duplications.
Divide users into user groups
according to department.

Set the User Name and Job
Account ID for each user so there
are no duplications.
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Example of Use | Server software settings SUETE SETIVETE/PUET

Settings
When you want The Job Account ID and name <For Windows and Mac 0OS X>
to just collect a do not need to be set. The Client Software does not
print log without When information is totaled for | need to be installed on the client
imposing print [User Name], the log for each computer. The login user name
restrictions. user can be obtained. used for Windows or Mac OS X
remains in the log as the User

Name.

<For Mac OS>

The JobAccountingID is set as
desired, and the UserName is set
as the user name for printing.

If Print Job Accounting associates with Active Directory, Login name and Card ID registered
on Active Directory in advance can be used as the user information. (Only Enterprise edition)
Card ID is registered to assign to unused arbitrary attribute with Active Directory.

Setting information for Active .
. Details
Directory
Login name This name is used to login to Windows.
Card ID This ID is the meaning information which
can identify a card.

For detail on usable Card ID, refer to Card Secure Kit user manual.
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Memo
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2. Setting up the server software

2. Setting up the server software

This section explains how to set up the Print Job Accounting server software.

(Note!) The window and setting contents differ depending on the printer model.

Operating Environment

@®\Windows 8.1 / Windows 8.1 (64bit
version)

@®Windows Server 2012 R2

®\Windows 8 / Windows 8 (64bit version)

@®Windows Server 2012

®Windows 7 / Windows 7 (64bit version)

®\Windows Vista / Windows Vista (64bit
version)

®\Windows Server 2008 R2

@®\Windows Server 2008 / Windows Server
2008 (x64 version)

@®\Windows Server 2003 / Windows Server
2003 (x64 version)

(Note!) * The computer in which the server
software is installed needs to remain
switched on, or needs to be running at
the time at which the log is set to be
obtained from the printer.

= Approximately 3MB of hard disk space
is required to save 10,000 log entries
on the computer.

Installing the server
software

(Note,) It is necessary to logon as a user with
PC administrator privileges.

@ Launch the server software application.

@ i the [User Account Control] dialog box
appears, click [Yes] or [Continue].

® cClick [Next].

| Print Job Accounting Enterprise Setup =)

Welcome to the InstallShield Wizard for
Print Job Accounting Enterprise

Thi= program will update Print Job Account ing
Enterprise on vour computer. To cont inue,
click Mext.

< Backll [F : Cance|

O Read “Software License Agreement” and
then click [Yes].

| Print Job Accounting Enterprise Setup =
License Agreement \
Flease read the following license agresment
careful ly.
Press the PAGE DOMN key to see the rest of the agreement.
Software License Azreement =

IMPORTANT —
If wvou do not agree to the terms of this Software License Agreement
(“Agreement”), you may not use this software.

Flease read this Azreement careful ly before using the software and
accompany ing documentat ion (“Licensed Software”). By installing the
Licensed Software, wou are indicating your acceptance of these ierms

and conditions and this Azreement is deemed effective betusen you -
Do vou accept all the terms of the precedine License -
hzresment? If vou select Mo, the setup will close. To
install Print Job Account ing Enterprise, vou must accept this

<Backfl | es

Install dd

Mo
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@ Verify the desired installation destination @ Check the settings and begin copying

location, and click [Next]. files by clicking [Next].
| Print Job Accounting Enterprise Setup |

Chooze Destination Location
tolect tolder where Sctup will install tiles.

| Print Job Accounting Enterprise Setup

Start Conying Files \
Heview actiings betore copying files. \

Setup has enoui:h Informtlon lo start cuns’lnz the progran lI Iee If you
want to review or changs any settings, click Back. If you are satisfied
e AT T TR TH e T e with the scttings, click Next to begin copying files.

o | a +] 1z 10 rs Cli « 10 Inzto oo

different folder. click Drowse and select ancther foldsr. Gurrent Settineos

= s o 5 ey \ Install in this folder :

Li¥rogran Files¥lkidata¥trint Job Account ing
Save o log in this folde

Setup will Install Print Job AccountIng Enterprize In the
following folder.

Install in this folder @ C:¥Prozran I'lle.'.;undntaﬂ‘rml Job Account ine

C:¥Program Flles¥0kidata¥Print Job Accountng z:’::nl:ifi::t{.'

Save o log in thiz folder @ EiBone

C:¥Progrom Filea¥0kidolo¥Print Job Accounting Browse... ; : e
| < Rack] || Wext > | § fancel < Backfl || Wext > | [ fancel

@ select appropriate Program Folder, and © cClick [Finish].
click [Next].

rint Job Accounting Enterprise Setup ==

Select Program Folder \
Fleass select o program tolder. \
Setup will add program lcons to the Program Folder llsted below. You may

type a new folder reme, or select one from the existing folders list.
Prozram Fulder:

| Print Job Accounting Enterprise Setup

@ InstalIZhield ¥izard Complete

The update of Print Job Accounting Enterprisc hos
been coneleted

Tablel FC

< Backll || Wext > | I fancel
@ Select [North America] or [Europe], Installing the server software is now
depending on location and then click complete.
[Next]. If the server software is Enterprise Edition,

T . == proceed to “Activating the license for the
Choose Cost Profile \n server software” (page 24).
telect cost profile which Setup will install.

Chooze cost proflle, and click MNext.

@ For Morth Anerica

) For Europe

< Rark|

s

Cancel
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Activating the license for
the server software

(Note,) The server software is required for
activation of the license.

© select [Start] > [All Programs] >
[Okidata] > [Print Job Accounting
Enterprise] > [Print Job Accounting
Enterprise].

@ When the [User account management]
window is displayed, click [Continue] or
[Yes].

® click [Activate Print Job Accounting
Enterprise].

"™ Print Job Accounting Enterprise

Print Job Accounting Enterprise

[E-}) Activate Print Job Accounting Enterprise I

I have already purchased and would like to activate the
product

OKI

3 Exit

O Enter [License Key] in the first box and
[Password] in the second box and Click
[Continue].

_ License ID and Password
Print Job Accounting Enterprise

Please enter your License ID and Password found on the CD
Label or received through your email.

Please enter your License ID:

Please enter your Password:

OK1 ©l

¢ Back 8 Exit Continus w5

(5] Verify that “The Activation was

successful” dialog box is displayed, and
click [Continue].

" Print Job Accounting Enterprise Activation ==

Print Job Accounting Enterprise Activation

fThe activation was successful. I

OKI mmr

Continue =]

(Note!) < If "Could not communicate with the
server" is displayed in the dialog box,
please check that the computer can
connect the Internet.

< If "The License could not be found on
the server” is displayed, please check
[Password] and [License ID] in step @

@ check that “Server ID” is displayed, and

click [OK].

Print Job Accounting (==

Server ID is " ". This ID will be required if a printer is added to
this utility on another PC before being deleted from this PC. Please take
a note of the ID.

After the installation is completed, you
can check “Server ID”.
[Help] menu> [Server ID]

0 Activating the server software is now

complete.

Fie Prioter Log Pocy Option Help
Beinter Privinr Addres Group Status | Last Acquisition Date
% Log
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Server software window configuration

=lol x|
- Printer Printer Address Stans | Last Date
= log a4t 192.168.0.3 Acqured  10/09/2011 6:13:44PM
&3 Date MCS6L 192.168.0.2 Acgured  10/09/2011 9:34:48 PM
2010/08
=) Group(Sales Department)
CB41(152. 168.0.3)
MCS51(152. 168.0.2)
= 2010/09
= Group{Sakes Depeartment)

CH41(192.168.0.3)
MCS61(192.168.0.2)
3 Proter
Group{Sales Department)

= CB41(152. 168.0.3)
D—— T Towm
201009

= MCS51(192.168.0.)
2010/08
2010009

@ [File] Menu
Commands for exiting the server software are displayed.

@ [Printer] Menu
Commands for adding, deleting and managing printers that obtain logs are displayed.

® [Log] Menu
Logs and summaries are displayed, and commands for writing to files are also displayed.

Items in the [Printer] menu and [Log] menu can also be selected by right-clicking the mouse
on the printer or log to be operated, and selecting the command.

® [Policy] Menu
Commands for setting the usage limitations are displayed.

® [Option] Menu
Commands for setting the options are displayed.

® [Help] Menu
You can view the Server ID, help and version information.

@ Selection window
Printers managed using Print Job Accounting and obtained logs are displayed in a tree
format according to printer and date.
The tree can be opened and closed using the same standard operations as Windows
Explorer. The tree is in the closed state directly after starting the server software, and needs
to be opened in order to select items.

Details window
Double-click the [Printer] that is at the origin of the tree in the selection window, and the
address, group it belongs to, log obtained/unobtained status, and date on which the last log
was obtained for printers managed by Print Job Accounting are displayed.
Double-click the log in the selection window to display the log.
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Starting the server software | Setting up the server

software

(Note!) The server software settings cannot
be configured without computer
administrator authority.

Configuring Active Directory
settings (Only Enterprise
edition)

Settings for Active Directory such as
setting usage limitations and registered

@ Check that the printer power is ON.

9 Select [Start] > [All Programs] > [Oki
Data] > [Print Job Accounting] > [Print
Job Accounting].

When the [User Account Control] window
is displayed, click [Yes] or [No].
The server software starts.

printers for user information managed
using Active Directory or registering an IC
card compatibility table to Active Directory

need to be configured in the server
software.

Before registering the printer in the server
software, if you complete all settings for
the Active Directory first, the operation to
safely. register user information managed in the
Active Directory or the IC compatibility
table to the printer can be performed
smoothly.

Active Directory settings can also be
configured after registering the server
software to the printer.

For details on Active Directory settings, see
chapter 6 "Syncing with Active Directory
User Information" (page 102).

® When the server software is started for
the first time, a window is displayed
notifying you of the Server ID. You must
write down the Server ID and store it

In Print Job Accounting, the log from
one printer cannot be obtained by
multiple servers. For this reason, in
order to distinguish which server is
obtaining the printer log, the Server ID
is set in the printer.

If a Print Job Accounting sever
cannot be used due to breakdown
etc, obtaining of the log needs to be
changed to a different server.

x Configuring Database
Server ID is "19365", This ID will be required if a printer is added to this S ett I n g S (O n I y E n te r p r I Se
utility on another PC before being deleted from this PC. Please take a note
of the ID,

edition)

In order to export log or Job Account IDs
that are managed with the sever software
to the database, database settings need to
be configured in the server software.

If you complete the database settings
before registering the printer to the server
software, the operation for exporting logs
or Job Account IDs managed using the
server software to the database can be
performed smoothly.

Database settings can also be configured
after registering the server software to the
printer.

For details on the database settings, see
chapter 7 "Saving managed data to the
database" (page 146).
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Adding a printer that (D-2 Enter the community name in the
. entry field and click [ADD].
acquires the log v ick [ADD]
x|
[~ SMMP community name
(NOte!) A maximum 50 printers (In Enterprise Specify community name string used to authenticate

SMMH communication For dewice detection, and chk [OK],

edition, 1,000 printers) can be
registered to the server software.

|cumrr|.|n|ty1 Add

@ Select the [Printer] menu > [Add a ST

Printe r] . ¥ Use "public” community name

;__‘,‘.'_, Print Job Accounting Enterprise = [ e

File Log Policy Option Help
-3 Click [OK].

#-]  Manage multiple printers as &group... ® . ] _
elete a Printet Brinter Graum X
Ehange & Printer Graum, .. [t

g & Specify community name string used to authenticate
Start,l'End L|:n;| SNRE communication for device detection, and dick [OK].
Sequire & Lag
Setking Ehe Time | add |
DEFH"IE Fees,.. cormnmunity 1
Backup of printer setting... Delete |
F‘ru:-perties. £ ¥ Use “public" commanity name

........ —— —

(0] Specify the printer that will acquire the
log.

_ (@ Select the search method.
<To search for a printer>

<Local port or broadcast search>

(D To search for TCP/IP network printers, O e : g
specify the community name that is FrRiE b sad
. . % Gparch prnkes ard srdect foom the ket
used for authentication to search for S
printers by using SNMP communication. P2 LCPAP Ntk
Eroadcast Addoss |M2‘?52‘365
(-1 Click [SNMP Setting]. e
[Add a printer for which logs will be acquired = P A |
Spacity the printer for which kgs wil be acquined 1 [isplag/espon the ko accuined by anothes remole server
1% Gearch printens and select from the it sy G
™ Local PostfPaualel LISH) ™ lgeort peinters from a fle.
¥ ICPAR Hebwork Fie Home |
Brosdeast Addess | 265,255 255,265 o —

" Spechy the prnter by address

e o T e |
(@-1 Select [Search printers and select

from the list], check the port to
which the printer is connected,
and click [Next].

I T T | To search for printers in different
segments of the TCP/IP network, enter
the broadcast address. If it is unknown,
contact the network administrator.
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<Searching for the printer from a CSV file>

@-1 Create a CSV file using software
such as Notepad or Excel etc.
<For Notepad>

i Write the IP address and name of
each printer on one line for each
printer. Separate the IP address and
printer names with a comma ","

7 e

The printer name can be omitted.

ii Save in text format with the
extension "CSV".

<For Excel>

i Write the IP address and name of each
printer on one line for each printer.
The printer name can be omitted.

ii Save in CSV file format.

(@-2 Select [Import printers from a
file], and click [Reference].

-3 Specify the CSV file created in O,
and click [Open].

@-4 Click [Next].
® Select the printer from the list, and

click [Next].
(494 5 princer for which logs wil be acqured T

Start new scaich |

Erul TCPAP redwaink seeaich

<D lﬂM)I Cancel

Only printers that are supported by
Print Job Accounting are displayed.
Press and hold the Shift key or Ctrl key
while selecting to select more than 1
printer.

<To specify a printer directly>

(D select [Specify the printer by address],
and select [Address]. When connected
to a TCP/IP network, enter the printer
IP address into [IP Address].

add & printer foe which Ings will be acquieed E =]

Speciy the prnter for which ks wil be scquired

1 Sesrch printers and selact from the it

Prenled [158]

255,255 255,265

1% Spechy the prnter by address

Addess TCRAP Network. |
|P Adders 192 160 2
1 Displap et the kog scuued by anoller remobs server

@ Click [Next].
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@ set the printer to acquire the log, and
click [Finish].

Auchil n parinder Fesr wobsi b o, vl e o epuiresdd x|

St Dthes Ioema.
Esirder Name m
Parter Group Mot in 8 goup "l
Fumpae Loge.
 lpervd 5 hou [0 beruaes
 Tam
[ [EE e |
el |
Cinerstion ot Loy Ful [Decteddogs [ =]
ko Expost Logs [Ches ract smderully gt ¥

T Bcond ko . cdalisbaien
I Acgine Oy Logsids ot uss rastrictions)
4 9 s

Chek. weith
m@qﬂnﬁ.ﬂ»wn

" i
i
i

Time To Acquire Logs

1200 Dilets |

Time

I'I2 Hours
IUD Minutes

(]:8 | Cancel

Printer Name

Set the name of the printer to be displayed in the
server software.

Printer Group

Select the group that the printer belongs to.

Acquire Logs

Set the schedule by which the log is acquired.

(Note!) Always set a time when the computer in
which the server software is set up and
printer power are both switched ON.
The log is not acquired if the power is
not ON.

Interval

Set the interval when the log is acquired over
a fixed time. The maximum interval time that
can be set is 24 hours. The default setting is
set as an optimized value detected from the
state of the added printer. If the interval is

set to a time that is longer than the default
settings, some of the logs may not be acquired.

Time

Set the specific time. Click [Change Time], and
add the time to the [Change Time To Acquire
Logs] window. Up to 5 acquisition times can be
added. After adding, click [OK].

Fees

Set the fee definition pattern when assigning
printing costs to users.

Click [Define fees] to add definitions.

For details on the fee charge definitions, see
"Creating fee charge definitions" (page 180).

The initial settings definition shows
a rough guide to the running costs
calculated from the standard prices of
various consumables and the number of
prints over the lifetime for each model.

Operation at Log Full
Set the process when the printer log buffer is full.

e Delete old logs
The oldest log is deleted, and the new log is
received.

e Cancel the job
All subsequent print jobs are cancelled.

¢ Do not acquire the log
The log is not obtained for subsequent print
jobs.
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Inhibit the initialization of the Hard Disk
and Flash Memory

Check this check box to prevent the printer built-
in hard disk, SD memory card, and flash memory
from being initialized. When Print Job Accounting
is used, always check this check box.

Auto Export Logs

Set to automatically write the acquired log to a
CSV format file, and send the file via e-mail.

e Do not automatically export
Automatic export is not performed.

e Automatically export logs
The acquired log is automatically written as
a CSV format file to the automatic export
destination.

e Mail logs to administrator
The acquired log is automatically written as
a CSV format file to the automatic export
destination, and the file is sent by e-mail to
the administrator.

Record logs in a database (Only
Enterprise edition)

Check to export the acquired log to a database.

Acquire Only Logs (do not use
restrictions)

Check this check box when you do not want to
automatically activate access restrictions for
models that have an access restriction function
on the control panel.

(Note!) Users cannot be registered.

Start acquiring the log immediately after
adding

Check this check box to start acquiring the log
after adding a printer.

SNMP Setting

Set the community name that is used for
authentication to manage printers by SNMP
communication.
e Read
Specify the read community name for the
server software.
Write
Specify the write community name for the
server software.
Retry
Specify the number of times to retry the
SNMP get or set operation. This setting is
effective only on some models.
Timeout
Specify the timeout for the retries of the
SNMP get or set operation. This setting is
effective only on some models.
Read Community
Specify the read community name for traps.
This setting is effective only on some models.
Write Community
Specify the write community name for traps.
This setting is effective only on some models.
Trap Port
Specify the Trap log receiving port. This
setting is effective only on some models.

@ When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

(Note! e Depending on the printer, this is not
displayed.

e For details on the factory set printer
administrator password, see the User's
Manual of the printer.

Print Job Accounting Enterprise 2=l

Pleaze enter the adminiztrator pazsword of the printer.

Fazzwaord

Caticel |

"

Next, the "Job Account ID registration
window is displayed.
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Registering the Job Account
ID and Name

The Job Account ID and Name can be
registered using the following method.
e Manual registration.

e Create a CSV file that contains the
Job Account IDs and User Names, and
register them in a batch.

e Users registered in Windows on the
network are read.

This section explains how to register

manually. For details on other methods,

see "Adding the Job Account ID"

(page 48).

@ Click [Add] in the [Job Account ID
registration].
2]

Phinkes Hame IAMnsa |mm~m|nmm
MC5E1 19216802 103 3

Sizw Userils |

Jst of registered IDs.
= [— ]
Hame I.JobAmmntlDI Eml Stabus
Email To Print 1879043194 Enable Printing [EFkelE
Local Pint 189048152 Enable Hinkng
Ureegistered ID L] Enable Frinting (e

O select [Add a User], select the group that
the user belongs to from [User Group],
and click [Next].

i
Add a uger or a uzer group.
 had a Used
User Group |Ndilduuuv ;[

" Manages muliple Job Account D s a groug.

Group Hame I

Femadladdiess I

cpeck | [ hets || cancn |

® Enter the [Job Account ID], [Name], and
[E-mail address] (can be omitted), and
click [Add].

Memo | The e-mail address needs to be set in
[Notifies total result by e-mail] and
[Notifies by e-mail when Limit Value
was exceeded] in step @

Job Account ID registration : -f-l-)il

SctJob Account ID and name (optionall. When multiple IDs are added, all these Dz
will harve thwe same sellings for Use Restictions, Limil Vale ard the Yelid peiod

Name JobAccount 1D [ Emataddess [ || add |
Delete |
G|
Eie... |
dobpecountlD [T Revnie fero
e [salo

E-mail address |sahu@uh.m

<w|w)|w|

O Click [Next].

@ set functions for the Job Account ID, and
click [Next].

Job Account ID registration .ll.)-‘.l

Set functions comesponding to Job Accourt ID.

I~ e i e By
™ Motifies by e-mail when Lini Yalue wes sesded

7' Do ot process Limit Yalue &5 & oroup

c&u\klﬂmﬂ)lwl
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Notifies total result by e-mail

Notifies the total amount used every month by
email.

Notifies by e-mail when Limit Value was
exceeded

A mail notification is sent when the print quantity
exceeds the limit value and printing is no longer
possible, and when the limit value is reset and
printing is made possible again.

Do not process Limit Value as a group

Limit values can be set individually for users that
belong to a printer group, and users that belong
to a printer group.

@ set the use restrictions, and click [Next].
x|

Set Lse Restrictions for the Job Account D

5
[ Disable Color Printing

= Fiint lnfdono
[ Disable Copying
™ Disable Color Copying
[ Disable USE temony to Print
™ Disable USE Memon to Color Frint
[ Disable Scan to Email
[~ Disable Scan to Netwark PC / Disable Scan to Shared Folder
[~ Disable Scan to USE Memary
" Disable Fax Sending
[ Disable Scan ta [ntsmet Fax

[ Disable Scan to Fas Server

< Back Next > Cancel

Disable Printing
Cancels printing.
Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Print In MONO

When disable color printing is set, monochrome
printing is performed without cancelling color
data.

Disable Copying

Copying using panel operations is prohibited.
When this is disabled, the printing prohibited
settings are applied.

Disable Color Copying

Color copying using panel operations is
prohibited. When this is disabled, the color
printing prohibited settings are applied.

Disable USB Memory to Print

Prohibits printing from a USB memory using
panel operations.

Disable USB Memory to Color Print

Prohibits color printing from a USB memory using
panel operations.

Disable Scan to E-mail
Prohibits Scan to Email using panel operations.

Disable Scan to Network PC /
Disable Scan to Shared Folder

Prohibits Scan to Network PC and Scan to Shared
Folder using panel operations.

Disable Scan to USB Memory

Prohibits Scan to USB memory using panel
operations.

Disable Fax Sending

Fax sending using panel operations is prohibited.
Fax sending that uses the fax driver is also
cancelled.

Disable Scan to Internet Fax

Prohibits scan to internet fax using panel
operations.

Disable Scan to Fax Server

Prohibits scan to fax server using panel
operations.
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@ set the limit values that can be used by
Job Account ID.
When each of the limit values is
exceeded, printing is cancelled until the
valid period set in step @.

(Note!) The limit value settings are enabled
from the point at which the server
software obtains the log when the limit
value has been exceeded. Printing can
still be performed when the limit value
is exceeded until the server software
receives the log.

Job Account ID registration 2=

Set Limit Yalue for the Job Account ID. IF any Limit Value i cxcoeded, the
pririten wall rol prind jubs for that Jub Account 1D any moe,

¥ Printed Sheats I"Il sheets
™ Eess I dollars)
[T Staple I staples
< Back I Neat > I Cancel ]

Printed Sheets

Set the number of sheets that can be printed.
Fees

Set the upper limit of the fee charges.
Staple

When the optional finisher is installed, set the
number of times that the stapler can be used.
When limit values are set
& click [Next], and proceed to step @
When limit values are not set
<& click [Finish], and proceed to step @

O set the expiration date for the limit
values set in @, and click [Finish]. When
the valid period is exceeded, the limit
value count is reset.

2l
Epecify the valid period for the Job Account 1D, 1f the vald period specified
here expaes, sach index is ceared.
Il]ylvmih j
To 1043172011

[ Mown [Tomeendoithen>

™ Canry over unused value to the next vaiid period

cBack |[ Fsh || Conea |

Do not specify

The valid period is not set. When the limit value
set in 0 is not set, printing is cancelled unless
the limit value is increased, or the usage status
are manually reset.

By month

Set the valid period in month units. Set the
number of months and base date (10th, 20th,
end of month, deadline).

By week

Set the valid period in week units. Set the
number of weeks and base day.

By day

Set the valid period in day units. The number of
days is set.

Carry over unused value to the next valid
period

Check to carry over the amount that is not used
within the valid period to the next period.

© When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

(Note!). Depending on the printer, this may not
be displayed.
e For details on the factory set printer
administrator password, see the User's
Manual of the printer.
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@ Click [End] in the [Job Account ID
registration] window.

@ When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

(Note!) Depending on the printer, this may not
be displayed.

Managing multiple printers
as a group

Multiple printers can be managed as

one group. When managed as a group,
the log can be displayed in group units.
Furthermore, the user control values can
be set to all of the printers that belong to
the group.

@ Start the server software.

@ select the [Printer] menu > [Manage
multiple printers as a group].

@ Enter the printer group name, and click
[Next].
2l

Specifies a name for the printer group.

Group Mame |Sdes Depanrment

< Back I Next > I Cancel

O sclect the printer to assign to the group
from the list, and click [Finish].

Add a printer group ﬂi‘

From the list, select the printers that pou want to manage as a group.

To select multiple consecutive printers, click the first printer, press and hold davin
SHIFT, and then click the last printer. To select multiple non-consecutive printers,
prezs and hold down CTRL, and then click on each printer.

Last Acquisition |

Group | Status

Printer | Address
[ 1

<gack |[ Frsn || canca |

Press and hold the Shift key or Ctrl key
while selecting to select more than 1

printer.
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(5) Register users to the group.
The Job Account ID registration window
is displayed. To register users, follow
the instructions in "Registering the Job
Account ID and Name" (page 31) and
register the users.

@ The [Do you want to register the Job
Account ID registered in the group?]
window is displayed.

Click [Yes], and the user registered in
step Ois registered to the printer.

When limit values are set for users
or user groups that are registered to
printer groups, the limit values are
enabled for the total amount of usage
for users and user groups of all printers
that belong to the printer group.
However, the usage amount of users
and user groups that have the [Do not
process Limit Value as a group] check
mark checked are not included.

Changing the printer group

The printer can be changed to a different
group. This is useful for when the printer is
relocated to a different department.

0 Start the server software.

@ Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

@ select the printer whose group you want
to change, and select the [Printer] menu
> [Change a Printer Group].

Multiple printers can be selected.

O sclect the new group to be assigned to,
and click [OK]. To remove the printer
from all groups, select [Not in a group].

@ When the [Do you want to register the
Job Account ID registered in the group?]
window is displayed, click [Yes].

(Note!) When [No] is clicked, the users
registered to that group are processed
as unregistered users in that printer.

Deleting the printer group

0 Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

® select the printer group you want to
delete, and select the [Printer] menu >
[Delete a Printer/Printer Group].

Multiple printer groups can be selected.

O cClick [Yes].

Printers that belong to the deleted
printer group are changed to [Not in a

group].

Backing up printer settings

Printer settings can be backed up. Backed-
up settings can be restored to a different
computer that has the server software
installed. This means that even if a
problem occurs with your computer, you
can continue using the same settings on

a different computer. Settings that can be
backed up are the printer settings, user
ID settings, fee settings, and user settings
that are synced with the Active Directory
(Only Enterprise edition).

@ Start the server software.

@ sclect the [Printer] menu > [Backup of
printer setting].

File | Printer Log Policy Option Help

_ﬁ Add a Printer...

-1 Manage multiple printers as a group...
melete a Frinter/Brinter Groum
Ehange a Printet Group, .

StatbEnd Log
fcguite & log
Setting bhe Time
Define Fees...

Badkup of printer setting. .. k
Froperbies, ..
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® Specify the save location and file name of
the printer settings, and click [OK].

@ e Store the backed-up setting file on a
different computer.

e We recommend creating a new
settings backup file each time the
software settings are changed.

e Acquired logs are not backed up.
Restoring printer settings

Backed-up printer settings are restored in
the server software.

@ Start the server software.

@ sSelect the [Printer] menu > [Add a
Printer].

I Print Job Accounting Enterprise

EHREER ERRLEr SR

= L = O

e e
FLAIRL= A |

® select [Import printers from a file], and
specify the file path of the setting backup
file.

The extension of the settings backup file
is "dat".

You can also click the [Reference] button
and select the file.

Add a printer fo

O Click [Finish].

Add a printer for which logs
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@ When the administrator password window
is displayed, enter the administrator
password and click [OK].

@ When the printer registration results
notification window is displayed, click
[Close].
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Memo
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3. Setting up the client software

3. Setting up the client software

This section explains how to set up the print job accounting client software with plugins.

Setting up in Windows

Operating Environment
e Windows 8.1 / Windows 8.1 (64bit
version)
e Windows Server 2012 R2
e Windows 8 / Windows 8 (64bit version)
e Windows Server 2012
e Windows 7 / Windows 7 (64bit version)

e Windows Vista / Windows Vista (64bit
version)

e Windows Server 2008 R2

e Windows Server 2008 / Windows Server
2008 (x64 version)

e Windows Server 2003 / Windows Server
2003 (x64 version)

Installing the Client Software

(Note!) It is necessary to logon as a user with
PC administrator privileges.

@ Launch the Client Software application.

@ if the [User Account Control] dialog box
appears, click [Yes] or [Continue].

® choose the appropriate Language, and
then Click [Next].

| Print Job Accounting Client - InstaliShield Wizard ol & ==
Choose Setup Language \
Select the language for the installation from the choices below.
Catalan -

Chinese [Traditional]
Czech

Chinese [Simplified] v
Danish ‘
PE

French [Standard] ==
German
Greek
Hungarian
Italiar
Japanese
Koarean

O click [Next].

' Print Job Accounting Client Setup =

‘Welcome to the InstallShield Wizard for Print
Job Accounting Client

The InstallShield ‘Wizard will install Print Job Accounting
Client an your computer. To continue, click Mext.

@ Read “Software License Agreement” and
then click [Yes].

' Print Job Accounting Client Setup

License Agreement

Plaase iead the follawing license agreement carsfull.

Press the PAGE DOWN key to see the rest of the agresment,

Eoftware License Agreement -

IMPORTANT U
If you do not agree to the terms of this Software License Agreement [Agreement’, you
may not use this software,

Please read this Agreement carefully betore using the software and accompanying
documentation ['Licensed Software"). By installing the Licensed Software, you are

indicating pour acceptance of these terms and conditions and this Agreement is deemed
effective between you [“Licensee') and Oki Data Corporation [ Licensor') -

Do you accept all the terms of the preceding License Agresment? 1f you
select Mo, the setup will close. To install Print Job Accounting Client. you
must accept this agreement.

IrstallShield

< Back Yes Neo

(6) Verify installation destination folder, and
click [Next].

"Print Job Accounting Client Setup ==

Choose Destination Location

Select folder where setup will install files,

Setup will inztall Print Job Accounting Client in the following Folder.

To install to this folder. click Mext. Toinstal to a different folder. click Browse and select
another folder

Destination Folder

T ADkidsta\Print Job Accaunting\Clent

r—
< Back I][ Next > JI[ Cancel ]
L
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@ select appropriate Program Folders, and
then click [Next].

“Print Job Accounting Client Setup ==

Select Program Folder

Please select a program folder.

Setup will add program icons ta the Pragram Folder listed below. ou may tupe & new falder
name, o select one from the existing folders list. Click Next to continue.

Program Falder.

AiSUng T OIders
Accessories
Admivistrative Tools
(Games

Mairtenance

Microsoft Mouse

Microzsoft Office

Microsoft SAL Server 2008
(lkidata

SharePoint =

< Back I]E Mext > ]I[ Cancel
L

(5] Verify settings and click [Next] to begin
copying files.

| Print Job Accounting Client Setup ==

Setup has enough information ta starl copying the program files. 1F you want to review or
change any settings, click Back. |f you are satisfied with the settings. click Next to begin
capying files.

] »

m

|hatallS hield

Start Copying Files
Review settings before capying files.

Current Settings:
Installin this folder : -
C:\Program Files\0kidataPrint Job Accounting! Client
Program falder :
kidata

€ [

Install5 hield

« Back et > Cancal
L

© click [Finish].

| Print Job Accounting Client Setup

InstallShield Wizard Complete

The InstallShield YWizard has successfully installed Print Job
Accounting Client. Click Finish o exit the wizard.

« Back _ Cancel

Installing the Client Software is now
complete.

Setting Job Accounting Mode

Job Accounting Mode is a method of
setting the User Name and Job Account
ID in the Windows client computer. There
are 4 modes. The default status is the
unsupported mode.

Job Accounting Mode settings can only
be configured in a print driver that
supports Print Job Accounting.

Tab

The tab for setting the User Name and Job
Account ID to the print driver properties is
displayed.

It is used by the user themselves to set or
change the User Name and Job Account ID.

Popup

A popup window for setting the User Name and
Job Account ID to be sent for each print job is
displayed.

It is used when 1 computer is used by multiple
users.

(Note!) Even if printing is performed on the
shared printer client side, the input
window is not displayed. Use Hide for
shared printers.
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Hide

Even if printing is performed on the shared
printer client side, the input window is not
displayed. Use the hide mode for shared
printers. The system administrator creates an ID
file that contains the Job Account ID and User
Name that correspond to the Windows login user
in advance. By specifying this file with the client
software, the user that performed the printing

is identified, and the corresponding Job Account
ID is automatically acquired. Furthermore, the
same Job Account ID can be set for all login
users. The users do not need to configure
settings or to know their own Job Account ID.
When using the Windows computer as a print
server and the printer as a shared printer, install
and use the client software onto the computer to
be used as a print server.

Not supported

Users identification is not performed, and all
jobs are recognized as Unregistered ID. The
User Name is the user name used to login to
windows, and the Job Account ID is 0. Used
when user recognition is not needed.

This section explains how to set the tab
mode. For details on how to change other
modes, see "Changing Job Accounting
Mode" (page 214).

@ select the printer driver of the printer
that will acquire the log from the
[Driver] list. To set all of the printer
drivers to the same mode, check [Set
the same mode for all drivers].

(Note!) When the shared printer is used,
do not use the function that sets all
printer drivers to the same mode.
When using a shared printer on
the client side to print, the account
information is not output.

@ sclect [Tab], and click [Change].

@ click [OK] in the change successful
window.
@ Select [File] menu > [Close].

File  Hide Mode  Help

—Job Accounting Mode

™ Set the same mode for all drivers.

Diriver

| oKl MC38T(PCL) =l

" Eopup
" Hide
' Not supported

LChange |

@ 1n Windows 8.1/Server 2012 R2/8/Server
2012/7/Server 2008 R2/Vista/Server
2008 select [Start] > [Control Panel],
and click [Printer]. (For Windows Server
2003, select [Start] > [Printers and
FAX].)

@ on the printer driver icon, right-click the
mouse button and select [Properties].

0 In the [Job Accounting] tab, enter the
User Name and Job Account ID.

In the default settings, the User Name is
the user name used to login to Windows,
and the Job Account ID is 1.

ﬂ
. Gered |  Shaing | Pors | Advanced |
Color Managemert Job Accounting | Security I Device Option

User Detailz

Uzer Mame [up to 80 characters)

|sat0

Job Account 1D [1-993999399)

Jn

@ click [OK].
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Setting up in Mac OS

(Note!) Depending on the model or print driver
used, the setting method or operating
environment may differ.

When the printer drivers are installed in Mac
0S, the plugins are installed together. Set
the User Name and Job Account ID in the
[JobAccounting] panel of the print dialog.

(Note!) If printing is performed without
configuring these settings, the User
Name is blank and the Job Account ID is
0 in the log.

Configuring the plugins

@ Set up the printer drivers in Mac OS.
@ sclect the [File] menu > [Desktop Print].

@ Select the [JobAccounting] panel.

Z1-8.7.1

Printer: (830 |2 Destination:

- |« General
Background Printing
Color Matching
Cover Page

Font Settings

Job Logging To:
s [ Je[ ]

[ ] Collated

Insert Option

O set the User Name and Job Account ID,

Paper Handlin
Plung-ln Prefergn(es sfrom: [Auto Select %]
Save as File gefrom: |Multi-Purpose Tray Z]
Color Option ing from: [ Multi-Purpose Tray & ]
Color-0Office Color

~ Color-Graphics Prol
Color-Graphics Pro2
Job Option

and click [Save Settings].

Printer: | (830 =

71-87.1

Destination:

r [ JobAccounting

3|

Job Accounting Setting

User Name :

Job Account ID:

| sato |

! |

Save Settings
I

[

@ Click [OK] in the confirmation window.

The current settings will be saved for
the printer *C830”.

[ Cancel

@ Click [Cancel] to close the dialog box.

Setting up in Mac OS X

Operating Environment
Macintosh running Mac OS X 10.3 or later

(Note!) Depending on the model or print driver
used, the operating environment may
differ.

Installing Client Software

@ Double-click on the Client Software file.
@ Disk image is mounted on the desktop.

® Copy to any location by dragging-and-
dropping the Client Software icon onto
the disk image.

Installing the Client Software is now
complete.

The Client software is a utility for
registering, editing and managing
JobAccountingID for the job account.

Registering the
JobAccountinglID

Double-click the Print Job Accounting icon.

@ Click [New].
800, _Print Job Accounting Client
UserNarme [+] Back Next

Edit
Delete

ate All

Help

@ Enter the login name used for Mac OS X,
and the JobAccountingID and UserName
for Print Job Accounting, and click [Save].

Save 3
LoginName - salo

Cancel |
UserName : saro
JobAccountinglD : |1 Help

Repeat this operation to register
multiple users.
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© Click [Save]. Registering multiple users
en0n _ Print Job gClient together
serMame ([ Back Next :
L:aw J.D %

Multiple JobAccountingID and UserName
can be registered using a CSV file. This is
useful when multiple login user names are
used in Mac OS X.

Edit
Delete
| Delete All

[ Help

© Use commercially available software to
prepare a CSV file.
In the CSV file, enter the Mac OS X login
name, JobAccountingID and UserName in

O Enter the password, and click [OK].

b Accountin lient wants 1o make .
n :::a':gj:s. xpe yr:llargp:sisw:lrd tnmalllow this. thlS Order-
L\{ (D Using 1 line for each user, enter the Mac

ol | 0S X login name, JobAccountingID and
ma: sato
UserName.
Password:l ----- |
@ Save the CSV format file.
: @ Use the client software to register.
@ Quit the client software. @ Double-click the Print Job Accounting

icon.
@ Select Import from the file menu.
@ Import the CSV file created in o

lnne Open
<> (22 = E) (85 Documents :)(a
FAVORITES (@ Applications » 5 sato.csv
(i Deskiop >
3 Ot
R (@ Oownloads »
iy Applications (B Movies
@ Music
[ Documnents B e
DEVICES (@ Public
MEDIA a‘ s'“s
J7 Music
53 Photos
1 Movies
Cancel | Open
@ click [Save].
800 — Print Job Aceounting Client
UserName D Back Next :
suzuki 2 .
sato. 1 | New
Edit
Delete
| Delete All
[ Help

@ Enter the password, and click [OK].

ﬂ Print Job Accounting Client wants o make
changes. Type your password to allow this.
J

Name: |sato |

Password: I ----- |

)

® (s [ 06

@ Quit the client software.
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Deleting the
JobAccountingID and
UserName

Changing the
JobAccountingID and
UserName

The Client software can be used to change
JobAccountingID and UserName that have
already been registered.

@ Double-click Print Job Accounting.

@ Select the user that you want to delete,

@ Double-click the Print Job Accounting and click [Delete].

icon. To delete all registered users, click
[Delete All].

@ Sclect the user that you want to change,

and click [Edit]. © Click [Save]

® Enter the new JobAccountingID and o — oS re—

UserName, and click [Save]. UserName » Back | [ N || NN

sato 1 [ New

O cClick [Save]. —

FY-Ye - Print Job Accounting Client Delete
UserName IE Back Next [E | Delete All

i et [ New —

Edit

Delete
| Delete All

[ Help

@ Enter the password, and click [OK].

q Print Job Accounting Client wants w make
u changes. Type your password to allow this.

Enter the password, and click [OK].

q Print Job Accounting Client wants o make
u changes. Type your password to allow this.

-

Name: |sato

Password: I--n. |

l'—\{ G) | Cancel

Name: |sato

Password: I--n. |

(6 Quit the client software.

@ Quit the client software.
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Memo

- 46 -



nt 1D Management

Adding the Job Account ID ........... 48
Registering the same Job Account ID to
multiple printers ........... 56
Deleting a Job Account ID or User Group .......... 62
Changing Job Account ID and User Group
settings ........... 63
Checking the usage status of individual Job
Account IDs and User Groups ........... 65
Receiving log results by e-mail ........... 67

Associating Job Account IDs to authentication



4. Job Account ID Management

4. Job Account ID Management

This section explains how to add or delete a Job Account ID, how to change settings for the
Job Account ID use restrictions, and management of Job Account IDs.

(Note!) The window and setting contents differ depending on the printer model.
O select the printer or printer group,

and then select the [Printer] menu >
[Properties].

Multiple printers can be selected.

Adding the Job Account ID

Job Account IDs can be added as required.
Add them using one of the following
methods.
e Adding manually.
e Creating a user list file and adding in a
batch.

t__';.'_, Print Job Accounting Enterprise

File Log Policy Option Help
e Users registered in Windows on the = AddaPrinter...
network are read. Manage multiple printers as a group. ..
For details on Job Account IDs, see --1 ke o U VNS G
"Preparing User Information" (page 16). EDfnE WE e
Start/End Log
) Acquire a Log
Adding manually Setting the Time
Define Fees...
@ Check that the printer power is ON. Backup of printer setting...
Properties...
@ start the server software. &

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details

@ 1n the [User] tab, click [Register].

2|

window.
3 _ y . Frinter Mame | Address The mawmum number | Present number
t_!_;‘. Print Job Accounting Enterprise 19216802 103
File Printer Log Policy Option Help
- oy
" LUEI Mame Job Account ID | Gros Statuz
Frail T Print 1A79N4R7194 Frnahle Printing
Local Print 1879048192 Enable Prinfing
Unregistered D 1} Enable Prnting
e 157 ] Ay | S ]
ok | Cancad |
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@ Click [Add].

@ select [Add a User], select the group that
the user belongs to from [User Group],
and click [Next].

ount ID registration

O Enter the [Job Account ID], [Name], and
[E-mail address] (can be omitted), and
click [Add].

notet ) If the names or user IDs duplicate
users that are already registered in the
printer, they cannot be added.

The e-mail address needs to be set in

[Notifies total result by e-mail] and
[Notifies by e-mail when Limit Value
was exceeded] in "Setting functions or
use restrictions" (page 53).

zount ID registration

© Click [Next].
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Creating a CSV file to add in
a batch

Users can be added by creating a CSV file
that contains the Job Account ID, Name
and E-mail address, and importing the file.

(NOte’ If the User Names or Job Account IDs
in the CSV file duplicate users that are
already registered in the printer, the
printer information remains, and only
the names and Job Account IDs that are
not duplicated are added.

@ Create a CSV file using software such as
Notepad or Excel etc.

<For Notepad>

@ Enter the Name, Job Account ID, and
E-mail address for each user on an
individual line. Enter the Job Account ID.
Separate the Name, Job Account ID and
E-mail address with a comma (,). The
E-mail address can be omitted.

Name Job Account ID

]]umnled Notepad
: it Format View Help

sat
hEISh'I ,fakahashi@oki. coi
5uzuk'| 3

=10l x|

murata,4q4
inoue, 5

<] ¥ A

E-mail address

@ Save in text format with the extension
“CSV".

<For Excel>

@ Enter the Name, Job Account ID and
E-mail address for each user on an
individual line. Enter the Job Account ID.
The E-mail address can be omitted.

Name Job Account ID

E Microsoft Excel - Book1

:E] Fle Edit View Inpert Format Tooks [:

NDFH IR MEB Ga@d-|9-
G - P
A | B [ C |

sato 1
takahashi takahashi@oki.com

suzuki 3
murata 4
inoue 5

M 4 » m[ySheetl shest2 £ Sheet3|/
Ready

el e | D =

E-mail address

@ Save in CSV file format.

@ Check that the printer power is ON.
@ start the server software.

@ Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

@ select the printer or printer group,
and then select the [Printer] menu >
[Properties].

Multiple printers can be selected.

@ 1n the [User] tab, click [Register].
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@ Click [Add].

O select [Add a User], select the group that
the user belongs to from [User Group],
and click [Next].

lob Account ID registration

© Click [File].

Job Account ID registration

@ Specify the CSV file created in @), and
click [Open].

@ Check that the Job Account ID and Name
have been added to the user list.

@® Click [Next].
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Importing users registered in | @ Select [Add a User], select the group that
Windows the user belongs to from [User Group],
and click [Next].

User name information from Windows 2
specified on the network can be obtained

Add a uger or a user group.
and registered as a batch to the server
software. Names that can be obtained ¢ bsalsl
are accounts registered on the specified o EEm -
computer. " Manages multiple Job Account 1D as & group.
Group WHame
(Note!) e Access permission for the specified p !
computer is required. Fads
o If the names of users that are already
registered to the printer and those
registered to the computer are
duplicated, the printer information is
not imported, and only names that
are not duplicated are added.
P check] [ heas || concs |
@ Check that the printer power is ON.
@ Start the server software. @ Click [Remote Server].
2lx]

® Double-click [Printer] in the selection _ _
SetJob Account ID and name (optionall. When multiple IDs are added, all these Dz

window. The registered printer list is il have the same seltings for Use Restictions, Lini ke are the Vaid peiod
displayed in the list view of the details Name Job Account 1D | E-mai Address |
window. .
O select the printer or printer group, G I|
File...

and then select the [Printer] menu > :
[Properties]. doh Account D |

HNane: |
Multiple printers can be selected.
Exail addiess |

@ 1n the [User] tab, click [Register].

@ cClick [Add].
Job Account ID registration 4 kS| <Back | Heat > | Cancel l
Phinkes Hame IAMN& |mm~m|nmm
MC5E1 19218802 103 3
e Usenils
List of registered IDs
T
Hame |.JobMomr\tID| Eml Stabus
Email To Prirt 1879043194 Enable Printing [ipdele
Local Pnit 1880 s Enable Fintng
Uraegistered ID o Enable Printing [harne
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© select the computer from which to obtain
user information from in [Import Source],
and click [Add].

importuser ]

User
Mame I Job Account D | Delete |
sato 23219 =
takahazhi a144
suzuki 11683
murata a0e4
inoLe 7347

Import Source

FILESERVERZ
PRINTSERWER

o]

Cancel I

Users that are registered as accounts
in the selected computer are added to
the [User] list. The Job Account ID is

assigned at random.

@ 1f user information that is not required
has been added, select Name, and click
[Delete].

@ Click [OK].

@ Check that the Job Account ID and Name
have been added to the user list.

® Click [Next].

Proceed to "Setting functions or use
restrictions" (page 53).

Setting functions or use
restrictions

The following steps apply to all Job

Account IDs registered in the steps
from page 48 to page 53. These can be
changed for individual Job Account IDs
afterwards.

@ set functions for the Job Account ID, and
click [Next].
2l

Set funchions cormesponding to Job Account ID.

™ ks oial el by el
™ Nolifies Ly e-mail when Linil Vs wes sxcesded

7' Do not process Limit Value &5 & oroup

c&mkl]*m;l(“ml

Notifies total result by e-mail

Notifies the total amount used every month by
e-mail.

Notifies by e-mail when Limit Value was
exceeded

A mail notification is sent when the print quantity
exceeds the limit value and printing is no longer
possible, and when the limit value is reset and
printing is made possible again.

Do not process Limit Value as a group

Limit values can be set individually for printer
users that belong to a printer group, and users
that belong to a user group.
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@ set the use restrictions, and click [Next].
|Job Account 1D registration =

Set Use Restrictions for the Job Account 1D

" Disable Color Printing
= Fiint I Mono
I™ Disable Copying
I™ Dizable Color Copying
™ Disable LISB Memory to Print
™ Disable USE Memory ta Colar Print
™ Disable Scan to Email
™ Disable Scan to Metwork PC / Digable Scan to Shared Folder
™ Disable Scan to USE Memany
™ Disable Fax Sending
™ Disable Scan to Intemet Fax

™ Disable Scan to Fax Server

< Bacl Next > Cancel

Disable Printing
Cancels printing.
Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Print In Mono

When disable color printing is set, monochrome
printing is performed without cancelling color
data.

Disable Copying

Copying using panel operations is prohibited.
When this is disabled, the printing prohibited
settings are applied.

Disable Color Copying

Color copying using panel operations is
prohibited. When this is disabled, the color
printing prohibited settings are applied.

Disable USB Memory to Print

Prohibits printing from a USB memory using
panel operations.

Disable USB Memory to Color Print

Prohibits color printing from a USB memory using
panel operations.

Disable Scan to E-mail

Prohibits Scan to e-mail using panel operations.

Disable Scan to Network PC /
Disable Scan to Shared Folder

Prohibits Scan to Network PC and Scan to Shared
Folder using panel operations.

Disable Scan to USB Memory

Prohibits Scan to USB memory using panel
operations.

Disable Fax Sending

Fax sending using panel operations is prohibited.
Fax sending that uses the fax driver is also
cancelled.

Disable Scan to Internet Fax

Prohibits scan to internet fax using panel
operations.

Disable Scan to Fax Server

Prohibits scan to fax server using panel
operations.

Assign to a user group, and if [Do not
process Limit Value as a group] is not
checked in step @, click [Finish] and
proceed to step @. In other situations,
click [Next] and proceed to step @.
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@ set the limit values that can be used by O set the valid period for the limit values
Job Account ID. set in @, and click [Finish].
When each of the limit values is When the valid period is exceeded, the
exceeded, printing is cancelled until the limit value count is reset.
valid period set in step @. 2|
(Note!) The limit value settings are enabled il L
from the point at which the server [By morth |
software obtains the log when the limit v el and
value has been exceeded. Printing can [T Mown  [Tomeenortnenz]
still be performed when the limit value T Cony ovet nused vakus 10 the et vaid period

is exceeded until the server software
receives the log.

Job Account ID registration x|

Set Limit Walue for the Job Accourit ID. If any Limit Value is excesded, the
prviter wll niot paink jobs tor that Job Account 1D any more.

W Printed Shests 100 sheets
I~ Eees [ dallarls)
I | Staple l saples
ook [Tesh |  Conce |
Do not specify
The valid period is not set. When the limit value
set in @ is not set, printing is cancelled unless
the limit value is increased, or the usage status is
manually reset.
Tl e e By month
Set the valid period in month units. Set the
Printed Sheets number of months and base date (10th, 20th,

. end of month, deadline).
Set the number of sheets that can be printed.

Fees By week

Set the valid period in week units. Set the

t th limit of the f h .
Set the upper limit of the fee charges number of weeks and base day.

Staple
P By day
When the optional finisher is installed, set the

. Set the valid period in day units. The number of
number of times that the stapler can be used.

days is set.
When limit values are set Carry over unused value to the next valid
w click [Next], and proceed to step @. period

Check to carry over the amount that is not used
within the valid period to the next period.

When limit values are not set

= click [Finish], and proceed to step @

- 55 -



4. Job Account ID Management

@ When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

(Note!) e Depending on the printer, this may
not be displayed.
e For details on the factory set printer

administrator password, see the User's
Manual of the printer.

@ Click [End] in the [Job Account ID
registration] window.

@ In the [Properties of printer from which
logs are acquired] window, click [OK].

Registering the same Job
Account ID to multiple
printers

The Job Account IDs and Names set in a
printer can be copied to a different printer.

(Note!) e If the Job Account ID or Name of
the users that are already registered
to the copy destination printer are
duplicated from users in the copy
source printer, the information in the
copy destination printer remains, and
only Names and Job Account IDs that
are not duplicated are added from the
copy source.

¢ Use restriction settings are also copied
together with the Job Account ID.

@ Check that the printer power is ON.
@ start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

O sclect the printer or printer group,
and then select the [Printer] menu >
[Properties].

Multiple printers can be selected.

@ 1n the [User] tab, click [Register].
@ click [Other Printer].

Job Account ID registration 2=
MNMIM |mm~m|nmm
(=5 19216802 103 3
e senile
List of rsgisteredIDs
[T
Hame AJob Account ID | G Stabus
Email To Print 1879043154 Enable Printing D
Local Pnt 189048192 Enable Fintng
Uraegistered ID o Enable Printing [harme
Chrrme Grongy, |
L e |
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@ select a printer or printer group that
already has user information registered
from [Import Source], and click [Add].

importuser ]

User

Mame I Job Account D | [elete |

Import Source

o]

Cancel I

The Job Account IDs and Names
registered in the selected printer or

printer group are added to the [User] list.

@ 1f user information that is not required
has been added, select the Name, and
click [Delete].

O Click [OK].

@ When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

(Note!) Depending on the printer, this may not
be displayed.

m Check that the Job Account ID and Name

have been added to the user list.

@® Click [End] in the [Job Account ID
registration] window.

® 1n the [Properties of printer from which
logs are acquired] window, click [OK].

Managing multiple users as a
group

Multiple Job Account IDs can be managed
as one group. When managed as a group,
the log can be displayed in group units.
Furthermore, the limit values can be set to
all of the users that belong to the group.

0 Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

® select the printer for which you want to
create a user group, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.

O click [Registration] in the user tab.

@ Click [Add].
Job Account ID registration d |
Phinkes Hame ].Minsa |Ihmﬁummm[ﬁnmmm
MCSE1 15216802 103 1
shewllserills |
List of registered IDs

[— |
Neme [ JobAccountID | Group [ Status ]
Email To Prirt 1879043194 Enable Printing [irdee
Local Pnt 1849048192 Enable Fintng
Uraegistered ID o Enable Printing e
ugveara I Enabls Hinkng
hashimoto E Enable Printing
nows 5 Enable Fintng
kalu 8 Erialde: Prirdirny o
murata 4 Enable Fintng
zaln & | Enalde: Prirdirg :I Erul
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O select [Management multiple Job Account
ID as a group], enter the [Group Name]
and [E-mail address] (can be omitted),
and click [Next].

The e-mail address needs to be set in
[Notifies total result by e-mail] and
[Notifies by e-mail when Limit Value
was exceeded] in step 0.

TS|
Add a user o a user group.
" Add aUser
[ser Group INUlulagluuy ;l

@ Manages multiple Job Account D as & group.

Group Name |sm Section No.1

E-mal addiess I

A e |

@ Select the user that you want to assign to
the group, and click [Next].

2l

Fmﬂnl&mﬂ»wam;oumwmwaum

To select muliphz consecutive users, click the first user, press and hold down
SHIFT. and then click the last user. To select multiple non-consecutive users. press
and hold down CTRL, and then chick on each user.

Hame | Job Account ID | Group |
Email To Print 1879048194
Local Fint T8MAIME Y2

1]
i
B
5
8
4
1

oozl 3 |
takahashi 2
cgack | [ heas || Conce |

@ set the functions for the group, and click
[Next].
2=

Set funchions comesponding to Job Account ID.

I~ s i i By
™ Motifies Ly e-mail when Limi Yahoe wes scesded

= Do ot process Limit Valie &5 & oroup

c&ncklumﬂ)lﬂmmll

Notifies total result by e-mail

Notifies the total amount used every month by
email.

Notifies by e-mail when Limit Value was
exceeded

A mail notification is sent when the print quantity
exceeds the limit value and printing is no longer
possible, and when the limit value is reset and
printing is made possible again.

Do not process Limit Value as a group

Limit values can be set individually for user
groups of printers that belong to the printer

group.
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© set the use restrictions, and click [Next].
|Job Account ID registration x|

Set Use Restrictions for the Job Account 1D

" Disable Color Printing
= Fiint I dono
™ Disable Copying
I™ Dizable Color Copying
™ Disable LISB Memory to Print
™ Disable USE Memory ta Colar Print
™ Disable Scan to Email
™ Disable Scan to Metwork PC / Digable Scan to Shared Folder
™ Disable Scan to USE Memany
™ Disable Fax Sending
™ Disable Scan to Intemet Fax

™ Disable Scan to Fax Server

Disable Printing
Cancels printing.
Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Print In Mono

When disable color printing is set, monochrome
printing is performed without cancelling color
data.

Disable Copying

Copying using panel operations is prohibited.
When this is disabled, the printing prohibited
settings are applied.

Disable Color Copying

Color copying using panel operations is
prohibited. When this is disabled, the color
printing prohibited settings are applied.

Disable USB Memory to Print

Prohibits printing from a USB memory using
panel operations.

Disable USB Memory to Color Print

Prohibits color printing from a USB memory using
panel operations.

Disable Scan to E-mail

Prohibits Scan to e-mail using panel operations.

Disable Scan to Network PC /
Disable Scan to Shared Folder

Prohibits Scan to Network PC and Scan to Shared
Folder using panel operations.

Disable Scan to USB Memory

Prohibits Scan to USB memory using panel
operations.

Disable Fax Sending

Fax sending using panel operations is prohibited.
Fax sending that uses the fax driver is also
cancelled.

Disable Scan to Internet Fax

Prohibits scan to internet fax using panel
operations.

Disable Scan to Fax Server

Prohibits scan to fax server using panel
operations.

Create a user group in the printer group,
and if [Do not process Limit Value as a
group] is not checked in step 0. click
[Finish] and proceed to step ®. In other
situations, click [Next] and proceed to step

©.
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@ set the limit values that can be used by
the user group.
If the total amount used by all users that
belong to the group exceeds the limit
values, printing is cancelled for all users
that belong to the group until the valid
period set in step ®.

(Note!) The limit value settings are enabled
from the point at which the server
software obtains the log when the limit
value has been exceeded. Printing can
still be performed when the limit value
is exceeded until the server software
receives the log.

Job Account ID registration I x|

Set Limit Yalue for the Job Account ID. If any Limit Value is exceeded, the
prnter vall not pant jobe for that Job Account 1D any more.

W Erinted Shests 100 sheets
I Eees [ dollarls)
I7| Starle I slaples

<gack [THeAs |  Cace |

Printed Sheets

Set the number of sheets that can be printed.
Fees

Set the upper limit of the fee charges.
Staple

When the optional finisher is installed, set the

number of times that the stapler can be used.

When limit values are set

== click [Next], and proceed to step m

When limit values are not set

1= click [Finish], and proceed to step @

® set the valid period for the limit values
set in @, and click [Finish].
When the valid period is exceeded, the
limit value count is reset.

2]
Specify the valid petiod for the Job Account ID. If the valbd period specified
here expues, sach index is ceared.
Il]ylmdh j
To 10/31/2011

[ Momn [Tomeendoithenz]

™ Cany over unused value to the next vaiid period

oot [ | oo |

Do not specify

The valid period is not set. When the limit value
set in 9 is exceeded, printing is cancelled unless
the limit value is increased, or the usage status is
manually reset.

By month

Set the valid period in month units. Set the
number of months and base date (10th, 20th,
end of month, deadline).

By week

Set the valid period in week units. Set the
number of weeks and base day.

By day

Set the valid period in day units. The number of
days is set.

Carry over unused value to the next valid
period

Check to carry over the amount that is not used
within the valid period to the next period.
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@® Click [End] in the [Job Account ID Changing the user group
registration] window.
2] @ start the server software.
Printes Mame | Addiess The maxmum numbes | Present ramber
R — " @® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.
sz Useri s
Litof et D5 S @ select the printer whose user group you
Heme [ JobAccountiD | Group [ Status [+
EmaiTorim 1675048134 EncbleP. Dok want to change, and then select the
Liroup Bales Bechon Mol Enable F...
ULucHPLn';ﬂU 13?9143193 E$EE e [Printer] menu > [PrOpertieS].
fliw:: 7 End)lEP:: Cheene Giings
hashmoto b SakaSechonMol EnableF... . .
i 6 SabsSeafirt ! FucinP Qs Divter Multiple printers can be selected.
kato 4 Enablc ...
O 1n the [User] tab, click [Register].
20
® In the [Properties of printer from which e
logs are acquired] window, click [OK]. e
MCEET 192168.0.2 103 it
Narme | JobAccountID | G Status -
Frail T Print 1R79N48194 Frahle Pr
Group Sales Section Mo.1 Enable Fr...
Group Sales Section Mo.2 Enable Fr...
Local Print 1879048192 Enable Fr...
Unregistered 1D 1] Enable Fr...
fujivara 7 Sales SectionMo.2 EnablePr..
hashimoto E SalesSectionMo.l EnableFr...
noue 5 Sales SechonMol  Enable Fr..
kata 8 SadesSectionMo2 EnablePr. o

ViewlsoriDz | Authontication User..

@ select the user whose group you want to
change, and click [Change Group].

2l
Phinkes Hame IAMnsa |Ihm'mmmnbﬂ|l’|nmmm|
MCSE1 15216802 103 1
List of rsgistered ID's
Aukd
Hame [ JobAccount D | Group [ Status [+
Email To Print 1879048134 Enzble P... Dekele: !
Graup Sales Sechion Mol Enable F...
Graup Sales Section Mo.2 Enzble P... [Hirie |
Local Pt LT R Enable ...
Uraegistered ID 0 Enable P... Cheange: Gy
hashinmodn f SakxSedimbo1 Frsbie P Dthes Pririter...
INCUS: 5 SokesSechonMol Enable P
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@ select the new group to be assigned to,
and click [OK]. To remove the printer
from all groups, select [Not in a group].

Group List

Ok | Cancel |

@ Click [End].
I
Phinter Name IAMN& |Ihmhmmm|ﬁnmmm
MC5E1 19218802 103 1
e Useni e
List of registered 1D

|
Heme [ JobAccountiD | Group [ Status
Email To Pririt 1879046194 Enzble ... Diedelre
Group Sales Sechion Mo.1 Enable F...
Group Saler Section Mo.2 Enable P... e
Local Prnt 187AME R Enabic ...
Uraegiztered ID 0 Enzble F.., w
hapweara ! SaksSechonMo.l EnableP...
heshimtn i SekesSedimNo 1 Frsie P Dihe: Pricte
Inowe 5 SalesScchon Mol  Enable ..
kals 8 SaksSedimNol Frsbie P Eml

@ Check that the group is changed, and
click [OK].

Properties of printer from which logs are acquired ) _?IZ[

Frinter Mame I Address l The mawmmum rumber I Fresent number I
MCEE1 19216802 103 1

Name | Job&ccountID | G Stalus |«
Froail Tr Print TR79N4/194 Frahle Pr
Group Sales Section Mo.1 Enable Fr...
Group Sales Section Mo.2 Enable Fr...
Local Print 1879048192 Enable Pr...
Unregistered |0 1] Enable Fr...
fujiveara 7 Sales SectionMo.l EnablePr.. |
hashimoto B SalesSectionMol EnablePr..
noue b Sales SechonMol  Enable Fr..
kata 8 SalesSectionMol  EnablePr.. ;‘

ViewlsoriDz | Authontication User..

OK Cancel

Deleting a Job Account ID
or User Group

(Note!) [Local Print], [Email To Print], and
[Unregistered ID] cannot be deleted.

@ Check that the printer power is ON.
@ start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

O sclect the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.

@ 1n the [User] tab, click [Register].

@ select the Name or Group Name from
the [List of registered IDs], and click

[Delete].
21
PtiﬂmNmIAMna IIhmim\mmmlﬁnmmnlm
] 19216802 103 1
List of registered 1D |
Hame [ JobAccouniD | Group [ Stabus =
Email To Piint 1873048194 Enable F... Dl
Group Sales Sechon Mol Enable P
Group Sales Section Mo.2 Enzble F... Change ]
Local Frint THEME S Enable P,
Urvegistered ID 0 Enble F... Chesnge Giongs
! Sal o] Enablc
[r— R SabsSedinbol Frdie P Dthes Printer...
Inowe 5 SalesScchon Mol  Enable ..
kals B SabsSeddimbul FrableP =

@ Click [Yes] in the confirmation window.

O Click [End] in the [Job Account ID
registration] window.

O 1n the [Properties of printer from which
logs are acquired] window, click [OK].

When a user group is deleted, the users
that belonged to the deleted user group
are changed to [Not in a group].
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Changing Job Account ID
and User Group settings

@ Check that the printer power is ON.
@® sStart the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

O sclect the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.

@ Inthe [User] tab, click [Register].

@ select the Name or Group Name whose
settings you want to change from
the [List of registered IDs], and click

[Change].
2ix]
Phinkes Hame | Addiess The maximn numbes | Present numbes
MC5E1 19218802 103 n
Sizw Userils
List of ragistered IDs.
e ]
Hame JobAccountlD | G Stabus >
Email To Print 1879043194 Enable Printing Delele: |
Local Pint 1879048192 Enabie Printng
Ureegistered ID 0 Enable Printing Change
hugveara 7 Enabls Finkng
hashimoto [ Enable Printing Chesge Grougs
5
8 Othes Printer...
F
| Zoam—

(7] Change the settings in the [Job Account
ID] (or [User Group] for groups), [User
Restrictions], and [Limit Value] tabs, and
click [OK].

0]
Job Account ID ILbeReshx:homl LniValuel Usage&dusl
Hame I
Job Account 1L 4
Statuz Enable Prirting
E -mail address |
Uzcr Group INot'n a group j

I~ Motifics total rozult by ¢ mad
™ Mndifies by p-mal when |imi Valie was secenderd

I= | Doinct process Limit Y elue as & group

[k ] cnce |

Job Account ID tab

Name

This can be specified in a maximum of 80
characters. """ cannot be used.

(Note!) The Job Account ID cannot be changed.
In order to change the Job Account ID,
delete the Job Account ID and then add
it again.

E-mail address

Enter to send an e-mail when the use amount or
limit values are exceeded.

User Group

Set the group to assign the user to.
If you do not want to assign the user to a group,
select [Not in a group].

Notifies total result by e-mail

Notifies the total amount used every month by
e-mail.

Notifies by e-mail when Limit Value was
exceeded

A mail notification is sent when the print quantity
exceeds the limit value and printing is no longer
possible, and when the limit value is reset and
printing is made possible again.
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Do not process Limit Value as a group

Printer limit values can be set individually for
users/user groups that belong to printer groups,
and users that belong to user groups.

User Restriction tab
|

Set Use Restictions for the Job Account D

" Digable Color Printing
™| Frint In Moo
™ Disable Copying
[™ Disable Calor Copying
[ Disable USE Memory to Print
[ Disable USB Memon to Color Print
[ Disable Scan ta Emal
™ Disable Scan to Network PC / Dizable Scan to Shared Folder
[~ Disable Scan to USE Memon
" Disable Fax Sending
[ Disable Scan ta [ntemet Fax

[ Disable Scan to Fax Server

< Back Next > Cancel

Disable Printing
Cancels printing.
Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Print In Mono

When disable color printing is set, monochrome
printing is performed without cancelling color
data.

Disable Copying

Copying using panel operations is prohibited.
When this is disabled, the printing prohibited
settings are applied.

Disable Color Copying

Color copying using panel operations is
prohibited. When this is disabled, the color
printing prohibited settings are applied.

Disable USB Memory to Print

Prohibits printing from a USB memory using
panel operations.

Disable USB Memory to Color Print

Prohibits color printing from a USB memory using
panel operations.

Disable Scan to E-mail
Prohibits Scan to e-mail using panel operations.

Disable Scan to Network PC /
Disable Scan to Shared Folder

Prohibits Scan to Network PC and Scan to Shared
Folder using panel operations.

Disable Scan to USB Memory

Prohibits Scan to USB memory using panel
operations.

Disable Fax Sending

Fax sending using panel operations is prohibited.
Fax sending that uses the fax driver is also
cancelled.

Disable Scan to Internet Fax

Prohibits scan to internet fax using panel
operations.

Disable Scan to Fax Server

Prohibits scan to fax server using panel
operations.

Limit Value tab
Properties of Job Account 2]

Job Account 1D I Use Restrictions  Limit Valus | Usage Status I

100 shests

" Fess |D dollar()

[T Staple ID staples
“Walid Period
I By marth j
To 1043142011
I'I_ Ianth To the end of the month j
[~ Camy over unused value to the next valid period

ok | cwen |

Printed Sheets

Set the number of sheets that can be printed.
Fees

Set the upper limit of the fee charges.
Staple

When the optional finisher is installed, set the
number of times that the stapler can be used.
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Valid Period

The valid period is displayed when limit
values are set. When the valid period is
exceeded, the limit value count is reset.

Do not specify

The valid period is not set. When the limit value
is exceeded, printing is cancelled unless the
limit value is increased, or the usage status is
manually reset.

By month

Set the valid period in month units. Set the
number of months and base date (10th, 20th,
end of month, deadline).

By week

Set the valid period in week units. Set the
number of weeks and base day.

By day

Set the valid period in day units. The number of
days is set.

Carry over unused value to the next valid
period

Check to carry over the amount that is not used
within the valid period to the next period.

(Note!) e The limit value settings are enabled
from the point at which the server
software obtains the log when the limit
value has been exceeded. Printing can
still be performed when the limit value
is exceeded until the server software
receives the log.

o If the valid period is changed, a
confirmation window is displayed to
check whether or not to reset the
usage status. To reset the usage
status, click [Yes].

@ When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

(Note!) Depending on the printer, this may not
be displayed.

© Click [End] in the [Job Account ID
registration] window.

© In the [Properties of printer from which
logs are acquired] window, click [OK].

Checking the usage status
of individual Job Account
IDs and User Groups

Checking the usage status

(Note!) To check or reset the usage status
including the log remaining in the
printer, first refer to "Immediately
acquiring the log" (page 196), and
acquire the log.

@ sStart the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

@ select the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.

O 1nthe [User] tab, click [Register].

@ select the Name or Group Name that you
want to check from the [List of registered
IDs], and click [Change].

2]

Phinter Name ].Minss |Ihnwiu.nmmba[ﬁnmmm
Ca41 132168.03 5002 10

Wjew Useni e

List of ragistered IDs. aakl

Hame JobAccountID | Gi Stabus -
Local Print 1879048152 Enable Piinting Dokl
Uraegstered ID 1] Enable Prining
fuijveara 7 Enable Fiinting Lhange
hashmelo E Enable Prining
inoue 5 Enable Prirting Change: Grong
Kato g Enable Prining
fnsala 4 Enalde: Prirtiny Dthes Printer...
sabo 1 Enable Pinkng &
ki 3 Enbie Printing =l |I|
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@ Check the [Usage Status] tab.
2ix

" Job Account ID | Use Restrictions | Limit Value  Usage Stetus |

Akpadyased ammt Avalable 1mane
amount
Frinted Sheets U Sheets Al Sheets
Feer 0 dollards] - dollas]
Staple 0 staples - staples
I~ fet
_Coed |

Printed Sheets

The number of sheets printed until now and the
remaining number of prints are displayed.

Fees

The fees incurred until now and the remaining fee
amount are displayed.

Staple

When the optional finisher is installed, the
number of times the stapler was used until now
and the remaining number of times are displayed.

e The usage status of the users and user
groups registered to the printer group
is the total usage amount of the users
and user groups from all printers that
belong to the printer group. Also, the
usage status of the user group is the
total usage amount of all users that
belong to the user group. However,
the usage amount of users and user
groups that have the [Do not process
Limit Value as a group] check mark
checked are not included.

e When a valid period is set for the
Job Account ID, when the period has
passed, the usage status value is
automatically reset to 0.

@ When the confirmation is completed, click
[OK].

O Click [End] in the [Job Account ID
registration] window.

O 1n the [Properties of printer from which
logs are acquired] window, click [OK].

Resetting the usage status

© Follow the steps from Qww®in
"Checking the usage status" (page 65).

@® Check the [Reset] check box in the
[Usage Status] tab, and click [OK].

(Note!) If the [Status] in the [Job Account ID]
tab (or [User Group] tab for groups) is
"Disable Printing (Exceeded the limit
value)", it cannot be reset unless the
printer power is ON.

2ix]
Job Accourt ID | Use Restrictions | Limit Value  Usage Status |
Alradyzed ammmnt Avalahle izage
amount
Frnted Sheets U Sheets 2 Shests
Fee: 0 dollarfs) - daflars]
Staple 0 staples - staples
7 St
_Cored |

® Click [Yes] in the confirmation window.

O Click [End] in the [Job Account ID
registration] window.

@ 1n the [Properties of printer from which
logs are acquired] window, click [OK].

When the usage status of the user and
user group registered to the printer
group is reset, the usage status of the
users and user groups of all printers
that belong to the printer group are
reset. Also, when the usage status of a
user group is reset, the usage status of
all users that belong to the user group
are reset. However, the usage status
of users and user groups that have the
[Do not process Limit Value as a group]
check mark checked are not reset.
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Receiving log results by
e-mail

Log results can be notified by e-mail to the
user every month.

(Note!) The outgoing mail server and sender's
e-mail address need to be configured in
advance according to the "Setting the
outgoing mail function" (page 224).

eThe mail is sent of the day after the

deadline (default setting is end of
the month) set in the "Changing the
deadline" (page 195).

e Iltems to be logged can be changed in
"Changing log items to be exported"
(page 201).

@ Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

@ select the printer or printer group,
and then select the [Printer] menu >
[Properties].

Multiple printers can be selected.

@ 1n the [User] tab, click [Register].

@ select the user to set, and click
[Change].

@ Enter the E-mail address in the [E-mail
address] field of the [Job Account ID]
tab, and check the [Notifies total result
by e-mail] check box.

Praperties of Toh Account T | 21x|

Job Accourt ID | Use Restrictions | Limit Value | Usage Status |

Mame Itakahashi
Job Account 1L 2
Statug Enable Frinting

E-mail address

Itakahashi@oklcm

IS:\I@ Scction Ho.1 j

T Mndifies by p-mail whean Limit Yalie was eireeded

I Do not process Limit Value as a group

@ Click [OK].

O Click [End] in the [Job Account ID
registration] window.

O 1n the [Properties of printer from which
logs are acquired] window, click [OK].
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Associating Job Account
IDs to authentication
users

In models that have an access restriction
function on the control panel in which
user name/password authentication is
being used, a Job Account ID can be
associated with user names that perform
authentication. When a Job Account ID is
associated with a user name, when that
user name/password are used to login to
the control panel, or when the user name/
password are set in the printer driver when
printing is performed, the use restrictions
associated with the Job Account ID are
enabled.

(Note!) e "Admin" cannot be specified as the
user name.

e The same Job Account ID can be
associated with different user names.

Adding manually

@ Check that the printer power is ON.
@ Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

™ Print Job Accounting Enterprise

File Printer Log Policy Option Help

+-Log

O select the printer or printer group,
and then select the [Printer] menu >
[Properties].

Multiple printers can be selected.

t__';.'_, Print Job Accounting Enterprise
File Log Policy Option Help

=-F  Add aPrinter...

Manage multiple printers as a group...
Delete a Printer Printer Group

- Change a Printer Group...

Start/End Log

Acquire a Log

Sething the Time

Define Fees...

Backup of printer setting...

Properties...

40

@ Click [Authentication User] in the [User]
tab.
The association between the user name
registered to the printer and Job Account
ID is acquired and displayed in the
register list.
2|

Frinter Mame I Address l The mawmum rumber I Fresent number I

MCEE1 15216802 103 1

Name | JobdccountiD | Giowp | Status [«
Frnail Tru Print TR7AN4/194 Frahle Pr
Group Sales Section Mo.1 Enable Fr...
Group Sales Section Mo.2 Enable Fr...
Local Print 1879048192 Enable Pr...
Unregistered 1D 1] Enable Pr...
fujivara 7 Sales SectionMo.2 EnablePr.. |
hashimoto 6 SalesSectionMol EnablePr..

L

Sales Sechon Mol Enable Fr...
Sales Section Mo.2  Enable Pr... j

noue
kata

o

Vicwlieor Dz || Authontication Usr..

OK Cancel
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@ Enter the [User Name] in the user name,
select the Job Account ID that you want
to associate with the user name from
[Job Account ID], and click [Add]. To
delete associations, select the association
that you want to delete from the
registration list, and click [Delete].

Aszociation with Authentication User and Job Acc. [ E3

Fieqgistration List

User Mame | Job Account 1D

[relete |
Charige |
File... |
Remate Server.. |
Other Printer... |

Uzer Hame Isato Registration |
Job Account D |1 'I End |

Pazzword I LITIET )

@ Click [Registration].

(Note!) » Register all associations between the
registration list user names and Job
Account IDs.

* The associations deleted from the
registration list are also deleted from
the printer.

Association with Authentication User and Job Acc_ [ E3

Registration List
Add

|zer Mame | Job Account 1D |

zato 1 Dielete |

[Change |

File... |

Remate Server... |

Other Printer... |
—

Registration I

Uzer Hame I
Job Account 1D |1 - End |

Paszword I [

@ When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

(Note!) For details on the factory set printer
administrator password, see the User's
Manual of the printer.

Print Job Accounting Enterprise ] 2=l

Fleaze enter the adminiztrator pazsword of the printer.

FPazzword

Caticel |

@ When a message showing that the
process was successful is displayed, click
[OK].

Print Job Accounting Enterprise x|

Succeeded in registration of a user name

@ click [End].
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Creating a CSV file to add in
a batch

A CSV file that contains the User Name
and Job Account ID can be created, and
associations added to the user names and
Job Account IDs by importing the file.

@ Create a CSV file using software such as
Notepad or Excel etc.

<For Notepad=>

@ The authentication user and Job Account
ID are included for each user individually
on a separate line. The authentication
user and Job Account ID are separated
with a comma (,).

_i5/x]
File Edit Format Wiew Help

sato,l -
takahashi,?2 -J
suzuki,3

murata,d4

inoue, 5

R H

@ Save in text format with the extension
"CSV".
<For Excel>

@ The authentication user and Job Account
ID are included for each user individually
on a separate line.

@J File Edit View Insert Format
NEH SR VR &d
ML
AR - e

gam B | T |

zato
takahashi
suzuki
murata
inoue

LT e Ll MO =

!
4 4 ¢ M |%Sheetl { Sheet2 f Sheet3 /
‘Draw~ | | AutoShapes= N . []

Ready

1 = LT Y BN ) P

@ Save in CSV file format.

@ Check that the printer power is ON.
@ Start the server software.

@ Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

@ select the printer or printer group,
and then select the [Printer] menu >
[Properties].

Multiple printers can be selected.

O In the [User] tab, click [Authentication
User].
The association between the User Name
registered to the printer and Job Account
ID is acquired and displayed in the
register list.

@ cClick [File].

Association with Authentication User and Job Acc..JE E3

Registration List
Add

Delete |

LChange |

Llzer Mame I Job Account 1D I

Bemote Server... |
Other Frinter... |

Uzer Name I Registration |
Job Account [D |1 'I End |

Paszwond I

@ specify the CSV file created in @, and
click [Open].

@ Check that the User Name and Job
Account ID have been added to the
registration list.

(Note!) When a Job Account ID that is not
registered to the printer is specified,
the registration list is not displayed. A
Job Account Id needs to be added in
advance.
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@ Click [Registration].

(NOte!) * Register all associations between the
registration list User Names and Job
Account IDs.

» The associations deleted from the
registration list are also deleted from
the printer.

Association with Authentication User and Job Acc_ [ E3

Registration List
Add

zer Mame I Job Account 1D I

zato 1 [relete |
Change |

File... |

Remate Server... |

Other Printer... |

Usger Mame I

Job Accaunt D |1 i Erd |

Passwaord I

m When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

(Note!) For details on the factory set printer

administrator password, see the User's
Manual of the printer.

Print Job Accounting Enterprise 2=

Fleaze enter the administrator pazsword of the prinker.

Fazzword I —
Cancel |

® When a message showing that the
process was successful is displayed, click
[OK].

® click [End].

Importing users registered in
Windows

User name information can be acquired
from Windows specified on the network,
and a Job Account ID can be associated.
User names that can be obtained are
accounts registered on the specified
computer.

(Note!) Access permission for the specified
computer is required.

@ Check that the printer power is ON.
@ start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

O sclect the printer or printer group,
and then select the [Printer] menu >
[Properties].

Multiple printers can be selected.

@ In the [User] tab, click [Authentication
User].
The association between the User Name
registered to the printer and Job Account
ID is acquired and displayed in the
register list.

0 click [Remote Server].

Association with Authentication User and Job Acc. [EHE3

Registration List

Add

Delete |
Change |
File |

Uzer Hame | Job Account D |

Other Printer... |

Uzer Name I Registration |
Job Account [D |1 VI Erd |

Password I
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@ When the computer from which user

information is acquired is selected in
[Import Source], the acquired User Name
is displayed in the [User] list.

rmportuser I

Uszer

User Mame | Job Acoount i Delete |

Import Source Sl

FILESERYERT
Izar Mame Job Account (D

sato I 1 j
takahazhi

suzuki

murata

inoue

Ok I Cancel |

@ select the user name from the [User

Name] list, select the Job Account ID to
be associated from the [Job Account ID]
list and click [Add], and the User Name
and Job Account ID are added to the
[User] list.

Uzer

Uzer Mame |J0bAccountII Dielete |

Import Source Add
FILESERYER1 =]
zer Mame Job Account (D
I |
takahashi
suzuki
murata

inoue

Ok I Cancel

O click [OK].

@ Check that the User Name and Job
Account ID have been added to the
registration list.

® click [Register].

(Note!) = Register all associations between the
registration list User Names and Job
Account IDs.

» The associations deleted from the
registration list are also deleted from
the printer.

Association with Authentication User and Job Acc_ JE E3

Registration List
Add

U zer Hame | Job Account 1D |

zato 1 [elete |
Charge |

File... |

Remate Server... |

Other Printer... |
User Mame I
Job Accaunt D |1 _' End |

Password I

@ When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

Print Job Accounting Enterprise ] e |

Fleaze enter the administrator pazsword of the printer.

Fazzword IT
Cancel |

® wnhen a message showing that the
process was successful is displayed, click
[OK].

® click [End].

_ 72 -



4. Job Account ID Management

Importing from a different @ select the printer from which user
. information is acquired in [Import
printer acq Limp
Source] and click [Add], and the User
The associations of User Names and Job Names and Job Account IDs are added to
Account IDs set in a printer can be copied the [User] list.

to a different printer.
@ click [OK].

(NOte!) If the associations between User Names m 2 x|
and Job Account IDs already registered
in the copy destination printer are User
duplicated by those in the copy source Mame | JobAccountID ] Delete |
printer, the copy destination information
remains, and the associations of User
Names and Job Account IDs that are not
duplicated are added.

@ Check that the printer power is ON.

9 Start the server software. Impart Source

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

O sclect the printer or printer group,
and then select the [Printer] menu >

[Properties]. oK I Cancel

Multiple printers can be selected.

@ Check that the User Name and Job

O In the [User] tab, click [Authentication Account ID have been added to the
User]. registration list.
The association between the user name © click [Registration].

registered to the printer and Job Account

. . . . (Note!) * Register all associations between the
ID is acquired and displayed in the

registration list user names and Job

register list. Account 1Ds.
@ click [Other Printer]. = The associations deleted from the
Association with Authentication User and Job Acc_ [ E3 reglstratlon list are also deleted from
the printer.

Reqistration List
Add Association with Authentication User and Job Acc. [EHE3

[elete | Fregistration List
Add |
Change | Uzer Hame | Job Account 1D |
1 Delete |

zato

File... |
Change |

Remate Server... |
File... |

Remate Server... |
User Name I Reqistration | -
Other Printer... |

Job Account 1D Iﬁ End |

Passwaord I

User Mame | Job Account 1D |

User Mame I

Job Azcaunt D |1 ¥ |

Password I
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@ When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

Print Job Accounting Enterprise Hﬂl]

Fleaze enter the administrator pazsword of the printer.

Fazzword I —
Cancel |

® When a message showing that the
process was successful is displayed, click
[OK].

® click [End].
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Setting use restrictions to the login name
Setting use restrictions to the application name
Setting use restrictions to the document name
Setting use restrictions to the host name
Adding settings to printers

Displaying use restrictions that are already
registered in printers

Deleting use restrictions

Changing use restrictions

Deleting all use restrictions
Temporarily disabling use restrictions

Enabling use restrictions




5. Managing use restrictions

5. Managing use restrictions

This section explains how to manage use restrictions, such as adding or deleting use
restrictions to login names, application names, document names (URL), and host names

included in print jobs.

Setting use restrictions to
the login name

If required, use restrictions can be set to
the login name. Add the settings using one
of the following methods.

e Adding manually
e Adding from the log

e Creating a login name list file and adding
in a batch

e Users registered in Windows on the
network are read

Adding manually
@ Check that the printer power is ON.
@ Start the server software.

@ Click the [Policy] menu > [Edit Policy].

% Print Job Accounting Enterprise
File Printer Log | Policy Option Help

&-Log Delete Al Policy...
Enable Policy...
Disable Policy. ..

User Registration on Active Directory...

O Click the [Login Name] tab.

=i
[Cannaziean =] e Pokey |

T [ Poley— - Pokcy for LogeHarns.
‘Satect Ophan ¥ ervcd User. = Enable Printing e
j ™ Prinkin Hona
Eriet Logia Hare: l— " Dissble Color Printing
" Disable Prning
|

™ AddUnvegisterd len

B B N T |

@ select [Manual] as the registration

method.
T x|
[Cennazieans =] ioqiePeky
Login Hams | apkssien | Doctment | Mot | ==
[ Logn Name 1 [ Poler- Py fos Login M.
Satect Optan ¥ ervcd User. = Enable Printing e
1 PritinMons.
r .
lg';n it Ufuﬁuwl-ﬁq
I AdduUnegistend hen

B B

@ Enter the login name that you want to

add settings to in the login hame input
field.

T x|
[Cannaziean =] e Py |
Login Name | pplesion| Document | Host |
[~ Lopr Mame — 1 [ Pobey Py o Logn Marns.
[ognbione  Poky |
‘Satect Ophan % ervcd User = Enabie Printing —
[Manaal z 1 PritinMons.
o dl e
" Disable Priing
=)
T~ AddUnvegisterd lien

L I T |

@ Select the use restrictions that you want
to use.

T x|
[Cannaziean =] e Py
Login Name | Appkeaton | Document | Host | ==
[~ Lopr Mame — 1 [ Py o o Lo e
‘Satect Ophan % ervcd User = Enabie Printing —
[Mensl ) 1 PritinMons.
Eonloonome S5 1 Disable Cokr Prining
" Disable Priing
=)
T AddUnvegiterd fien

L I T |
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Enable Printing Adding from the log

Use restrictions can be set to the login
names included in an acquired log.

Allows printing.
Print in Mono

(Note!) Before going to the following, you need
to complete the procedures of “Export
job information in a file if this utility
acquires logs” (page 237).

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

@ Check that the printer power is ON.

@ start the server software.
Disable Printing ® cClick the [Policy] menu > [Edit Policy].
C | inting.

ancels printing O click the [Login Name] tab.

©® cClick [Add] in the Policy field.

The added login name and use @ select [Log] as the registration method.

T =l
restrictions are displ in the [Poli T —
est ct-o s are d§p ayed in the [Policy e G _ sensuray |
for Login Name] list. oo oy
TS T
T = """""""""“‘ AN !
T I
Ak ral - . T
| I = | ETIAETE ]n__ﬁhl :Mwﬁﬁg
- =T TS — | g |
o Sy o —_—
Eriei LogiMarme [Sa " Disable Car Priniing Bre |
1 Disable Priving = L
T i Urveggetend lam
|

T AddUnvegstend han

I o

_wm | e | e |

@ select the login name that you want to
add settings from the list to.

. . T =l
O click [Add] at the bottom of the window. e s
‘Logn Name Drocument | How _I'
CU £ Iw"'_”"‘" = =
T E— T o —
‘Logii Nams | Applesin | Documert | Host | 2 L Saect Opson' svcl ses: P —

| Ligin Name:

| ;ﬁih‘mh-ﬂﬂ-
[Manal

Eonbognbane [San

¥ Enable Prining

" PontinMons.

" Diable Csior Prking
" Disabie Prring

[ECE|

T AddUnvegstend fham

TP TS I |
San Trabis Partrg

_M[IEM

Proceed to “Adding settings to printers”

(page 93).

(NOte!) If the "Adding settings to printers"
(page 93) steps are not executed, the

set use restrictions are not registered to

the printer.

Log.

_we | e | [ ]

@ select the use restrictions that you want
to use.
T =l

[Cennaziean =] femie Py |

‘Login hsms | Applesien | Document | Hott |

Ligin Name:

|9-=Mmh-uu-
| Log

_we | e | [Tl ]
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Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Disable Printing
Cancels printing.
©® cClick [Add] in the Policy field.
The added login name and use

restrictions are displayed in the [Policy
for Login Name] list.

0

[Cannaziean =] e Pokey |
Login Name | Appkeaton | Document | Host |
" Logh Hame —_— [Py Poky fr LoginHare
N
‘St Upan b srvod Liper: 1 Enable Priting ™) - Erubls Prrieg
Log i 1 Pritin Mons.
g 1 Disable Cokr Prining
takshashy 1 Dinable Prning
Tupdi
L LY
e
T~ AddUnvegisterd len

o | me ] e |

© Click [Add] at the bottom of the window.

e i
[Cannaziean =] e oy |

lognbame | Py PokylLogabime
M
‘Gt Upon 4 sriod Liper: ¥ Enable Printing ™) — bl Pareg

Log A  Prinkin Hona.
" Dissble Color Priniing
1 Dinable Printing
|
|
Dipletn I

T~ AddUnvegisterd len

Login Hams | appikssien | Document | Mot |

at
takahashi
ubki
rouanin
eue

L'Eil

Proceed to “Adding settings to printers”
(page 93).

(Note! If the "Adding settings to printers"
(page 93) steps are not executed, the
set use restrictions are not registered to
the printer.

Creating a CSV file to add in
a batch

You can create a CSV file that contains the
login names, and add settings to the login
names by importing the file.

@ Create a CSV file using software such as
Notepad or Excel etc.

<For Notepad>

Bl untied - otepad JBI[=IIY

File Edit Format View Help

Ssato ;|

takahashi
suzuki
murata
inoue

<] 2V

@ Write 1 login name on each line.

@ Save in text format with the extension
"CSV".

<For Excel>
E1 Microsoft Excel - Book1
@ File Edit WView Insert Format

NEH SR VK GG

........

Ab - f
s B | |

sato

takahashi

suzuki

murata

inoue

SN = RRaa N SR SVRN SR R

:

M4 4 » M) Sheetl / Sheet2 £ Sheet3 /
‘Draw~ | | AutoShapes~ . % [
Ready

® Write 1 login name on each line.
@ save in CSV file format.
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@ Start the server software.

® Click the [Policy] menu > [Edit Policy].
O Click the [Login Name] tab.

@ select [File] as the registration method.

e x

[Cennaziean 'I Acgure Poley I
Logn Name | apclcaten | Document | Host |
Lagin Hame Poley
[ognbione  TPoky ]
et Oution o ervcd e 1 Epable Priting
T Prnkin o

[Marwa
" Djsable Cokr Prinking
-

_fe | e | [ ]

@ Click [Select File], specify the CSV file
that you created in step (M, and click
[Open].

@ Select the login name that you want to
add settings from the list to.
oy =

[Cannaziean =] e Py |

Login Hams | appieston | Document | Host |

Login Name: ~ Poley

[ognbione  TPoky ]
‘Satect (phon 12 ervl Uier. = Epable Printing s
Fie " Pinkin lons
Gelect Fio " Disabie Color Prining
takshashs 1 Dinable Prining
Tupdi
g |
|
Dirlsa I

™ AddUngegisterd len

e | ew | [ ]

@ select the use restrictions that you want
to use.

x|

[Cennazieany *]  cguersy |
Login Hame | appkosten | Doctment | Motk |
[ Logh Name — " Poley + [ for Loge Harne
‘Sstech (phon 12 ervod Uier. = Epabie Frinting M
Fie | 1 Pk in Hone:
Seleci 1 Bijsable Ek Prvting
L " Dinable Printing
]

e | e | [ ]

Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Disable Printing

Cancels printing.

© Click [Add] in the Policy field.
The added login name and use

restrictions are displayed in the [Policy
for Login Name] list.

I x|

[Cannaziean =] e Py |

Login Hams | appieston | Document | Host |

Lisgin Name

T S I S— |
‘Sefect Ophon ko snicd Le - bl Paning
Fie
Stlect i i

i

_m | e | e |

@ Click [Add] at the bottom of the window.

oy |

[Cannazieans -| Acgure Polly |
Login Nane | Applston | Document | Host |
Lagin Name: [ Poley
[ognbione  TPoky ]
Sefect Opfon ko snvcd Le: 1 Epable Priting ) Erabis Partng
Fie =] T Pkin Hors
soncipe | [0 T Disable Eor ining
takshashe 1 Dinable Prining
Tupdi
L LY
e A I
|
™ AddUngegisterd len

L[ELI

Proceed to “Adding settings to printers”
(page 93).

(Note! If the "Adding settings to printers"
(page 93) steps are not executed, the
set use restrictions are not registered to
the printer.
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Importing users registered in
Windows

User name information from Windows
specified on the network can be obtained
and registered as a batch to the server
software. Names that can be obtained

are accounts registered on the specified
computer.

(Note!) e Access permission for the specified

computer is required.
¢ If the names of users that are already
registered to the printer and those
5 registered to the computer are

duplicated, the printer information is
not imported, and only names that are
not duplicated are added.

@ Check that the printer power is ON.

@® start the server software.

@ Click the [Policy] menu > [Edit Policy].
O Click the [Login Name] tab.

@ select [Server/Network] as the
registration method.

=0

|cwnnmn:n '| Arue Poky
Login Hams | appieston | Document | Host | |
(g ey
TP =TS R—
Setect Opton i ervol User. 1 Enable Printing fime
e R [ I
(Harus
e
1 Dinable Prining
. I
|
Deletn I
™ ckd Uirvegisterd hem
_wa | e |
@ Click [Server].
e x
|cmun|mn:n 'I Arquee Pokey
Login Hams | appieston | Document | Hast | =
i bty
=TS R—
Satect Option i ervol User. ¥ Enable Printing fime
1 Prinkin Hona.
m " Dissble Cokr Prinking

" Disable Prting

o | e ] e |

@ Select the computer from which the login
names are acquired.

T

[Cennszisnsy -| Aruse Poley |
Login Hane | Applcsten | Document | Host |
Lagin Hame Fukey
TP I R—
‘Satect Ophon 12 ervol Uier.

¥ Ensble Printing.
™ Phinkin Hona.

| ServerHetwor. 'I
Served an " Diinable Cokr Printing
o 1 Dinatle Prning
LY
SERVERG i |
|
Dipletn I
T ckd Ureegiatend ham :

O select the login name that you want to
add settings from the list to.

X

S I T |

[Cennaziean =] e Py I

‘Login Nama | Appkcation | Brocumert | Host |

[ognbione  [Poky |
‘Gestect Upaon 13 ervcd User.

¥ Ensble Printing.
™ Phinkin Hona.

| ServerHenwo. 'I
T 1 Disable Cokr Prining
= Dbty
E sty

SERVER3 Lod = I
|
Dipletn I
™ ckd Uirvegisterd hem

© select the use restrictions that you want
to use.

L B T |

X

[Cannaziean =] e Py
Login Hans | appieston | Document | Hast | ==
[ Logn Name:
[ognbione  TPokey |
‘Gt Upon 13 envcd User.

= e i
Sern y
takghashi
il ki
‘35““2 L
SERVERZ incus
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Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Disable Printing

Cancels printing.

@ Click [Add] in the Policy field.
The added login name and use
restrictions are displayed in the [Policy
for Login Name] list.

e i

ECI T — T |
Login Nams | apeiksien | Document | Host |
 Lagin Hame o e Poky o Legniane
TP I —

‘Gestect Upaon 13 ervcd User.

ServerHetwork. 'I
Served R
ke shashy
il k. -
SERVERZ i
‘iil\ﬁla ncue —

_fe | e | [l ]

@ Click [Add] at the bottom of the window.

P i
[Cannaziean =] e Py |

Login Hams | apkesten | Doctment | Mot |

| Lign Name: — Poley
[ognbione [Py ]
‘Gestect Upaon 13 ervcd Uier. §‘ 1 Enable Printing - Trabis Pandrg
Senven/etwort =] £ PrckinMons

Serve wan T Diinable Coks Printing
_II — 1 Dinable Prning
SERVERZ g
SERVERY e |
I sdllimgemtn

Proceed to “Adding settings to printers”
(page 93).

(Note! If the "Adding settings to printers"
(page 93) steps are not executed, the
set use restrictions are not registered to
the printer.

Adding unregistered item
settings

Use restrictions can be set for login names
that are not registered on the printer.

@ Check that the printer power is ON.
@ Start the server software.

@ Click the [Policy] menu > [Edit Policy].
O Click the [Login Name] tab.

@ select the use restrictions that you want

to use.
ey i
[Cannaziean =] hoie Py
Login Hams | appikssten | Doctment | Mot | ==
ClognMame [ Py [Pokoy i LegeNamm.
Satect Opton 12 srvol Uses:  Enatis Frining —
[Menaal 1 PritinMons.
Erlogabane [ 1" Disable Cor Printing
" Disable Prting
DOipltn I
™ AddUnvegistend ien

P B

Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Disable Printing

Cancels printing.
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5. Managing use restrictions

@ Check the [Add Unregistered Item] check
box.
The [Other Login Names] and their use
restrictions are displayed in the [Policy
for Login Name] list.

x|

[Cannaziean =] e oy |
Login ane | Applcsten | Document | Host |
Lagin Hame - Pobey
[ognbione __ Poky ]
‘Gestect Uphon 13 ervcd User. i - -
[Mensel 2| | itinbons
Eies Lo Hares. " Diinable Cor Printing
" Disable Prning
. I
Diplstn I

b o | [ ] (oo ]

@ Click [Add] at the bottom of the window.

Setting use restrictions to
the application name

If required, use restrictions can be set to
the application name. Add the settings
using one of the following methods.

e Adding manually

e Adding from the log

Adding manually

@ Check that the printer power is ON.

@ Start the server software.

@ cClick the [Policy] menu > [Edit Policy].

N O Click the [Application] tab.
T — | E
Logi Hams | appicatin | Document | Most | .- [Conpazieans)  ¥] | AcosePeky
e o ey s e s | e |
T o T — o — = e
et i | e PSR =i = —
Erlogabane [ 1" Disable Cakor Prinking || r rankes
b Aagpletions o B Piter's b :x:::“
Al |
| =]
P AddUnvegistend lien —»I
T AddUrvegstend hem
e | ] | v |

Proceed to “Adding settings to printers”
(page 93).

(Note! If the "Adding settings to printers"
(page 93) steps are not executed, the
set use restrictions are not registered to
the printer.
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@ Enter the application name that you want

to add settings to in the application name
input field.

0

[Cennszisnsy 'I Ae Poley I
Logn Hane Appkcsion | Document | Host |
- Appleation [~ Poley
R I —
Lrier Apskcatn Hame ¥ Enable Printing.
[Frovesd — | 7 Pinbos
e
Aphcations o Piries kg o
mar|
Dipletn I
T Add Uneegiterd em

B B




5. Managing use restrictions

@ select the use restrictions that you want O Click [Add] at the bottom of the window.
to use. oy |
T T —
U = i s ) 3 tonietoky |
[Ceopazieans %] Aippeion Pobey
Logn Hane Apckcsion | Document | Host | ! e | Cries Appkcsion Hama ¥ Enetie Pintrg &w bl Pk
i fome | | Pk
[arr—r— T R— i e
= = 1 Dinable Printing
Lovicstios o e Piniel’s by e |
—
Diplatn I
™ Add Ureegisterd hem
L[E | v |
_w | [m]
Enable Printing Proceed to “Adding settings to printers

(page 93).

Allows printing.

Print in Mono
(Note! If the "Adding settings to printers"
(page 93) steps are not executed, the
set use restrictions are not registered to
Disable Color Printing the printer.

When color printing is executed, printing is output
in monochrome.

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Disable Printing

Cancels printing.

@ Click [Add] in the Policy field.
The added application name and use
restrictions are displayed in the [Policy
for Applications] list.
o |

[Cannaziean =] e Py I

LoginMame  Appicaton | Document | Hast |

Appleion

Lries Apsiecatn Hame
Fm

Apphcations o te Pirkers g

_ma | e | e |

- 83 -
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Adding from the log

Use restrictions can be set to the
application names included in an acquired
log.

(Note! Before going to the following, you need
to complete the procedures of “Export
job information in a file if this utility
acquires logs” (page 237).

@ Check that the printer power is ON.
@ start the server software.

® click the [Policy] menu > [Edit Policy].
O click the [Application] tab.

@ select the application name that you
want to add settings from the list to.
T =l

[Cannaziean ¥]  Acoe Poky |
Logn Hame - Apckcaton | Document | Host |
[ Appleaion - Puey o
R I T—
Lrie Apgkcsbon Hars ¥ Enable Printing.
[irosd || 0 Pt
1 Disable Color Prining

pplcalins lion e Finiers by r
ko Explasnt
TWindows 'woedad Ackceton
e ] s |

L : =

T kd Urvesgatend ham

I o

@ sclect the use restrictions that you want
to use.
T x|

e ECTT — |

I T—

I o

Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Disable Printing

Cancels printing.

@ Click [Add] in the Policy field.
The added application name and use
restrictions are displayed in the [Policy
for Applications] list.

T i
[Cennaziean =] e Py |

T I — |

Hetspnd Trubis Porirg

Cm | e | e |

O click [Add] at the bottom of the window.
T =

[Cannaziean) ] Acoue Pokey |
Logn Hame Apckcston | Document | Host |
Appleon ~ Poley o
T I —
Lries Apgkcsbon Hars ¥ Ensble Printing. Metsoad Erabia Py
[Firosd | |0 Pk
" Disable G P

pplcalins lion o Piniers by e e
Wirkows Exphoent
“Windows 'wiosdhad Apckcaton
Nirpad s |

T ikd Urvegatend ham

L[ELI

Proceed to “Adding settings to printers”
(page 93).

(Note! If the "Adding settings to printers”
(page 93) steps are not executed, the
set use restrictions are not registered to
the printer.
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5. Managing use restrictions

Adding unregistered item @ Check the [Add Unregistered Item] check
. box.
Settlngs The [Other Applications] and use

restrictions are displayed in the [Policy
for Applications] list.

Use restrictions can be set for application
names that are not registered on the

printer. A
LoginMams  Appicaton | Document | Host | I —
@ Check that the printer power is ON. = e
Lrie: Apghcateon Hare " Ensble Printing. %EIEIMW
Ii ™ Phinkin Hona:
@ start the server software. ——— © Dt ey
@ Click the [Policy] menu > [Edit Policy]. o
O Click the [Application] tab.
@ Select the use restrictions that you want
to use. LI T |
ey |
ETCI T — T |
e @ Click [Add] at the bottom of the window.
s o | [E—TE—— T xl
[ 1 PritinMons. T E—
m"&:‘mw :x:::ﬂ Logn Hane Appkcsion | Document | Host | I ! ﬂl
mwm Al | Lries Apgkcshon hare ¥ Enable Printing. e
Diplste I Apphcations o e Pirkers kg r“mm
o |
=
_w | ] Lfslpmerite
Enable Printing

i () =)

Allows printing.

Print in Mono Proceed to “Adding settings to printers”

When color printing is executed, printing is output (peee ),
in monochrome.

Disable Color Printing (Note! If the "Adding settings to printers”

Cancels color printing. If there is color data part- (page 93) steps are not execut.ed, the

way through a print job, all printing from that set usg restrictions are not registered to
. : the printer.

point onwards is cancelled.

Disable Printing

Cancels printing.
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Setting use restrictions to
the document name

If required, use restrictions can be set
to the document name. Add the settings
using one of the following methods.

e Adding manually

e Adding from the log

Adding manually

@ Check that the printer power is ON.
@ start the server software.

@ cClick the [Policy] menu > [Edit Policy].

=l

O Click the [Document] tab.
ECI T — T |

mn—lﬂ I
k | I R I R—

Lrier Cocament Narme / LFIL ¥ Enable Priting

I ™ Phinkin Hona:

" Dissble Cokr Printing

Document Hames / LIALS bom the Printer’s kg

o

Tost Page
Document
Coniguaatin: |
Dipltn I
I addlgemitan

P B

@ Enter the document name that you want
to add settings to in the document name

input field.
T e
| ETIEETE] '| Aegae Poy
Login Hame | Applcsten Document | Host | et |
Py
I R I R—
Dk Diocament Name / AL ¥ Ensble Printing.
Iit-r ™ Phinkin Hona:
Document Hames / LIALS bom the Printer’s kg : e,
Tast Page
Document
Corigpnation k) I
Ry I
Dipbatn I
T AddUrvegstend hem

I B

* (Asterisk) can be used as a wild card

in the document name. However, items
that are just * or contain ** cannot be
registered.

@ select the use restrictions that you want
to use.
T =l

|ETCI T — T |

( ]

Login Hame | Applcsion Document | Host |

Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Disable Printing

Cancels printing.

@ Click [Add] in the Policy field.
The added document name and use
restrictions are displayed in the [Policy
for Document Names/URLs] list.
A=

[Cenneziensy -| Arue Poley |
Login Hame | Applcsien Document | Host |
- Pebey

I I —
Lrtes Document Neme / UAIL. 1 Enable Printing Tast Disabils Cokw Pantirg
Iit-r | ™ Prinkin Hona.

1= Diinable Cokr Printing

Docursent Hames / LIALS bom the Printer’s kg
Tast Page
Document

Conbiguation

S B B |
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5. Managing use restrictions

@ click [Add] at the bottom of the window.
T x|

[Cennaziean) O |
‘Logi Hame | Applcsten  Document | Host |
[ Poley o
Lrées Document Narme / UFIL " Enabie Printing. %EIKI Diabe ok Piting

Iit!r 1 Pk in Mons.

| ¥ Disable Lok Printing
Dicusert Hastt # UFLS bt e Pricea's kg

Tt Page
Document
sl |
e |
T Urvegatend hem

==

Proceed to “Adding settings to printers”
(page 93).

(Note!) If the "Adding settings to printers”
(page 93) steps are not executed, the
set use restrictions are not registered to
the printer.

Adding from the log

Use restrictions can be set to the document
names included in an acquired log.

(Note! Before going to the following, you need
to complete the procedures of “Export
job information in a file if this utility
acquires logs” (page 237).

@ Check that the printer power is ON.
@ start the server software.

@ click the [Policy] menu > [Edit Policy].
O click the [Document] tab.

@ select the document name that you want

to add settings from the list to.
T x|

[Cannazieans 5] somunpuy |
‘Login Hame | Applcsten Document | Host |
- Pobey o
P T I T— |
Lrées Document Narme / LFIL ¥ Enable Printing.
Fﬁ!hw 1 Pk in Mone.
Doaenend Hstms  LIAL bost e Pt * S o
= " Dinabie Prring

Document
Conbiguration Ay |

T s Ureegatend hom

I o

@ select the use restrictions that you want
to use.
T =0

[Cannaziean | ﬂl

‘Login Hame | Applcsten  Document | Host |

I T—

I o

Enable Printing

Allows printing.

Print in Mono
When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Disable Printing

Cancels printing.
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5. Managing use restrictions

@ Click [Add] in the Policy field. Adding unregistered item
The added document name and use .
L. . . . settings
restrictions are displayed in the [Policy
for Document Names/URLs] list. Use restrictions can be set for document
C T names that are not registered on the
T T — -
Login Hame | Applcsion Document | Host | —tenay | prlntel".
. @ Check that the printer power is ON.
bt @ start the server software.
@ Click the [Policy] menu > [Edit Policy].
O Click the [Document] tab.
| s | e | @ sSelect the use restrictions that you want
to use.
Click [Add] at the bottom of the window. AW ————— .
@ _-[ ] l Lo Nams | Applcaton Documet | ow | ErrT—
— [T 3] _scaaetey | Pt e e ——
ek || rene
G im0 Comermg | eI ] oo toes s ompisg | | ORE s
[P | | [ Piinkes T E
Document Hosvest LS born the Pt kxy : e, o |
m o |
Coriiguration ) | Dirks |
oy | e PR T T
Diplatn I
_w | [m]

L[ELI

Enable Printing
. . . Allows printing.
Proceed to “Adding settings to printers”

(page 93). Print in Mono

When color printing is executed, printing is output

in monochrome.
(Note! If the "Adding settings to printers”

(page 93) steps are not executed, the Disable Color Printing
set use restrictions are not registered to

Cancels color printing. If there is color data part-
the printer.

way through a print job, all printing from that
point onwards is cancelled.

Disable Printing

Cancels printing.
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5. Managing use restrictions

O Check the [Add Unregistered Item] check Setting use restrictions to
box.

The [Other URLs] and use restrictions the host name

are displayed in the [Policy for Document

If required, use restrictions can be set to
Names/URLs] list.

the host name.

e

Add the settings using one of the followin

Lo Nams | Applcaton Document | ow | Errr— T J ? ¢

= methods.

iDL ¢ e oy e Adding manually

sttty | | . ol e Adding from the log
Adding manually
@ Check that the printer power is ON.

e @® sStart the server software.
@ Click [Add] at the bottom of the window. © Click the [Policy] menu > [Edit Policy].
e - |

e T — | O Click the [Host] tab.

o e x|
Erier Bocament Narse 4 UfIL r o ] [Connazieans %] AcosePeky
Ii"- s ;":'::‘:" DR Dt e Login Hame | dlcaion| n_m =)
o] g v

R [ Oy
F Add Ureegisterd liem -,_nl
Dirletn I |
w | EE |

P B

Proceed to “Adding settings to printers”

(page 93). @ Enter the host name that you want to add
settings to in the host name input field.
oy =

T — | |
(Note! If the "Adding settings to printers” ETEESEERT ’ —
(page 93) steps are not executed, the o ecwre | [— T
set use restrictions are not registered to Mﬁ" :f:mu At
the printer. R S
COMPUTER3 ) I
Dipletn I
™ Add Ureegisterd hem

_fea | e | [Tl ]
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5. Managing use restrictions

@ select the use restrictions that you want
to use.
T A

T — |

Login Hame | Appkcaten | Document Mait |

ET I " T—
Eries Hoat Nome

ﬁukﬂ':kl

Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Disable Printing

Cancels printing.

@ Click [Add] in the Policy field.
The added host name and use restrictions
are displayed in the [Policy for Host
Names] list.
T =
ECI T — T |

Login Hame | Appkcaten | Document Mait |

Heal
ries Host Name. COMPUTERS [

ﬁukﬂ':kl

Hots o the Printer's kg

T~ AddUnvegisterd len

@ Click [Add] at the bottom of the window.
e
T — |

Heal
COMPUTERY {Eriable Pinting

™ AddUnvegisterd lien

L[Eil

Proceed to “Adding settings to printers”
(page 93).

(Note! If the "Adding settings to printers”
(page 93) steps are not executed, the
set use restrictions are not registered to
the printer.
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5. Managing use restrictions

Adding from the log

Use restrictions can be set to the document
names included in an acquired log.

(Note!) Before going to the following, you need
to complete the procedures of “Export
job information in a file if this utility
acquires logs” (page 237).

@ Check that the printer power is ON.
@ start the server software.

® cClick the [Policy] menu > [Edit Policy].
O cClick the [Host] tab.

@ select the host name that you want to
add settings from the list to.
T x|

[Canszieana) — 3] hcaweroy |
‘Logi Hame | Appkcaben | Document Hast |
e - Pobey v
I I T
ke Moat Neme: ¥ Ensble Printing.
[EaraTERs || Potnbons
1 Diable ol Prning
Hasts o he Fiiers g :
COMPUTER] ML L
comuTEnz
M|
T iddUinvegterd em

I e B

@ select the use restrictions that you want
to use.

T =
|cwnszmn:1 vl Aroue Pobey I

‘Login Hame | Appkcaten | Document Hast |
[ Haety

rier Hosi Name:
ﬁHM’ER?

‘Hosts hoes the Printer's log
COMPUTERT
CoMPUTERZ
COMPUTERS

_we | e | [ ]

Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Disable Printing

Cancels printing.

@ Click [Add] in the Policy field.
The added host name and use restrictions
are displayed in the [Policy for Host
Names] list.
T =

| ETTCI T — T |

‘Login Hame | Appkcaten | Document Hast |

M [ Poley
ke Hoat Hame.
[ronruTERS |

Hosts hoes the Prinier's log
COMPUTERT
CoMPUTERZ
COMPUTERS

Hesl
COMPUTERT P I Mene.

Cwm | e ] e |

O click [Add] at the bottom of the window.

T ]

[Cannaziean 3] semieboey |
‘Logi Hame | Appkcaten | Document Hast |
Mo - Pobey v
Hat
ke Host Name: 1" Ensbie Prining. COMPUTERD Pt I Mons.
fowRTERs || F Penbes
" Disable Color P
bt hoen the iinr's log e —
COMPUTER]
CinPuTER?
COMPUTERS s |
T kd Urvegatend ham

Proceed to “Adding settings to printers”
(page 93).

(Note!) If the "Adding settings to printers”
(page 93) steps are not executed, the
set use restrictions are not registered to
the printer.
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Adding unregistered item
settings

Use restrictions can be set for host names
that are not registered on the printer.

@ Check that the printer power is ON.
@ Start the server software.

@ Click the [Policy] menu > [Edit Policy].
O Click the [Host] tab.

@ select the use restrictions that you want

to use.
e x
— : — T — |
ot Py .
Lrier Hoat Name 1 Enable Printing

I ™ Phinkin Hona

T Diinable Cokr Printing

Hosts o the Printer's kg = ——
COMPUTERT e i
COMPUTERZ
COMPUTERS s |
|
o |
T AGonn

P B

Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Disable Printing

Cancels printing.

@ Check the [Add Unregistered Item] check
box.
The [Other Host Names] and use
restrictions are displayed in the [Policy
for Host Names] list.
froiy =l

| ETCI T — T |

Login Hame | Appkcaten | Document Mait |

I - E—

B B

@ Click [Add] at the bottom of the window.
=l
| ETCI T — T |

Login Hame | Appkcaten | Document Mait |

Moot - Pokey
IR - R
Erker Mot Neme - i

I ™ Prinkin Hona

Hosts hors the Printer's kg

COMPUTERT # Disable Priving
COMPUTERZ
COMPUTERS A
Dipletn I
F AddUnegstend hem
N (==

Proceed to “Adding settings to printers”
(page 93).

(Note! If the "Adding settings to printers”
(page 93) steps are not executed, the
set use restrictions are not registered to
the printer.
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5. Managing use restrictions

Adding settings to
printers

The set use restrictions can be added to
the printer.

(Note!) The use restrictions of items that are
already registered and exist in the
printer are changed.

@ Select the printer that you want to add
use restrictions to, and click [Add].
Printers that can have use restrictions
added are displayed in the [Selected
Printer] list. To add use restrictions to all
of the printers, click [Add All]. To exclude
printers from having use restrictions
added, select the printer in the displayed
[Selected Printer] list, and click [Delete].

=
Selact the Pereads) % apely Policy.
e

Prirkai Hasne. Addess Status

(=2} TR Ho Agghed
Frtes N [podes |
S 19218802
=1} 19218803

Add M |
ST | [

@ cClick [Apply].
st panter £l

S the Prnoars) o apply Policy.
Seelecind Prrter;
Prrtst Hane. Addess Statut
(=2} TN Hek Agghed
MCEE 19218802
=1} 19216803
|
Dieisle: I
Add M I

@ When the administrator password window
is displayed, enter the administrator
password and click [OK].

Displaying use restrictions
that are already
registered in printers

@ The use restrictions that are already
registered in printers can be displayed.

@® Check that the printer power is ON.
@ start the server software.

O Click the [Policy] menu > [Edit Policy].

@ select the printer, and click [Acquire
Policy].

L . |

O The registered use restrictions are
displayed in the use restriction lists in
each of the [Login Name], [Application],
[Document] and [Host] tabs.
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5. Managing use restrictions

@ Click [Update] at the bottom of the
window.

oy

Deleting use restrictions

Use restrictions that are registered in
printers can be deleted.

| | G 1 | | ETCI T — T |
@ Check that the printer power is ON. i & Im——
|| ke
@ Start the server software. .  omeries
COMPUTER3 -;v.l I
® Click the [Policy] menu > [Edit Policy]. e
O select the printer, and click [Acquire S
Policy].
| e ) [Comed]

0 select the printer that you want to delete
use restrictions from, and click [Add].
Printers that can have use restrictions
deleted are displayed in the [Selected
Printer] list. To delete use restrictions
from all of the printers, click [Add All].
To exclude printers from having use
restrictions deleted, select the printer in
the displayed [Selected Printer] list, and
click [Delete].
T

L (R

@ The registered use restrictions are
displayed in the use restriction lists in

each of the [Login Name], [Application], e e
[Document] and [Host] tabs. st BRIE ot
@ Select the use restriction that you want
to delete from the user restriction list,
and click [Delete]. The use restriction
display is deleted from the use restriction
list.
=l
et ECI T — T | End ol |
o o T e —
— 7 | e © Click [Apply].
(G L rty N —
%& | Selact tha Prreai] 50 apply Policy.
| R
J
L I T R
Add A I
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5. Managing use restrictions

@ When the administrator password window
is displayed, enter the administrator
password and click [OK].

(Note!) Unregistered items such
as OtherLoginNames,
OtherApplicationNames, OtherURLs, and
OtherHostNames cannot be deleted.

Changing use restrictions

Use restrictions that are registered in
printers can be changed.

@ Check that the printer power is ON.
@® sStart the server software.

® Click the [Policy] menu > [Edit Policy].

O select the printer, and click [Acquire
Policy].

L . |

@ The registered use restrictions are
displayed in the use restriction lists in
each of the [Login Name], [Application],
[Document] and [Host] tabs.

@ select the Name of the use restrictions
that you want to change from the
use restriction list, and select the use

restriction.
U
[Eonzwey ] “ |
i | — | ETACTE] Arcue Pely
Hase Py o
Lrder Hoat Name » -
[ £ Pk Mone COMPUTERS P InMene.
Hiets o the Printer's kg £ e D Pk
. = Dy
COMPUTERZ
COMPUTER3 A I
oo |
| Dinlate I

B I T |

Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.
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5. Managing use restrictions

Disable Printing

Cancels printing.

@ Click [Change]. The changed use
restrictions are displayed in the use
restrictions list.
T A=

[Cannazieans 'I e Poley I
Login Hame | Appkcaten | Document Mait |
= Pobey:
[Het sk ]

e Moat Name.

T COMPUTERY Uinatle Parirg

s o the Printer's log

COMPUTERT

CoMPUTER:

COMPUTERS

_m | e | e |

@ Click [Update] at the bottom of the

window.
O =
[Cannazieans 'I Aegae Poy
Login Hame | Appkcaten | Document Mait | _I
T I T— |

Erker Mot Name

Ii COMPUTERS Dinable Parirg

Hiosts o the Printer's leg

COMPUTER]

COMPUTERZ

COMPUTERS

F addUnvegisterd lien

© select the printer that you want to
change the use restrictions for, and
click [Add]. Printers that can have use
restrictions changed are displayed in the
[Selected Printer] list. To change use
restrictions for all of the printers, click
[Add All]. To exclude printers from having
use restrictions changed, select the
printer in the displayed [Selected Printer]
list, and click [Delete].

T o=

‘Saact the Prineer(i) o apgly Poicy.
Selecind Parber;
PireaiHame | Addess | Staws |
an TR0 Mot Appbed
Fintes Naros [hades |
MO 19216202
con 19216803
L |
Add M I
e | |

@ click [Apply].

T

Silact the Peread( % apply Py,

S 19218802
=1} 19216803

[PinieNomn [ e |

i

® When the administrator password window
is displayed, enter the administrator
password and click [OK].
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Deleting all use
restrictions

All of the use restrictions set for the Login
Name, Application Name, Document Name
and Host Name can be deleted.

@ Check that the printer power is ON.
@® start the server software.

® Click the [Policy] menu > [Delete All
Policy].

% Print Job Accounting Enterprise

File Printer Log Option  Help

[#1- Printer Edit Policy...

9 Log | oseeairo )
Enable Policy...
Disable Policy...
User Registration on Active Directory...

O sclect the printer that you want to delete
all of the use restrictions from, and click
[Add]. Printers that can have all use
restrictions deleted are displayed in the
[Selected Printer] list. To delete all use
restrictions from all of the printers, click
[Add All]. To exclude printers from having
all use restrictions deleted, select the
printer in the displayed [Selected Printer]
list, and click [Delete].
T |

S the Prntars) o apply Policy.
e
Prirtst Hame. Addess Statut
(=2} TR Ho Agghed
MCEE 19218802
=1} 19218803

1

—ed | e |

@ click [Apply].

T =
Selact the Prrcer(s] 4 aply Pokcy.

e
(=2} TN Hek Agghed

S 19218802
=1} 19216803

i

@ When the administrator password window
is displayed, enter the administrator
password and click [OK].
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Temporarily disabling use | © ciick [Apply].

st remter |

restrictions s o
Use restrictions can be temporarily - TR otk
disabled. The use restrictions set for the - R
Job Account ID for printing jobs from a PC |
are also disabled. b |
Add M I
@ Check that the printer power is ON.
@ Start the server software.

@ Click the [Policy] menu > [Disable
Policy].

L_',; Print Job Accounting Enterprise

@ When the administrator password window
is displayed, enter the administrator

File Printer Log Qasla' Option Help .
- Printer Edit Policy... password and click [OK].
#-Log Delete All Palicy...

Enable Policy...

IS )

User Registration on Active Directory...

O select the printer whose use restrictions
you temporarily want to disable, and
click [Add]. Printers that can have use
restrictions temporarily disabled are
displayed in the [Selected Printer] list. To
temporarily disable use restrictions for all
of the printers, click [Add All]. To exclude
printers from having use restrictions
temporarily disabled, select the printer in
the displayed [Selected Printer] list, and
click [Delete].
T |

S the Prntars) o apply Policy.
e
Prirtst Hame. Addess Status
(=2} TR Hoi Asphed
MCEE 118802
=1} 19218803
Dieisle: I
Add M I

JIT T
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Enabling use restrictions

Use restrictions that were temporarily
disabled can be enabled again.

@ Check that the printer power is ON.

@® start the server software.

@ Click the [Policy] menu > [Enable Policy].

% Print Job Accounting Enterprise

File Printer Log Option Help
- Printer Edit Policy...
H-Log Delete All Palicy...

Disable Policy... !

User Registration on Active Directory...

O select the printer whose use restrictions
you want to enable again, and click
[Add]. Printers that can have use
restrictions enabled again are displayed
in the [Selected Printer] list. To enable
use restrictions again for all of the
printers, click [Add All]. To exclude
printers from having use restrictions
enabled again, select the printer in the
displayed [Selected Printer] list, and click

[Delete].
S A
Sesct the Prrka(s] 10 apcly Policy.

Selecind Parber;

PiresiHame | Addess | Sesas |
| - E——
MO 19216202
con 19216803

I

e | |

@ Click [Apply].

T =
Selact the Prrcer(s] 4 aply Pokcy.

Selecind Prter
Poisione [ Addess [ Staws |
e TE1BAD3 NotAgpked

(Fishass [ Adies |
S 19218802
=1} 19216803

i

@ When the administrator password window
is displayed, enter the administrator
password and click [OK].
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Memo
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6. Syncing with Active Directory User Information

6. Syncing with Active Directory User

Information

This section explains how to add or delete use restrictions or change settings for user
information managed by Active Directory, and how to sync with Active Directory user

information.

Setting the printer to
be linked with Active
Directory

@ Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the details window.

t_!_;',. Print Job Accounting Enterprise
File Printer Log Policy Option Help

.. Lng

@ select the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.
t__';'_, Print Job Accounting Enterprise

File Log Policy Option Help

= F  AddaPrinter...
Manage multiple printers as a group...
Delete a Printer Printer Group

G- Change a Printer Group. ..

Start/End Log

Acquire a Log

Setking Bhe Time

Define Fees...

Backup of printer setting. ..
Properties...

O Click the [Option] tab > [Detail setting].
21|

Printer | User  Option |

Acquire Logs
& |nterval
I? Hour ID Minutes
" Time
Lhange Time... |
Fees Cad41/0831/0822 j
Define fees... |
Dperation at Lag Full IDEIE[E old logs j
Auto Export Logs IDD not automatically expart j
I™ | Becord lngs in & database
Click [Detall zetting] ta cooperate with
Active Directory.

ok | x|

@ Check the [Synchronize user list with
Active Directory] check box.

ostailsatung 2ix]
fF{_ Tiet v Di jI
- Policy based printing

© Usar s idantified by Job Account ID

Chont soltware has to be matalled on cach wers FU.
% User is identified by PC Login name / card

Chent soltwase is not necassary.

™ Download erecled card bable bo a pinter
I Al altzmative autfienticatian for card

ok | Cancel

@ select [Policy based printing].
oetailsetng 21

¥ Synchionize user list with Active Directory

~ Palicy based printing
 User it idaniified by Job Account 1D
Chenit softwar: has bo be mtalled on cach ser's PL.
 {ser i sdanihed by P'C Login nams / caed

W
Chent sofbware is not necessary,

I~ Download ereolied card bable bo a prnter
I Allowy altzmative autfientication for card

ok | Cancel
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User is identified by Job Account ID

Print restrictions from a registered user PC are
set in the Job Account ID. For jobs from PCs, the
Job Account ID needs to be set in advance in the
client software driver of the print source PC.

User is identified by PC Login name/card

Print restrictions from an unregistered user PC
are set in the login name. The client software
does not need to be installed in the print source
PC.

@ Click [OK].
oetailsetng 21

¥ Synchronize user list with Active Directory

Foicy basact e
= Usar e ideniiied by Job Account 1D

Chent software has bo be nstalled on cach user's PU.
& et is idenitified by PC Login name / card

Chent software is not necessan.

I™ Download erolled card table to 2 printer

171 &l altemative autfienticatian)for card

o |

@ Click [OK] at the bottom of the window.

Printer' Uzer  Option |

Acquire Logs
& |nterval
7 Houw IU Mirutes
" Time
Lhange Time... |
Eees Ca41/C831 /0822 j
Diefine fees... |
Operation at Log Full IDeIete ald lags j
#Auto Export Logs IDo not automatically export j
I | Becord logs in & database
Click [Detail zetting] to cooperate with Detail setting... |
Active Directary. -

— e Em |

O 1f the settings for creating an IC card
compatibility table are not set, a message
notifying that the IC card compatibility
table cannot be registered to the printer
is displayed. Click [OK].

In order to register an IC card
compatibility table to the printer,

the settings for creating an IC card
compatibility table need to be configured.
For details on the settings required for
creating an IC card compatibility table,
see "Creating an IC card compatibility
table" (page 133).

@ when the window notifying the changes
to setting items is displayed, click [Yes].
£

TH S d for the folowing Do you vank b =y

Prinder Iem Present sedti Hew
CBAI[192162.0.. Synchrore wit.. Mot Synchronze  Syncheonze

e |

® When the window notifying that
the setting changes are complete is
displayed, click [Close].

® When the [Login name/Group name
which synchronizes with Active Directory]
is displayed, configure the Active
Directory settings. For details, see page
104.
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6. Syncing with Active Directory User Information

Conﬁguring the Active @® Click [Add] in the [Active Directory User/
. . Group Settings].
DI reCtO ry Settl n gs Active Directory User/Group Settings ;|g|5|
Configure the connection destination and Accounts for hich Use Restrictions Have Been Configured
H H H Liser [, N... | T Di Mame E-mail Address
other such settings for the Active Directory T T R T e
that is linked to the server software.
Connecting to the currently logged-on
Active Directory
@ Click [Policy] menu > [User Registration
on Active Directory]. 4 | »
: padd.. CHAnEE: - I REMOYE |
Elle Printer Log | Policy Option Help
- Use Restricti [ -
B Edit Policy... Prgi:mg on
[+~ Liog Delete All Palicy... Color Printing
Enable Palicy. .. Eg"&ﬂwing
Disable Palicy... USB Memory to Print
User Registration on Active Direckory... tl;s;‘n:im“m Color Print e
Sican bo Metwork PC
Scan ko USE Memory
Fanx Sending _ld
@ Click [Setup] in the [Login name/Group J| B
name which synchronizes with Active e SNl |
Directory] window.
Ligin naame /Group nsme which SyrchFOBEEE W ACENEDRSPENN 3 20X @ Click [Options] in the [ Active Directory
Logn name/ioup name. Prinier
(None b Accout 10| Loge Name/Gioup® | Pirvsane] A ] St | The mviman v Search].
Uinupgistared |00 0 Othed ogiriamas (=) 19216803 5m
~lolx|
Searchies Autive Dieclory g fur auser o roup.
Search Cri |
e | Smtooodh |
& Group Stop
1] ] 1 | | il |
[ Sewp. | Erd | Agph |
W ob Account D) = * L |
Erpet oss.._ |
| |

| e
I™ Selects & users and aroups i

@ Check the [Set Up Active Directory] tab
in [Search the currently logged on Active
Directory].

ST
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6. Syncing with Active Directory User Information

6 e change the port number to which @ To search for users that have locked
Active Directory connects, enter the [Port accounts, check the [Search for locked
Number]. The range of the port number users] check box.

is from 1-65535.

© Click [OK].
(7 A change the search target, enter [Base

DN]. An example input when the domain
name is [domain.local] is shown below.
When there is no OU: CN=Users,
DC=domain, DC=local

When OU is specified: OU=0U name,
DC=domain, DC=local

If these values are not entered, the
search is made based on DC=domain,
DC=local.

When OU is specified, the time required
to complete the search can be reduced.
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Connecting to an Active
Directory in a specified
domain

© Click [Policy] menu > [User Registration
on Active Directory].

Elz Printer Log | Policy Option Help
- Edit Palicy. ..
[+ Liog Delete All Palicy...

Enable Policy...
Disable Palicy...

User Reqistration on Ackive Directary...

@ Click [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

1 ngin name/Liraup name which synchronizes with Active Directory x|

Login rame/Group nome: Ppininr

[Mowe [ dobAccount 0| LognNeme/Gioupt [ P I
Uniegisteied 107 0 Othwogriiames B4l 192 16603 Ei]

@ Click [Add] in the [Active Directory User/
Group Settings].

Active Directory User/Group Settings & |E||5|

Accounts for Which Use Restrictions Have Been Configured

| User Mame/Group M... | Type | Displary Mame | E-mail Address

OtherLoginhames Reserve Liser Unregistered ID

4] |

CHAnEE: - I Remove |

Lse Restriction [ -
Printing

Color Printing

Copying

Color Copying

UISE Memory to Print

UISB Memory bo Color Print
Sran b Fmail

Sican ko Metwork PC

Scan ko USE Memory

Fax Sending -
1| | >

Sel Up Refresd Service. .. Rl el Mo End |

O cClick [Options] in the [Active Directory
Search].

Active Directory Search .u.'ﬂl}.l
-

Seardes Auive D ¥ ! fur & user or group.

Search Criteria 1

— | Satsoarch |
Name |

{+ Group | Stop

1 |

I Selects & users and aroups

& £ |

@ uncheck the [Set Up Active Directory] tab
in [Search the currently logged on Active
Directory].
|

T Search for kxcked ysers

o] e |

@ Enter the [Domain Name], [Logon Name]
and [Password].
x|

Sat Up Active Directory | Choose Cobanns | 1€ Card |

- o v |

Logon Name sz |

passced I sennne |

Port fhasber [0

[T

T Search for kacked ysers

Domain Name

Enter the Active Directory domain name for
searching for the user and group.

Logon Name

Enter the user name for logging on to the Active
Directory.
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Password

Enter the password for logging on to the Active
Directory.

(7 A change the port number to which
Active Directory connects, enter the [Port
Number]. The range of the port number
is from 1-65535.

O change the search target, enter [Base
DN]. An example input when the domain
name is [domain.local] is shown below.
When there is no OU: CN=Users,
DC=domain, DC=local
When OU is specified: OU=0U name,
DC=domain, DC=local
If these values are not entered, the
search is made based on DC=domain,

DC=local.

The search time can be reduced by
specifying the OU because the search is

only performed within the specified OU.

© To search for users that have locked
accounts, check the [Search for locked
users] check box.
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To add attributes to the
displayed user list

@ Click [Policy] menu > [User Registration
on Active Directory].

File Printer Log ,Wi_cv Option  Help
Edit Palicy. ..
Delete All Palicy. ..
Enable Policy...
Disable Palicy...
User Registration on Active Direckary. ..

@ Click [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

1 agin name/Lroup name which synchronizes with Active Directony 3 x|
Login rame/Group nome: Pyninr
Uinupgistared |00 0 Othed ogiriamas (=) 19216803 5m
1] | b | 1] | X

@ Click [Add] in the [Active Directory User/

Group Settings].

Active Directory User/Group Settings _' & ]Dlﬂ

Accounts for Which Use Restrictions Have Been Configured

| User Mame/Group M... | Type | Displary Mame | E-mail Address

OtherLoginhames Reserve Liser Unregistered ID

REMOYE

4] | |

Use Restriction [ -
Printing

Color Printing

Copying

Color Copying

LISE Memory to Print

UISB Memory bo Color Print

Sran b Fmail

Sican ko Metwork PC

Scan ko USE Memory

Fax Sending -
1| | >

Sel Up Refresd Service. .. Rl el Mo End |

O cClick [Options] in the [Active Directory
Search].

Active Directory Search ...l.l;ll..Yd
-

Seardes Aulive Dieclory g fur & user or group.

Search Criteria = Start Soorch |
Hame [
& Group Stop

Inember REferente;

Gy Setliings. ..

I | Selects & users and arouns

& £ |

@ select the items that you want to display
in the [Choose Columns] tab > [Viewable
Column], and click [Add].
|

St Up Active Directory  Choose Colmns | 16 Card |

-mad fuldress

@ cClick [OK].
option x|

Set Up Active Directory  Choose Columns | 16 Card |
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To hide attributes in the user
list

@ Click [Policy] menu > [User Registration
on Active Directory].

File Printer Log ,Wi_cy Option  Help
Edit Palicy. ..
Delete All Paolicy...
Enable Policy. ..
Disable Palicy. ..

User Registration on Active Direckary. ..

@ Click [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

1 agin nameLroap name which synchronizes with Active Directony 3 x|
Login rame/Group nome: Pyninr
Unangistaied IO 0 OthedogirMames =71 1521603 o0
L ] ey 4] ] |
[_sow. | e | oy |
FF o Assignob Account I . L |

@ Click [Add] in the [Active Directory User/
Group Settings].

Active Directory User/Group Settings

_ioj x|
Accounts for Which Use Restrictions Have Been Configured
| User Hame/Group ... | Type | Display ame

OtherLoginhames Reserve Liser Unregistered ID

| E-mail Address

1

- M

CHAnEE: - I REmOvE:

Lse Restriction [ -
Printing
Color Printing

Copying

Color Copying

LISE Memory to Print

UISB Memory bo Color Print
Sran b Fmail

Sican ko Metwork PC

Scan ko USE Memory

Fax Sending

-
1| B

Sel Up Refresd Service. .. Rl el Mo End |

O cClick [Options] in the [Active Directory
Search].

Active Directory Search ...l.l;ll..Yd
Seardhes Auive Diredlory I
Search Criteria

Hame [ Tope

iy fur & user or group.

Start Scarch I

& Group Stop

Inember REfETEntE,

Gy Setliings. ..

| |
I | Selects & users and arouns

& £ |

@ Display the [Choose Columns] tab.

@ select the items that you want to hide in
[Column to View], and click [Remove].
10|

Set Up Active Directory  Choose Colmns | 16 Card |

] _enal |
@ Click [OK].
#lxl

Set Up Active Directory  Choose Colamns | 16 Card |
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To change the order of
attributes displayed in the
user list

© Click [Policy] menu > [User Registration
on Active Directory].

:,; Print Job Accounting Enterprise

Elz Printer Log | Policy Option Help

- Edit Palicy. ..

E- Log Delete All Palicy...
Enable Policy...
Disable Palicy...

User Reqistration on Ackive Directary...

@ Click [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

1 agin name/Lroup name which synchronizes with Active Directony E x|
Login rame/Group nome: Pyninr
[Nowe [ dobAccount D] LognNeme/Gioupt [ Prives I
Unangistaied IO 0 Othedagrilames =71 1521603 o0
1] | i | | |
- V- B | oy |
FF o Assign Job Account | i SRCr e

@ Click [Add] in the [Active Directory User/
Group Settings].

Active Directory User/Group Settings & |E||5|

Accounts for Which Use Restrictions Have Been Configured

| User Mame/Group M... | Type | Displary Mame | E-mail Address

OtherLoginhames Reserve Liser Unregistered ID

4] |

CHAnEE: - I Remove |

Use Restriction [ -
Printing

Color Printing

Copying

Color Copying

LISE Memory to Print

UISB Memory bo Color Print

Sran b Fmail

Sican ko Metwork PC

Scan ko USE Memory

Fax Sending -
1| | >

Sel Up Refresd Service. .. Rl el Mo End |

O cClick [Options] in the [Active Directory
Search].

o
Seardies Aulive Deeclory i for & user o group.
Search Criteria - | Start Soorch I
Hame [ o2
{+ Group Stop
Description |  User
User N... | T Sethi...
IMember, Reference. .
Conry settiomsi.
i Options.. 1§
1 | | Bl |
I | Selects & users and arouns

@ Display the [Choose Columns] tab.

@ select the items that you want to change
the order of in [Column to View], and
click [Up] or [Down].

O 1]

Set Up Active Directory  Choose Colamns | 16 Card |

o] e |

@ Click [OK].
x|

St Up Active Directory  Choose Columns | 16 Card |
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Specifying attributes for
obtaining IC card information

IC card information (card ID) registered
in the Active Directory attributes can be
obtained, and the IC card compatibility
table can be added when an Active
Directory user is added. This setting
requires the IC card compatibility table to
be registered to the printer.

© Click [Policy] menu > [User Registration
on Active Directory].

Elz Printer Log | Policy Option Help
Edit Palicy. ..
Delete All Policy...
Enable Policy. ..
Disable Palicy...

User Reqistration on Active Direckary. ..

@ Click [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

1 agin nameLroap name which synchronizes with Active Directony 3 x|
Login rame/Group nome: Pyninr
Unangistaied IO 0 OthedogirMames =71 1521603 o0
L ] ol 4] ] |
[ Zewp. |} Erd | Aok |
FF o Assignob Account I . L |

® Click [Add] in the [Active Directory User/
Group Settings].

Active Directory User/Group Settings

_ioix|
Accounts for Which Use Restrictions Have Been Configured

| User NamejGroup ... | Type || Display Mame

OtherLoginhames Reserve Liser Unregistered ID

|| E-mail Address

4] | i |

BEMOVE |

Lse Restriction [ -
Printing

Color Printing

Copying

Color Copying

LISE Memory to Print

UISB Memory bo Color Print

Sran b Fmail

Sican ko Metwork PC

Scan ko USE Memory

Fax Sending -
< | =
Sel Up Refresd Service. .. | Rl el Mo | End |

O cClick [Options] in the [Active Directory
Search].

Active Directory Search ...l.l;ll..Yd
-

Seardes Aulive Dieclory g fur & user or group.

Search Criteria
Type _ SotSowdh |
lame I
& Group Stop
Description | € User
User M. [T Setti... Hame E2itinge s

I | Selects & users and arouns

& £ |

@ Display the [IC Card] tab.
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6. Syncing with Active Directory User Information

@ Check the [Gets IC card information
from Active Directory] check box, and
enter the name of the attribute in which
IC card information stored by the Active
Directory in [Attribute].

TE|

Set Up Active Directory | Choose Cobams 1€ Card |

IC Card Infarmation
¥ gets IC card information from Active Directory
aitrioeo | TSRO
o] e |
@ Click [OK].
Optivn 2] x|

Set Up Active Directory | Choose Cobkanes 1€ Card |

o | et |

The Active Directory attribute name
that you created yourself can also be
specified.

(Note!) e Primary attribute items such as "cn"
cannot be used as attributes for IC
card information.

o If an invalid attribute name is
specified, IC card information cannot
be obtained.

Adding an Active Directory

user

Search for the user or group from the
Active Directory, and use restrictions or
limit values can be set.

Searching for users

0 Start the server software.

@ Click [Policy] menu > [User Registration
on Active Directory].

Eile Printer Log | Policy Option Help
Edit Policy...
Delete All Policy. ..
Enable Palicy. ..

Disablz Policy. ..
User Reqgistration on Active Directory. ..

@ click [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

1 0qin name /Taeoaip name which synchronizes with Active Dicectory 21X

Liogin name/Group nome: Pinter
Urangisieied D 1 Othed agriames 571 [EAETE] E]]
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O Click [Add] in the [Active Directory User/
Group Settings].

Active Directory User/Group Settings ] & |E||5|

Accounts for Which Use Restrictions Have Been Configured

| Display Mame | E-mail Address

Reserve Liser Unregistered ID

| User Hame/Group ... | Type

OtherLoginhames

4] | |

BEMOVE |

Lse Restriction [ -
Printing

Color Printing

Copying

Color Copying

LISE Memory to Print

UISB Memory bo Color Print

Sran b Fmail

Sican ko Metwork PC

Scan ko USE Memory

Fax Sending -
1| B

Sel Up Refresd Service. .. | Rl el Mo | End |

@ Enter the search conditions into the
[Active Directory Search] window, and
click [Start Search]. To stop the search,

click [Stop].
active Direory seanh

Searches fcive o ! ;

[ Search Criteria

pescrption [

Usar Name | T
4] | »
I [Sejects ol ses and groups = LI

(Note!) The search cannot be performed
unless the Active Directory connection
destination is set. For details on
setting the Active Directory connection
destination, see page 106.

Name

Enter the character string that you want to search
from the Active Directory display name, surname,
name, and Name. Items that match the beginning
of the entered character string are displayed. If
items have been entered into the [Description]
column, items that match both are displayed.

Description

Enter the character string that you want to search
the Active Direction explanation for. Items that
match the beginning of the entered character
string are displayed. If a character string has
been entered into the [Name] column, items that
match both are displayed.

Type

Select the Active Directory search target. Groups
or users can be set as search targets.

o If the [Start Search] button is clicked

when the [Name] and [Description]
sections are blank, the search is
performed for all users or groups.

e "*" can be entered as a wild card
for [Name] and [Description]. "*"
represents more than 0 character
strings.

O The groups or users are displayed in the
[Active Directory Search] window.
To set use restrictions or limit values,
select the group or user and click

[Settings].

ative pireutory search ~loixl
Searches Acthve Db iy rk For & user or group.

[ e | metswr |
e Im 1 Group Shof I
Descripion | & Lser

4] |
[T Selects gl users and groups

[Found 1 sccounts

When setting use restrictions or limit
values for groups, the same use
restrictions are set for the users that
belong to that group. However, use
restrictions or limit values can also be set
for specific users or groups that belong to
the group.
e To set use restrictions or limit values for
groups or users, proceed to "Setting use
restrictions or limit values" (page 114).

e To set use restrictions or limit values
for specific users or groups that belong
to groups, proceed to "Referencing
members that belong to groups”

(page 114).
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Referencing members that
belong to groups

Use restrictions or limit values can also be
set for specific users or groups that belong
to the group.

@ sclect a group from those displayed in
the [Active Directory Search] window,
and click [Member Reference].

Active Directory Search E =] 3]
Searches Active Dirsctory b configure use restrictions For a ussr or group.
~Search Criteria e T
Hame | sales Section tio. 1
& Group Stop |
Description | £ User
User MamefGroup Name | Type | Settings | Display Name Settings. .. |
Sales Section No.1 Group o Setting
{ Weber Refereice,
O DETTOE
Options...
! | A e
I™ Selects all users and groups —
[Found 1 accounts

@ Users that belong to the group are
searched. To stop the search, click
[Stop]. To search the users that belong to
the group again, click [Re-search].

List of Members Belonging to Selected Group

10| x|

[ User N.o | Type | Belonging Group [ Setti... | Display Name Research |
O suzuki User Sales Section No.1 MoS. sueuki
O sato User Sales Section No.1 Mo5. sato
O takahashi User Sales Section No.1 MNoS... takahashi
O muraka User  SalesSectionfad  NoS.. murata Gethigs o)
O ircue User Sales Section No.1 MoS... inoue
(Cop | Settias, o
< ] |
Search finished End

® select a group or user displayed in the
[List of Members Belonging to Selected
Group] window, and click [Settings].

Member Reference E o [=] 5]

List of Members Belonging to Selected Group

[ Tuser o [ Tue odlergr o [ oot [ Delptiane [ Beach |
suzuki User  Sales Section No.1 NoS.. suzki =
O sate User Sales Section No.1 MoS.. sato —
O takahashi User Sales Section No. 1 MoS.. takahashi
O murata User Sales Section No.1 MNoS.. murata = j
O inoue User Sales Section No.1 MoS.. inoue
4] | |

Search Finished End

Proceed to "Setting use restrictions or limit
values" (page 114).

Setting use restrictions or
limit values

@ set the use restrictions in the [Use
Restrictions] tab.
21 x|

User/Group Information USERESU‘CUOHSI Limit Values I

[]Disable Printing
[ ]Disable Color Printing

[C1Frint in Mona

[]Disable Copying

[IDisable Color Copying

[ |Disable USB Memory to Print

[]Disable USB Memory ta Calor Print

[ ]Disable Scan to Email

[ |Cisable Scan to Network PC [ Disable Scan to Shared Folder
[ ]Disable Scan to USE Memary

[ ]Disable Fax Sending

[ |Cisable Scan to Internet Fax

[ IDisable Scan to Fax Server

[INotifies total result by e-mail

[ |Motifies by e-mail when Limit Values was exceeded

[¥]Do not process

Cancl

Disable Printing
Cancels printing.
Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Print in Mono

When Disable Color Printing is set, monochrome
printing is performed without cancelling color
data.

Disable Copying

Copying using panel operations is prohibited.
When this is disabled, the Disable Printing
settings are followed.

Disable Color Copying

Color copying using panel operations is
prohibited. When this is disabled, the Disable
Color Printing settings are followed.

Disable USB Memory to Print

Prohibits printing from a USB memory using
panel operations.

Disable USB Memory to Color Print

Prohibits color printing from a USB memory using
panel operations.

Disable Scan to Email

Prohibits Scan to Email using panel operations.
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Disable Scan to Network PC /
Disable Scan to Shared Folder

Prohibits Scan to Network PC and Scan to Shared
Folder using panel operations.

Disable Scan to USB Memory

Prohibits Scan to USB memory using panel
operations.

Disable Fax Sending

Fax sending using panel operations is prohibited.
Fax sending that uses the fax driver is also
cancelled.

Disable Scan to Internet Fax

Prohibits scan to internet fax using panel
operations.

Disable Scan to Fax Server

Prohibits scan to fax server using panel
operations.

Notifies total result by e-mail

Notifies the total amount used every month by
e-mail.

Notifies by e-mail when Limit Values was
exceeded

A mail notification is sent when the print quantity
exceeds the limit value and printing is no longer
possible, and when the limit value is reset and
printing is made possible again.

Do not process Limit Value as a group

Limit values can be set individually for printer
users that belong to a printer group, and users
that belong to a user group. When [Do not
process Limit Value as a group] is unchecked, if
the total amount used by users that belong to the
group exceeds the specified limit value, printing
of all users that belong to the group is cancelled.
When [Do not process Limit Value as a group] is
checked, if the total amount used by users that
belong to the group exceeds the specified limit
value, printing of the users whose print total

exceeds the limit value is cancelled.

@ set the limit values in the [Limit Values]
tab.

When each of the limit values is
exceeded, printing is cancelled until the
valid period set in step 0.

Use Restriction Change i 2] x|
Use Rastrict\o
100 sheets
[ staple staples
Yalid Period
IDﬂ not specify j
Set Priorities. ..
Cencel |

(Note!) The limit value settings are enabled
from the point at which the server
software obtains the log when the limit
value has been exceeded. Printing can
still be performed when the limit value
is exceeded until the server software
receives the log.

Printed Sheets

Set the number of sheets that can be printed.
Fees

Set the upper limit of the fee charges.
Staple

When the optional finisher is installed, set the
number of times that the stapler can be used.

If the limit value was set, proceed to step 9
If the limit value was not set, proceed to

step @.
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@ set the valid period for the limit value set
in step ©.

Use Restriction Change 2

Use Restrictions lhl\'nlmi

F# Prinked Shests 100 chests
I” Eees |
I~ e [ slaples

To 2012f01{10

1 months To 10th of the morth ~|

I Corry over unused value to the next valid period

When the valid period is exceeded, the
limit value count is reset.

Do not specify

The valid period is not set. When the limit
value set in @ is not set, printing is cancelled
unless the limit value is increased, or the usage
conditions are manually reset.

By month

Set the valid period in month units. Set the
number of months and base date (10th, 20th,
end of month, deadline).

By week

Set the valid period in week units. Set the
number of weeks and base day.

By day

Set the valid period in day units. The number of
days is set.

Carry over unused value to the next valid
period

Check to carry over the amount that is not used
within the valid period to the next period.

O Click [OK].

Use Restriction Change 2%

Use Restrictions lill\'almi

I pretsdshos [100 cheats
I" fees [

I Staple [ slaples
oy month |
To 2012{01/10

1 months To 10th of the month "I

I Corry over unused valus to the next valid pericd
Set Priorkes... |

(Note!) e The use restrictions for users that
belong to multiple groups are all
set to prohibited when the multiple
groups are set to prohibited. Printing
and copying etc, are set to printing
(copying) available, Print in Mono,
color printing (copying) unavailable,
and printing (copying) unavailable in
this priority order.

e The limit values are taken as those
from the group with the highest
priority level. To change the priority
of groups, see "Changing the priority
level of groups" (page 122).
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Copying user settings from Applying settings to the
other groups printer
The settings of groups or users whose use
restrictions or limit values are completed The following steps apply to all users
can be copied to other groups or users. registered in the steps from page 102
to page 116. These can be changed for
@ Select the copy destination group or user each user later.
in the Active Directory Search window.
v Directory seoran— R © Click [End] in the [Active Directory
Searches Active Di to corfigy brictions for & user or group. H
Saaeh Crearn = T Search] window.
== I C Group SEop _{D] 2|
Description |  Lisar Searches b i For & user or growp.
- Saarch Criteria
i T i P e |
O suzdi Priority ... selling sundi Groap SE8p
H sato User Mo Setting saho Description | ¥ Liser
[0 takahashi user Mo Settng takahashi
0O rmurats e ke [ st NoemefGroup Name. | Type | Settings T Dispiay tamne e, |
0 incem Lisar Mo Setting incus .
E:;N :;:ly... m :;N IMeemfoer Reference,,, I
[0 takahashi user Mo Settng takahashi
O rmurata User Ho Setting irata
0 incus Liser Mo Seting incus
L1 | | jid| £rd |
[T Selects gl users and groups
[Found 5 sccounts
'I I J Frd |
) ] N T |y -1 e
@ click [Copy Setting]. oS wcouets
factive Directory Search R - .|
o : ““‘:"“" —— ® Click [End].in the .[Active Directory User/
e Pt -~ Group Settings] window.
Description |
Active Directory User/Group Settings = ]Dlﬂ
Iuwmum Type |m |MM
O s Privrity ... selling Accounts for Which Use Restrictions Have Been Configured
Duen o o R K 0 RO [FTR A
E mo m :m OtherLoginklames Reserve |ser Unregistered 1D
4 | >
f"lseha‘mwm : HLI Add... I CHETTE . | Hemave |
Found S sccounts
Use Restriction [ -
© Select the group or user whose settings i N
are to be copied, and click [OK]. e
USE Menry Lo Prinl
21X 5B Memory to Color Print
can ko kmal
Specify A SOUFCR USEF F Qo (o copry from. Sican ko Network PC
Scan ko USE Memoary
Fax Sending
Scan ko Inkernet Fax |
Scan ko Fax Server
Motifies total r&s.ult vy e-{nail =
bhr‘tﬁesbve-mal\:\henuﬂ Values was exceeded | bf_l
Set Up Refresh Service... | Refresh Now

4| |
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@ When the [Assign Job Account ID]
window is displayed, assign a Job Account
ID to users that currently do not have a
Job Account ID assigned, and click [OK].
For details on how to assign Job Account
IDs, see "Assigning a Job Account ID to
an Active Directory user" (page 125).

Assign Job Account ID 2|

User

Name_’ Job Account [T | Login Mame/Group Name |

suzuki suzuki

LChange |
Filc... ]
Auta Assign l

Eemove

| ——
W Only display non-assigned login name
Job Account D | ancel

L

O Click [Apply] in the [Login name/Group
name which synchronizes with Active
Directory] window.

1 ngin name/Liraup name which synchronizes with Active Directory 3 2 x|

Logn rame/Goup nme: Ppininr
1 i t [Pien T
Unusgisiered |7 0 Othad.ogniamas a4l [ TE] Eod]
sunds A wauk
] e I C11 J
sewp. | £
7 At Assign Job Aiccount 1D s | T

@ When the confirmation window appears
confirming whether or not to apply use
restrictions to the printer, click [OK].

Print Job Accounting Enhkprise. E[

Policies are applied ko the selected prinker,

Zancel |

@ When the administrator password window
is displayed, enter the administrator
password and click [OK].

@ When the settings for registering the IC
card compatibility table to the printer are
enabled, a window inquiring whether or
not to register the IC card compatibility
table to the printer is displayed. Click
[Yes] to send the IC card compatibility
table to the printer, or [No] to not send
the IC card compatibility table to the
printer.
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Changing Active Directory
user settings

The use restrictions or limit values set to
the Active Directory users or groups can be
changed.

Changing use restrictions or limit values

0 Start the server software.

@ click [Policy] menu > [User Registration
on Active Directory].

™ Print Job Accounting Enterprise

File Printer Log | Policy Option  Help

- Edit Palicy. ..

- Log Delete All Palicy. ..
Enable Policy. ..
Disable Palicy...

User Reqistration on Active Directary. ..

@ click [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

Login name/Group name which synchronizes with Active Directory 2l 2] x|

Login hame/Group name Pinter

Name [ Job Account D | Login Name/Group b | Printer Name [ Addiess | Status | The magimum mun
u Bl 5001

nregistered 10 OtherLoginklames 19216803

o | oyl | o
(== . i
= Aul Job Account D Tr— Seesim |
Espont Lisers

O select the user in the [Active Directory
User/Group Settings] window, and click

[Change].
Active Directory User/Group Settings = Ellll
Accounts For Which Use Restrictions Have Been Configured
User MamefGroup M. E-mail Address
OtherLoginkames
3 ' i
Add.. | Change... | Remave |
Use Restrictions on suzuki
Use Restriction | £
Prinking Enable
Color Printing Enable
Copying Enable
Color Copying Enable
USE Memory ko Print Enable
USE Memory to Color Print Enable
Scan bo Emnail Enable
Scan bo Mebwork PC Enable
Scan to USE Memary Enable
Fax Sending Enable
Scan to Internet Fax Enable |
Sian ko Fax Server Enatble
Motifies total result by e-mai Do nak Motify
N?tifies b e-mail when Limit Yalues was exceeded Do nok Notify | _ILI
4 4
Set Up Refresh Service.., | Refresh Now | End

@ set the use restrictions in the [Use
Restrictions] tab.
20 x]

User/Group Information USERESU@MSI Limit Values I

[ |Disable Printing
[ ]Disable Color Printing

[CJPrint in Mona

[ |Disable Copying

[]Disable Color Copying

[ ]Disable USB Memory to Print

[ |Disable USE Memory to Calor Print

[ ]Disable Scan to Email

[ |Disable Scan to Network PC [ Disable Scan to Shared Folder
[ |Disable Scan to USE Memary

[ ]Disable Fax Sending

[ IDisable Scan to Internet Fax

| |Disable Scan to Fax Server

[INotifies total result by e-mail

[ IMotifies by e-mail when Limit Values was exceeded

[w]Do not process

concl

Disable Printing
Cancels printing.
Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Print in Mono

When Disable Color Printing is set, monochrome
printing is performed without cancelling color
data.
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Disable Copying

Copying using panel operations is prohibited.
When this is disabled, the printing prohibited
settings are applied.

Disable Color Copying

Color copying using panel operations is
prohibited. When this is disabled, the Disable
Color Printing settings are followed.

Disable USB Memory to Print

Prohibits printing from a USB memory using
panel operations.

Disable USB Memory to Color Print

Prohibits color printing from a USB memory using
panel operations.

Disable Scan to Email
Prohibits Scan to Email using panel operations.

Disable Scan to Network PC /
Disable Scan to Shared Folder

Prohibits Scan to Network PC and Scan to Shared
Folder using panel operations.

Disable Scan to USB Memory

Prohibits Scan to USB memory using panel
operations.

Disable Fax Sending

Fax sending using panel operations is prohibited.
Fax sending that uses the fax driver is also
cancelled.

Disable Scan to Internet Fax

Prohibits scan to internet fax using panel
operations.

Disable Scan to Fax Server

Prohibits scan to fax server using panel
operations.

Notifies total result by e-mail

Notifies the total amount used every month by
e-mail.

Notifies by e-mail when Limit Values was
exceeded

A mail notification is sent when the print quantity
exceeds the limit value and printing is no longer
possible, and when the limit value is reset and
printing is made possible again.

Do not process Limit Value as a group

Limit values can be set individually for printer
users that belong to a printer group, and users
that belong to a user group. When [Do not
process Limit Value as a group] is unchecked, if
the total amount used by users that belong to the
group exceeds the specified limit value, printing
of all users that belong to the group is cancelled.
When [Do not process Limit Value as a group] is
checked, if the total amount used by users that
belong to the group exceeds the specified limit
value, printing of the users whose print total
exceeds the limit value is cancelled.

@ set the limit values in the [Limit Values]
tab.

Usetiskoup Information | Lise Restrictions ~ Limit Yalues I

7 Bripked sheets i i

[~ Eees l—

[ staple staples

Yalid Period

IDo niot specify j
Set Priorities...
Ok | Cancel |

When each of the limit values is
exceeded, printing is cancelled until the
valid period set in step 0.

(NOte!) The limit value settings are enabled
from the point at which the server
software obtains the log when the limit
value has been exceeded. Printing can
still be performed when the limit value
is exceeded until the server software
receives the log.

Printed Sheets

Set the number of sheets that can be printed.
Fees

Set the upper limit of the fee charges.
Staple

When the optional finisher is installed, set the
number of times that the stapler can be used.

If the limit value was set, proceed to step 0
If the limit value was not set, proceed to

step 0.
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@ set the valid period for the limit value set
in step @.

Use Restriction Change ) -ﬂﬂ

To 2012f01{10

1 months To 10th of the morth “'I

I Carry over unused value to the next valid period

When the valid period is exceeded, the
limit value count is reset.

Do not specify

The valid period is not set. When the limit
value set in @ is not set, printing is cancelled
unless the limit value is increased, or the usage
conditions are manually reset.

By month

Set the valid period in month units. Set the
number of months and base date (10th, 20th,
end of month, deadline).

By week

Set the valid period in week units. Set the
number of weeks and base day.

By day

Set the valid period in day units. The number of
days is set.

Carry over unused value to the next valid
period

Check to carry over the amount that is not used
within the valid period to the next period.

@ cClick [OK].
Use Restriction Change i d |
L | Uik Yahoes |
IV [rinted Sheets: | 100 cheets
I" fees [
I~ Stape | saphes
oy month |
To 2012j01{10
1 months To 10th of the mornth "I
I Carry over unused value to the next valid period
set Poormes... |

(Note! e The use restrictions for users that
belong to multiple groups are all
set to prohibited when the multiple
groups are set to prohibited. Printing
and copying etc, are set to printing
(copying) available, Print in Mono,
color printing (copying) unavailable,
and printing (copying) unavailable in
this priority order.

e The limit values are taken as those
from the group with the highest
priority level. To change the priority
of groups, see "Changing the priority
level of groups" (page 122).
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Changing the priority level of

groups

When users that are set with use
restrictions or limit values belong to

multiple groups, the priority level at which

group use restrictions or limit values are

applied to users can be changed. The use

restrictions or limit values of the highest
priority level group are assigned to the
user.

0 Start the server software.

@ Click [Policy] menu > [User Registration

on Active Directory].

Ele Printer Log | Policy Option Help

- Edit Palicy. ..

E- Log Delete All Palicy. ..
Enable Palicy...
Disable Policy. ..

User Reqistration on Active Cirectory...

® Click [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

1 agin name/Lroup name which synchronizes with Active Directony x|
Login rame/Group nome: Pyninr
[Nowe [ dobAccount D] LognNeme/Gioupt [ Prives I
Uniegisiend 1D 0 Othedogriames | CBA1 192 1603 5001
1] | - |

O sclect the user in the [Active Directory
User/Group Settings] window, and click
[Change].

Active Directory User/Group Settings = |E||5|

Accounts for Which Use Restrictions Have Been Configured

oup M...

OtherLoginklames Reserve |ser Unregistered 1D

< | |

add... changs.. | | Remove |

Use Restrictions on suzuki

Use Restriction [ -

Printing Enablc

Color Printing Enable

Caopying Cnable

Color Copying Enable

UISE Menmry Lu Prinl Ensalile

UISE Memory to Color Print Enable

Scan to kmal tnable

Sian ko Metwork PC Enable

Scan ko USE Memoary Enable

Fax Sending Enable

Scan to Inkernet Fax Enable I

Sican ko Fax Server Enable

Motifies total result by e-mail Do not: Motify

‘N tifies by e-mail vwhen Limit Yahues was exceeded Do not Notify | le
Set Up Refresh Service... | Refresh Now | End |

@ Click the [Limit Values] tab > [Set
Priorities].

Use Restriction Change 2%

I St [ slaples
oy month |
To 2012{01/10

1 months To 10th of the morth ~|

¥ Carry ovor unused value to the next valid peried
[ ] concet |
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@ select the group whose priority you want
to change in the [Set Priorities] window,

and click [Up] or [Down].

Allacate the priarity level in the limit walues For the groups
to which the user belongs when the user belongs ko two ar
more groups,

The limit walue of the group with high priority becomes
effective for the user,

Sales Section Mo, 1

Sales Section Mo, 3

Cowan

s

(o]4 I Cancel
@ Click [OK].

Allocate the priority level in the limit values For the groups
to which the user belongs when the user belongs to bwo or
fmare groups.

The limit walue of the group with high priority becomes
effective for the user,

Sales Section Mo, 2
Sales Section Mo, 1
Sales Section Mo.3

i

Dnowan

Cancel |

(Note!) The priority order settings are applied to

all users that belong to the group.

Applying settings to the
printer

@ Click [Apply] in the [Login name/Group
name which synchronizes with Active
Directory] window.

1 ngin name/roap name which synchronizes with Active Directory 2 x|

Logn rame/Goup nme: Ppininr

Uningisteied I} 0 Othed ogriiames 71 19216803 Ei]

wund 1730 ek

LN 2 sl | .
Stup..

FF Autn Assgn Job Account I

s
Erpat oers..

@® When the confirmation window appears
confirming whether or not to apply use
restrictions to the printer, click [OK].

Policies are applied ko the selecked printer,

Zancel

® When the administrator password window
is displayed, enter the administrator
password and click [OK].

O When the settings for registering the IC
card compatibility table to the printer are
enabled, a window inquiring whether or
not to register the IC card compatibility
table to the printer is displayed. Click
[Yes] to send the IC card compatibility
table to the printer, or [No] to not send
the IC card compatibility table to the
printer.
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Deleting an Active
Directory user

The use restrictions or limit values set to
the Active Directory users or groups can be
deleted.

@ sStart the server software.

@ Click [Policy] menu > [User Registration
on Active Directory].

:,; Print Job Accounting Enterprise

Elz Printer Log | Policy Option Help

- Edit Policy. ..

B Log Delete All Palicy...
Enable Policy...
Disable Palicy...

User Reqiskration on dctive Directory. ..

@ cClick [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

1 agin name/Lroup name which synchronizes with Active Directony x|
Login rame/Group nome: Pyninr
[Nowe [ dobAccount D] LognNeme/Gioupt [ Prives I
Urangisieied D 1 Othed agriames 571 1821680 ET]
1] | g 4| | |
JI T [ |
R Job hccount I T |

O sclect the user in the [Active Directory
User/Group Settings] window, and click
[Remove].

Active Directory User/Group Settings & |E||5|

Accounts for Which Use Restrictions Have Been Configured

oup M...

OtherLoginklames

Reserve |ser Unregistered 1D

| | 3

Aul... I Cliame... I B I
Use Restrictions on suzuki
Use Restriction [ -
Printing Enable
Color Printing Enable
Cring Frahle
Color Copying Enable
LISE Mamory bo Print Enable
UISB Memory to Color Print Enable
Scan ko Email Enablz
Sican ko Metwork PC Enable
Sran Lu USE Memury Enalile
Fax Sending Enable
can to nkernet Fax Enable |
Sican ko Fax Server Enable

Motities botal result by e-mail Do not Mokiby
Nur‘tﬁes b e-mail when Limik Yalues was exceeded Do nok Notify | _ld
4 L3

End I

Set Up Refresh Service... | Refresh Now |

@ When the user delete confirmation
window is displayed, click [Yes].

@ click [End].

Active Directory User/Group Settings = |E||5|

Accounts for Which Use Restrictions Have Been Configured

Liser M. N... | Type Di Idame
OtherLoginMames Rescrve User Unregistered ID

E-mail Address

| | |

Aud... I Cliamge, .. I

By I

Use Restriction [ -
Printing

Color Printing

Cnpwying

Color Copying

USE Memory bo Print

LISB Memory to Color Print
Scan ko Email

Sican ko Metwork PC

SLani Lo USE Menmry

Fax Sending

SCan to Internet Fax

Scan to Fax Server

Motities botal result by e-mail

Nur‘tﬁes b e-mail when Limit Yalues was exceeded ﬁ
4 I E

Refresh Mow

Set Up Refresh Service...
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@ Click [Apply] in the [Login name/Group
name which synchronizes with Active
Directory] window.

1 ngin name/Liraup name which synchronizes with Active Directory = 2lx|

Login rame/Goup nome: Ppinins

i N b [Priven. Ti
Uniegistpied [0 0 Othed ogintiames BT 15216803 Ei]
sk 0

LT — | sl |
sew. |

Enport Ueavs..

¥ Autn Assign Job Account D

@® When the confirmation window appears
confirming whether or not to apply use
restrictions to the printer, click [OK].

© When the administrator password window
is displayed, enter the administrator
password and click [OK].

® When the settings for registering the IC
card compatibility table to the printer are
enabled, a window inquiring whether or
not to register the IC card compatibility
table to the printer is displayed. Click
[Yes] to send the IC card compatibility
table to the printer, or [No] to not send
the IC card compatibility table to the
printer.

Assigning a Job Account
ID to an Active Directory
user

Active Directory users that are set with
use restrictions or limit values must be
assigned with a unique Job Account ID.
There are two methods for assigning a Job
Account ID to an Active Directory user that
is set with use restrictions or limit values,
which is done when the user is added

to the Active Directory. These are the
automatic method or the manual method.

Automatically assigning a
Job Account ID

When the setting for automatically
assigning the Job Account ID is enabled,

a unique Job Account ID can be
automatically assigned to a user when the
user is added to the Active Directory.

@ start the server software.

@ Click [Policy] menu > [User Registration
on Active Directory].

Ele Printer Log | Palicy Option Help

[ Edit Policy...

G- Log Delete all Palicy. ..
Enable Policy...
Disable Palicy...

User Registration on Active Directary. ..

® In the [Login name/Group name which
synchronizes with Active Directory]
window, check the [Auto Assign Job
Account ID] check box.

1 agin name /Liroap name which synchronizes with Active Directory ] i .

Logn rame/Goup nome Pyninr

1 N t [Pien 1
Uniegistered [0 0 Othwedogrbiames BT 192 16803 s
aundi P sk
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Manually assigning a Job
Account ID

When [Auto Assign Job Account ID] in

the [Login name/Group name which
synchronizes with Active Directory] window
is disabled, the [Assign Job Account ID]
window is displayed when a user is added
to the Active Directory. A unique Job
Account ID can be assigned manually to
the user.

@ Check the [Only display non-assigned
login name] check box.
21X

User

Namei JohAcmun‘tlDl Loogin Name/Group Mame | 51
A

sato zato

Ful | LI

¥ iy display norrassioned login name

@ Enter the Job Account ID to be assigned
in the [Job Account ID] column.

Assign Job Account ID 21|

User

Namei JobAcmun‘tlDl Loogin Name/Group Mame | 51
A

sato zato

| | 1|
™ Only display non-assigned login name
Job Account 1D iEeEi

@ select the user to assign the Job Account
ID to in [User], and click [Change].
Assign Job Account ID h. 21x|

User

Namel JohAccuun‘tlDl Loogin Name/Group Mame | 51

sato zato A

Auto Assign |
FHemove

|l = I3

z 5 oK |
¥ Only display non-assigned login name
dobhccourtlD [12265 Cancel |
O Click [OK].
2]

User

Namei Juob Acco | Loogin Name/Group Mame | 51
A

unit 1D
sato 12345 :zato

ImjE——
¥ Only display non-assigned login name
Job Account D |

(NOte!) These settings are not reflected in
the printer until [Apply] in the [User
Registration on Active Directory]
window that appears after step @ is
clicked.
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Assigning a Job Account ID <For Excel>

from a file

When [Auto Assign Job Account ID] in

the [Login name/Group name which
synchronizes with Active Directory] window
is disabled, the [Assign Job Account ID]
window is displayed when a user is added
to the Active Directory. A Job Account ID
can be assigned to the user by creating

a CSV file that contains the user name

and Job Account ID, and then reading the
created CSV file.

(Note!) e Assignment of the Job Account ID is
only available for users that are added
from the Active Directory.

o If a Job Account ID is already assigned
to the user, the file contents are
overwritten.

@ Create a CSV file using software such as
Notepad or Excel etc.

<For Notepad>

B untited -otepad WSI[=II-Y

File Edit Format Miew Help

sato,12341 -]
takahashi,12342
suzuki,l12343
murata,lZ344
Tnoue,l12345

4] 2V

@ Write 1 login name on each line.

@ Save in text format with the extension
"CSV".

E] Microsoft Excel - Book1

5 File Edit WView Insert Format

NEHSAIVE B

......

Ab - B
A | B | C |

1 |sato 12341

2 |takahashi | 12342

3 |suzuki 12345

4 |murata 12344

5 linoue 12345

6 I

=

M 4 ¢ M\ Sheetl Sheet? / Sheet3 /
‘Draw v |3 | AutoShapes~ N\ . [
Ready

@ write 1 login name on each line.
@ save in CSV file format.

@ Check the [Only display non-assigned
login name] check box.

2/
User
MName | Job Account ID | Login Mame/ Group Name |
inoue inoue
murata murata
sato sato
suzuki suzuki
tak ahashi takahashi
LEhange |
Filc... |
Auto Assign
Eemove |
4] | LI
¥ iOnly display non-assigned login name
Lob L1y I 1 Em
= 1 —l
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© Click [File].

(/) Specify the CSV file created in @, and
click [Open].

@ Check that the Job Account ID is
displayed in [User].

Assign Job Account ID

@ Click [OK].

Assign Job Account ID

Note! ) These settings are not reflected in
the printer until [Apply] in the [User
Registration on Active Directory]
window that appears after step 0Ois
clicked.

- 128 -



6. Syncing with Active Directory User Information

Changing the assigned Job
Account 1D

@ Start the server software.

@ Click [Policy] menu > [User Registration
on Active Directory].

File Printer Log ,Wi_cy Option  Help

- Edit Palicy. ..

- Log Delete All Palicy. ..
Enable Policy. ..
Disable Palicy...

User Reqistration on Active Directory. ..

@ Click [Assign] in the [Login name/Group
name which synchronizes with Active
Directory] window.

1 ngin name /Liraup name which synchronizes with Active Directory x|

[Mowe [ dobAccourt D[ LognNeme/Gioupt [ Priveshi T
Uniegisieied I 0 Dthedogndames o4l 182 16803 Ei]
o 125 roue

sty 1234 murata

saly 121 eso

umki 12343 sumki

Lk ahashs TZH2 lakashstn

@ uncheck the [Only display non-assigned
login name] check box.

2]

User

Namei JohAcmun‘tlDl Loogin Name/Group Mame | 51

inoue 12345  inoue

murata 12344 murata

sato 12341 sato

suzuki 12343 suzuki

taka... 12342  takahashi

| | i3

I I” Only display non-assioned login name:
3 o

@ Select the user whose Job Account ID is
to be changed in [User].

Assign Job Account ID fed 3|

User

Namei JobAr.cuun‘tIDl Loogin Name/Group Mame | 51

inoue 12345  inoue
murata 12344 murata
33k 12341

Kl = | i
I Only display non-assigned login name

Job Account 1D I‘I 2343 Cancel |

(6) Change the entry in [Job Account ID],
and click [Change].

2/
User
Namel JobAr.cuun‘tIDl Loogin Name/Group Mame | 51
inoue 12345  inoue
murata 12344 murata
sato 12341 zato
suzuki 12343 suzuki
taka... 12342 takahashi

Kl =———| i
I Only display non-assigned login name

Job Account 1D |12348
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@ Click [OK].
21x]

User

Namel Job Account ID| Login Mame/Group Mame |§
inoue 12345  inoue

murata 12344 murata

sato 12341 sato

suzuki 12343 suzuki

taka.. 12342  takahashi

EE |
I” Only display non-assigned login name
Job Account ID |1 2346

(Note!) These settings are not reflected in
the printer until [Apply] in the [User
Registration on Active Directory]
window that appears after step Qis
clicked.

Exporting data for client
software

Users added from Active Directory can be
used in the client software hidden mode.
For details on the client software hidden
mode, see "Setting Job Accounting Mode"

(page 41).
@ Start the server software.

® Click [Policy] menu > [User Registration
on Active Directory].

% Print Job Accounting Enterprise

File Printer Log | Paolicy Option  Help

E- Edit Policy...

G- Log Delete All Palicy. ..
Enable Policy. ..
Disable Palicy. ..

User Reqgistration on Active Directory. .,

® Click [Export Users].

1 agin name/Lroup name which synchronizes with Active Directony 3 x|
Liogin name/Group name: Fyinier

[Nowe [ iobAccourt 0 | LognNeme/Gioupt [ Priveshl I

Uningisiered | 0 Othad ogniiamas o1 152 1603 E]

[T TZHS roam

munats 1238 muratn

salo 121 edo

sumhi 12343 ki

tekahasts TEHE \skshsi

B ] i}

O Check the [For Client reference] check
box, and click [Browse].

CETTEE—— 20
[-Uszer auto ating folder

¥ Tor Client reference

" Create card table

i Card tatie setting
|S5rd el auta exporting folder;

IC; “Program Fazh0kidata\Print Job Accounting

Sendcardtable Edk cardiatie l Brotws=,.. I

= it Ardmitesatan af Fam e it sending cand Fanl e Froprindern,
I Display & message at starup)af this iy

™ Kietify admirisiratar by e-mail

Ok | LCancel |
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@ sclect the folder that you want to save,
and click [OK].

0 click [OK] in the [Export Users] window.
[eporvsers 21

— User auto exporting folder
¥ Tar Client reference

Iﬁ'\Plngam FleANkidata\Print Jnh Arermbing

" Create card table

v Card tatie setting
|E5rd Eable aute exporting folder

IC: “Program FazhOkidata\Print Job Accounting

Sendcardtabie Edf cardEstis i Browse... I

= Wit Armitesatan af Famine it senditg cand Fanl e frarinsern,
I Display & message at starupof this utiey

™ etify admirisiratar by e-mail

LCancel

@ A file named opjobac4.dat is generated
in the folder selected in @, and the
generated file can be specified in the
[Hidden mode] of the client software.
For details on specifying the export file
for the client software, see "Acquiring
user information from files in hide mode"
(page 219).

Exporting the IC card
compatibility table

The IC card compatibility table associates
three types of data, namely the IC card
information (card ID), Job Account ID, and
login name. When the IC card compatibility
table is registered to the printer, the use
restrictions assigned to the Job Account
ID or login name can be applied to the IC
card authentication print job. In order to
register the IC card compatibility table with
the printer, all of the following conditions
need to be fulfilled.
e An SD card for receiving the IC card
compatibility table is installed in the
printer

e The printer power is ON

e The IC card compatibility table
registration settings in the printer
in which you want to register the IC
card compatibility table are enabled
(page 131)

e The settings for creating an IC card
compatibility table are enabled
(page 133)

Setting the printer to which
the 1C card compatibility
table is registered

Enable the IC card compatibility table
registration settings in the printer in
which you want to register the IC card
compatibility table.

@ Check that the printer power is ON.
@ Start the server software.

® Double-click [Printer] in the selection

window. The registered printer list is
displayed in the details window.

t__'_;',. Print Job Accounting Enterprise
File Printer Log Policy Option Help

..

[#-Log
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O select the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.

t__';'_, Print Job Accounting Enterprise
File Log Policy Option Help

= F  AddaPrinter...
Manage multiple printers as a group...
Delete a Printer Printer Group

'l Change a Printer Group. ..

Start/End Log

Acquire a Log

Sebbing Bhe Time

Define Fees...

Backup of printer setting...

Properties...

&

@ Click the [Option] tab > [Detail setting].

Printer' Uzer  Option |

Acquire Logs

& |nterval

I? Haur ID inutes
Lhange Time... |

Fees C841/0831/0822 j

Define fees... |

= Time

Operation at Log Full IDeIete ol lags j

Auta Export Logs IDU not automatically export j

I™ | Becordlogs in & database

Click [Detail zetting] to cooperate with
Active Directory.

ok | x|

@ Check the [Synchronize user list with
Active Directory] check box.
ostailserung 2=l

Pkt Basad i
1~ Usar it idaniified by Job Account 1D

Chent software has bo be matalled on cach user's FU.
& User is dentified by PC Login name / card

Chent software is not necessany.

™ Download erecled card bable bo a pinter
I Al altemative autfienticatian for card

TS | Cancel

@ Check the [Download enrolled card table
to a printer] check box.
oetalsatung 2 x]

¥ Sunchionize uses list with Active Diteciony

-~ Policy based printing
" User it identified by Job Account ID
Chorit sollwans has bo be matalled on each users FL.
(% User is identified by PC Login name / caed
Chent sofbware is not necessan.

[ ¥ Downioad creoled card tble fo 3 printet

= Al altzmative autfienticatian fos card

@ cClick [0OK].
petaiiseting 2=

[¥ Synchronize uses list with Activa Diseciory

~ Policy based prnting
1~ Usar iz idantified by Job Account 1D
Chent solftware: has o be matalled on cach wiers FL.
& User s identified by PC Login name / card
Chent soltwase is not necassary.

V¥ Download erecled card table bo a prinler

I Al altzmative autfienticatian for card

[ e |

© Click the [Option] tab > [OK].
2l
Frinter | User  Option |

Acquie Logs

@ |nteryval

I? Hour ID Minutes
Lhange Time... |

Fees C841/0831/C822 j

Define fees... |

 Time

DOperation at Lag Full IDeIete old logs j

Auta Export Logs IDD it automatically expart j

I™ | Becord logs in & database

Click [Dietall setting] ta cooperate with

o " Dietail setting...
Active Directory. —gl

sl |
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@ 1f the settings for creating an IC card
compatibility table are not set, a message
notifying that the IC card compatibility
table cannot be registered to the printer
is displayed. Click [OK]. In order to
register an IC card compatibility table
to the printer, the settings for creating
an IC card compatibility table need
to be configured. For details on the
settings required for creating an IC card
compatibility table, see "Creating an IC
card compatibility table" (page 133).

® When the window notifying the changed
setting items is displayed, click [Yes].
]

The sctting will be changed for the following itom. Do you want o continue?

Printer lem Present sei Hew
CBAI[192162.0.. Synchrore wat.. Mot Synchronze  Syncheonze
CRA192168.0.. Dowmloadenrol.. Invalidity Effsctve

N |

® When the window notifying that
the setting changes are complete is
displayed, click [Close].

® When the [Login name/Group name
which synchronizes with Active Directory]
is displayed, configure the Active
Directory settings. For details, see page
104.

Creating an IC card
compatibility table

The IC card compatibility table is created
based on Active Directory user information
that has already been registered.

@ Start the server software.

@ Click [Policy] menu > [User Registration
on Active Directory].

File Printer Log | Palicy Option Help

..
[#-Log

Edit Palicy. ..

Delete all Palicy. ..

Enable Policy...

Disable Palicy...

User Reqistration on Active Directory. ..

® Click [Export Users].

2 x|

[Mowe [ dobAccount D | LognNeme/Gioupt [ Priveshi I
Unuegisiaied [0 0 Othed ogniiames Cidl [EAFTE] S
o 125 rous
sty 12344 mursta
saly 1541 eso
sumbi 12343 sumuki
Lk ahashs V&2 \akshsh

@ Check the [Create card table] check box,
and click [Browse].

oot s T

i~ Uszer auto folder
™ Tor Client reference

Bratse I

¥ Create card table

i~ Card table setting
Lard table auto exporting tolder

IC:\Plogam FiscADkidat=\Print Job Accourting

Gl e Editcard table... |

— Mnkifying administratne of failire in sending card tahle o pringee
[~ Display a message at startup of this utilty

™ Motify administrator by e-mail

Ok | LCancel

@ Select the folder that you want to save,
and click [OK].
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@ Click [OK] in the [Export Users] window.
21

— User auto exporting folder
™ Tor Client reference

Bt I

¥ Create card table

i~ Card table setting
Lard table auto exporting tolder

IC:\Plogam FlacAOkidat=\Print Job Accourting

Gl b Editcard table... | Browse.. |

— Mnkifying administratne of failure in sending card tahle o pringee
[ Display a message at startup of this utilty

I™ Motify administrator by e-mail

LCancel

@ When a window inquiring whether or not

to send the IC card compatibility table
to the printer is displayed, click [Yes] to
send the table, or [No] not to send the
table.

When [Create card table] is checked, the

IC card compatibility table is updated
when Active Directory users are added,
deleted, or when settings are changed.

Adding IC card information
to the IC card compatibility
table

The following methods can be used to add
IC card information (card ID) to the IC
card compatibility table.

e Obtain from the Active Directory

— The IC card information obtained when a user
is added to the Active Directory can be added
to the IC card compatibility table. For details
on obtaining IC card information from the
Active Directory, see "Specifying attributes for
obtaining IC card information" (page 111).

e Using the Card Enroll Tool

— When using the Card Enroll Tool, the IC card
reader attached to the computer in which the
server software is installed is used to read
data from an IC card, which is then added to
the IC card compatibility table. The IC card ID
can also be added manually. Follow the steps
below to use the Card Enroll Tool.

@ Install the Card Enroll Tool on the same
computer in which the server software is
installed.

® To enter the IC card ID manually, proceed
to step @. To enter the IC card ID from
the IC card, attach an IC card reader
to the computer in which the server
software is installed.

@ start the server software.

O Click [Policy] menu > [User Registration
on Active Directory].

Eile Printer Log | Palicy Option Help
Edit Policy...
Delete All Palicy. ..
Enable Policy. ..
Disable Palicy. ..

User Reqgiskration on Active Directory..,
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@ cClick [Export Users].

© The Card Enroll Tool starts. The record list
g e/ Leoip e which synchronizes with Active Difectory 20x| of the IC card compatibility table created
e e — by the server software is displayed in the
I;I:-aﬁnluadlﬂ m‘g SLTW 41 1% 1603 B WindOW
muata 12384 murata .
salo 12341 sso
e B [ i e s
TEHZ \akshssin Settirglil)  Helpdt)
Ecit Ervolix] Card Table
=
Ho. [togen o [cado [em |
[« o 12345
[= ] murata 12344
as ate 131
O« b 12343
as takahashi 122
Al I
_’I Lo%ﬁ{.‘:..
| w | _||
_ow® |
‘COOparate mode
@ Check the [Create card table] check box,
and click [Browse].
[ ] @ To add an IC card ID manually, double-
: -
ppase] 21 click the IC card ID field so the ID can be
— User auto ating folder .
W e e entered. In this state, enter the IC card
[ ID using the keyboard.
B | CET
Ecit Ervolix] Card Table
-
A ra‘ Jgn [cxd I;‘m I
Lard table auto exporting tolder oz murata 12344
IC:\ngamFles\Dkida!a\PlidJobAccomhhg Ef :Z?.. 1@
3 takahashi =2M2
Gl Editcard table... |
— Mnkifying administratne of failire in sending card tahle o pringee
[~ Display a message at startup of this utilty
™ Motify administrator by e-mail
0Fk. | Cancel I
When entering the IC card ID from the
@ Select the folder that you want to save, IC card, check the IC card ID recorder
and click [OK]. check mark, and place the IC card over
. . the IC card reader. The IC card ID is
O Click [Edit card table]. _ .
automatically entered into the checked
2l
recorder.
— User auto ating folder
™ For Client reference _ x
I Ecit Ervolix] Card Table
Birnwer I ™ Salect 2l
Ho. Togen o [cxdo [em |
[= (=] 1245
[=F] murata 12344
IV Cieate card table e 2
 Card tabie satting as takahahi 12342
Lard table auto exporting tolder
IC:\ngamFles\Dkidala\P'
Gl B Browse.. |
— Mnkifying administratne of failure in sending card tahle o prinkee
[~ Display a message at startup of this utilty
™ Motify administrator by e-mail
aF. | Cancel |
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® Click [Send].
R

Setielfl)  Helpit)

Edit Ervolie] Card Table
I salect 1

Wo  [lognin [cadm [em I

a: oue O102020405067805 12345

[=F] mirata 0102030405067604 12344

gz ato [lie e 1341

=R} aunda OIOZIAA0S06TENS 12343

as takshahi O10200405067802 12342

|

® When the window confirming whether to
send the IC card compatibility table is

displayed, click [YES].

® The updated IC card compatibility table is
saved, and the IC card compatibility table

is registered t o the printer.

(Note!) The IC card compatibility table cannot
be registered to a printer whose IC
card compatibility table registration
settings are not enabled. For details on
how to enable the IC card compatibility

table registration settings, see

"Setting the printer to which the IC
card compatibility table is registered"

(page 131).

The Card Enroll Tool can be installed in
a different computer to that in which
the server software is installed, and the
IC card ID can be added to the IC card
compatibility table created by the server

software.

For details on adding IC card IDs to the
IC card compatibility table created with
the server software from a Card Enroll
Tool installed on a different computer,
see the User's Manual from the IC card

authentication kit.

When adding IC card IDs to the IC card
compatibility table created with the
server software from a Card Enroll Tool
installed on a different computer, the
following settings are required on the
computer in which the server software

is installed.

(1 Set the folder in which the IC card
compatibility table exists as a shared
folder, and set the access permissions
to allow changes from the computer
on which Card Enroll Tool is installed.

(@ Check that the [Remote Registry]
service is started. When the [Remote
Registry] service is started, the [Con-
trol Panel] > [Administrative Tools]>
[Services] > [Remote Registry] sta-
tus is displayed as [Started]. If it is
not displayed as [Started], [Start] is
displayed on the left side. Click it to
start the [Remote Registry] service.

&
i
:
E
d "'"""""'"'g""'"""""" §
E
7
£

Extendnd A Standard
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Registering the IC card
compatibility table to the
printer

The created IC card compatibility table can
be manually registered to the printer.

@ Start the server software.

@ Click [Policy] menu > [User Registration
on Active Directory].

File Printer Log ,Wi_cy Option  Help
Edit Palicy. ..
Delete All Policy...
Enable Policy. ..
Disable Palicy...
User Reqistration on Active Directory. ..

® Click [Export Users].

2 x|

[Mowe [ dobAccourt D] LognNeme/Gioupt [ Prevesh I
Unusgistarad D 0 Othed agiriamas [==1] 19216803 s
nous 1245 roue

muaty 12344 murata

saly 12541 o

ki 12343 supuki

[ 122 lakashstn

@ Check the [Create card table] check box,
and click [Browse].
2l

— User auto expotting folder
™ Tor Client reference

¥ Create card table

i~ Card table setting
Lard table auto exporting tolder

IC:\Plogam FiscADkidat=\Print Job Accourting

Birnwer I

Gl e Editcard table... |

— Mnkifying administratne of failire in sending card tahle o pringee
[~ Display a message at startup of this utilty

™ Motify administrator by e-mail

Ok | LCancel

@ Select the folder that you want to save,
and click [OK].

@ Click [Send card table].
2]

— User auto exporting folder
™ Tor Client reference

Brawse I

¥ Create card table

i~ Card table setting
Lard table auto exporting tolder

2\Print Job Accounting

— Mnkifying administratne of failure in sending card tahle Bnpringee
I Display a message at startup of this utilty

[™ Motify administrator by e-mail

Ok | LCancel

@ When the window confirming whether to
register the IC card compatibility table is
displayed, click [YES].

@® When the window notifying that sending
is completed is displayed, click [Close].
£

The bansmission processing of card table was completed.

Prirtes Name. [ Resu [ Detad [
CB1921620.3) Succseded

o=

When automatically updating registered
Active Directory users, the updated IC
card compatibility table is automatically
registered in the printer. For details

on automatically updating registered
Active Directory users, see “Setting the
automatic update service” (page 141).

(Note!) The IC card compatibility table cannot
be registered to a printer whose IC
card compatibility table registration
settings are not enabled. For details on
how to enable the IC card compatibility
table registration settings, see
"Setting the printer to which the IC
card compatibility table is registered"
(page 131).
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Displaying error messages at
server software startup

If the IC card compatibility table cannot be
registered to the printer, an error message
can be displayed at server software startup
to notify you of the error.

@ Start the server software.

® Click [Policy] menu > [User Registration
on Active Directory].

Eile Printer Log | Palicy Option Help
Edit Policy. ..
Delete All Palicy...
Enable Policy...
Disable Palicy...

User Registration on Active Direckary. ..

® Click [Export Users].

1 agin name/Lroup name which synchronizes with Active Directony 3 x|
Login name/Group nome: Pyninr

[Mowe [ dobaccount 0] LognNeme/Gioupt [ Privesh I

Uningisiered | 0 Othad ogniiamas a4l 152 1603 E]

[T 145 e

munats 12344 murata

salo 1ZH1 e

sumhi 12343 sk

takshashi 12342 \skshaiin

O Check the [Display a message at startup
of this utility] check box.

CETTEES— 2l
~User auto ating folder

I Tor Client reference

Bt I

¥ Create card table

i~ Card table setting
Lard table auto exporting tolder

|&\ngam FacAOkidat=\Print Job Accourting

Gl b Editcard table... | Browse.. |

I Matify administrator by e-mail

s |

@ Click [OK].
2%

— Uszer auto folder
™ Tor Client reference

Brawse I

¥ Create card table

i~ Card table setting
Lard table auto exporting tolder

|&\ngam FacAOkidat=\Print Job Accourting

Send cardtable Editcard table... | Browse.. |

— Mnkifying administratne of failire in sending card tahle o pringee
[V Display a message at startup of this utiity
I Matify administrator by e-mail
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Sending an error notification
mail to the administrator

If the IC card compatibility table cannot
be registered to the printer, a mail that
contains the error details can be sent once
a day to the administrator.

@ Start the server software.

® Click [Policy] menu > [User Registration
on Active Directory].

Eile Printer Log | Policy Option Help
Edit Policy...
Delete All Paolicy...
Enable Policy. ..
Disable Palicy...

User Registration on Active Direckary. ..

® Click [Export Users].

1 agin name/Lroup name which synchronizes with Active Directony 2lx|
Login name/Group nome: Pyninr
Uniegisteied I 0 Othedoginhinmes [F7]) 192 16803 E]]
o 125 roue
sty 12344 murata
saly 121 eso
uruki 12343 sumki
Lk ahashs 122 lakashstn

|
oy |
O Check the [Notify administrator by
e-mail] check box.
2l

~ Uszer auto invg folder
I Tor Client reference

Birnwer I

¥ Create card table

i~ Card table setting
Lard table auto exporting tolder

|&\ngam FacAOkidat=\Print Job Accourting

Gl b Editcard table... | Browse.. |

— Mnkifying administratne of failure in sending card tahle o prinkee
[~ Display a message at startup of this utilty
[ Matify administrator by e-mait

@ Click [OK].
2]

i~ Uszer auto folder
™ Tor Client reference

Brawse I

¥ Create card table

i~ Card table setting
Lard table auto exporting tolder

IC:\Plogam FacAOkidat=\Print Job Accourting

Gl b Editcard table... | Browse.. |

i~ Mnkifying administratne of failure in sending card tahle Bnpringee
[~ Display a message at startup of this utilty

[V Motify administrator by e-mail

LCancel

(Note!) The outgoing mail server, sender's
e-mail address, and administrator's
e-mail address need to be configured in
advance according to the "Setting the
outgoing mail function" (page 224).

- 139 -




6. Syncing with Active Directory User Information

Permitting alternative
authentication to IC cards

The settings for the IC card alternative
authentication mode of the printer can be
configured.

@ Check that the printer power is ON.
@ start the server software.

@ Double-click [Printer] in the selection
window. The registered printer list is
displayed in the details window.

™ Print Job Accounting Enterprise

File Printer Log Policy Option Help

3
- Log

O sclect the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.

t__';'_, Print Job Accounting Enterprise
File Log Policy Option Help

=-F  Add aPrinter...
Manage multiple printers as a group...
Delete a Printer Printer Group

G- Change a Printer Group. ..

Start/End Log

Acquire a Log

Setting Ehe Time

Define Fees...

Backup of printer setting...
Properties...

@ Click the [Option] tab > [Detail setting].
a1

Printerl User  Option |

Acquie Logs
& |nteryval
I? Hour IU Mintes
 Time
Lhange Time... |
Fees Cad41/0831/0822 j
Define fees... |
DOperation at Log Full IDeIete old logs j
Auta Export Logs IDo ot automatically export j
I™ | Becord logs in & database
Click [Detall setting] ta cooperate with
Active Directory.

ok | set |

@ Check the [Synchronize user list with
Active Directory] check box.
oetalsatung 2 x]

fF{’_ i Tiet vikh Aicirve Diveclory I
~ Policy based printing
1~ User iz idantified by Job Account 10
Chent solftware: has o be matalled on cach wers FL.
& Usar is entified by PC Login name / card
Chent sofbware is not necessan.

™ Download erecled card bable bo a pinter

I Al altzmative autfienticatian for card

TS | Cancel

@ To enable the IC card alternative
authentication mode, check the [Allow
alternative authentication for card] check
box. To disable the IC card alternative
authentication mode, uncheck the [Allow
alternative authentication for card] check
box.
oetailseung 2l x]

[¥ Synchronize user list with Active Directory

B pinting
™ User iz idantified by Job Account 1D

Chent soltware: has to be matalled on cach wiers FL.
& User s identified by PC Login name / card

Chent soltwase is not necassary.

I” Download creclied card table bo a prirker
[TF {Bllow atemalive authenbicabon for card

| o, | Cancel
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@ Click [OK].
petaisetung 2=

[# Syrchronize user liet with Acthve Directony

Pokcy basedi i
© Usar is idaniifiad by Job Account ID

Lhent software has to be natalled on cach wser's FL.
1% User is identified by PC Login name / caed

Chient software is not necessan.

I” Download erecled card table bo a prirker
I¥ Allow altemative: authertication for card

o) e |

© Click the [Option] tab > [OK].
Properties of printer from which loes are acquire 21x]

Printerl Uzer  Optian |

Acquire Logs
& |nterval
7 Hour ID Minutes
= Time
Lhange Time... |
Fees Co41/C831/0822 j
Define fees... |
Operation at Log Full IDeIete old lags j
Auto Expart Logs IDo ot autormatically export j
I~ | Becord|logs in & database
Click [Detail zetting] to cooperate with Detail setting... |
Active Directory. E

et |

@ when the window notifying the changed
setting items is displayed, click [Yes].

® When the window notifying that
the setting changes are complete is
displayed, click [Close].

Setting the automatic
update service

The Active Directory user information can
be periodically monitored, and changes
to registered user or group information
can be updated. Monitoring in order to
automatically update registered users or
groups is set to enabled by default, but
settings such as the monitoring schedule
settings, and which users and groups are
target for monitoring can be changed.

(Note!) When a new user that belongs to a
group that is target for monitoring in
the Active Directory is added, users can
be registered to the printer until the
maximum number of users that can
be registered to the printer is reached.
After the maximum number of users
that can be registered is reached,
subsequent users are not registered to
the printer.

@ Start the server software.

@ Click [Policy] menu > [User Registration
on Active Directory].

File Printer Log ,Wi_cv Option  Help
- Edit Palicy. ..
- Log Delete all Paolicy. ..
Enable Policy...
Disable Palicy...

User Reqistration on Active Directory. ..

© Click [Setup].

1Lngin name/Lieoup name which synchronizes with Active Directory 2 x|
Lingin name/Group raese Pyinier
I i N 1] irkes M Ti o
ke Section Sals Section Na | 7 19216300 Poicy Apphed 5001
0
inoue: 1235 incue
masls TZHA inasta
saln 12341 sabo
ki 143 wauk
tabahashi 12342 takahashi
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O Click [Set Up Refresh Service] in the
[Active Directory User/Group Settings].

Active Directory User/Group Settings i = ]Dlﬂ

Accounts for Which Use Restrictions Have Been Configured

| User MamejGroup M... |T!Ee |Di§EzNane |E—mderHsA
Sales Scction Mo. 1 Group Sales Scction M.
inoue Priority Lser inoue
murdla Priurily User murala
saho Priority Lser sako
suzukl Frority User suzukl =
Lo oo Colt oz
il I o

Aud... I G e REive I

Use Restriction [ -
Printing
Color Printing
Cnying
Color Copying

USE Memory bo Print

UISB Memory to Color Print
Scan ko Email

Sian ko Metwork PC

SLani Lo USE Memory

Fax Sending

SCan to Internet Fax

Scan to Fax Server

Motities botal result by e-mail

Nur‘tﬁes b e-mail when Limik Values was exceeded _ILI
4 I E
Fefresh hiow | End I

@ Set the automatic update timing.

~lalx
At refrech
2
Omomli days | 12 didock
 speafy Interval (3U~1440 minutes)
| minutes
GroupsjUsers Monkored
User [ i} [RefreshDate o.... |
[A sales Section Mo.1 Group 1/6/2012 1:53 AM
inoue Pricwity Llser 1242612011 3:0....
& murata Priority Liser 12f26/2011 3:0...
M sato Pricrity User 12f26{2011 3:0...
B sunbi Pricrity User 12{26/2011 3:0...
[A takshachi Priceity User 12f26/2011 3:0...
o | _coma |
Specify Time

Automatic update can be performed at a set time.

This can be set in day units.
Specify Interval

The automatic update interval can be set in
minute units.

@ set the user/group to monitor for
updates.

@ Check the users/groups to monitor for
updates on the Active Directory. When a
group is checked, the users that belong
to the group are also monitored.

ol
At refrech
& Spedly Tnw (1365 days)
Once every [ 1 days [T12 odock
 Speafy Interval (30~1440 minutes)
| minutes
GroupsjUsers Moniored
User N [T [RefreshDateo.... |
[A sales Section Mo.1 Group 1/6/2012 1:53 AM
innne Pricwity Llser 12f26{2011 3:0.._.
M murata Priority User 1226/2011 3:0...
sato Pricrity User 12f26{2011 3:0...
B suzki Pricrity User 12{26/2011 2:0...
[ takshachi Pricrity User 12f26/2011 3:0...
® click [OK].
Set Up Retresh Service I = |Q]_>_<j
~ fuwsto refrech
& Spedly Taw (1365 days)
Once every | 1 days | 12 didock
" Speafy Interval (30~1440 minutes)
| minutes
GroupsjUsers Monkored
User o i} [ Refreshpateo... |
[A sales Section Mo.1 Group 1/6/2012 1:53 AM
inoue Pricwity Llser 1242612011 3:0....
[ murata Priority Liser 12f26/2011 3:0...
M sato Pricrity User 12f26{2011 3:0...
B suznki Pricrity User 12{26/2011 3:0...
[A takshachi Pricrity User 12f26/2011 3:0...
(e Cancel |
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Immediately updating user
settings

Updates can be performed immediately as
well as those performed at the automatic
update timing set in the [Set Up Refresh
Service] window.

@ Start the server software.

® Click [Policy] menu > [User Registration
on Active Directory].

Eile Printer Log | Policy Option Help
Edit Policy...
Delete All Paolicy...
Enable Policy. ..
Disable Palicy...

User Registration on Active Direckary. ..

® Click [Setup].

1 agin name/Lrnap name which synchranizes with Active Directory 1 2 x|

[Nome [ Jobccount 0] LognHame/Giouph [ Prites 1

Sles Saction o Sl Saction M 1 (=) 132 1EA00 Pokcy Appled 5001

inour. 1245 ioue

[TTTY 12344 mursta

aaln. 12341 sabe

sk 14343

tabahashi 12342 takahashi

i | bt 1| | |
[ - [ B | ww |

5 ST — |

O Click [Refresh Now] in [Active Directory
User/Group Settings].

Active Directory User/Group Settings = |E||5|
Accounts for Which Use Restrictions Have Been Configured

User hame/Group M... | Type I Displary Mame | E-mail Addres: =

Sales Scction Mo. 1 Group Sales Sccbion M...

inoue Priority Liser inoue

nurdla Priurily User murala

saho Priority Lser sako

suzukl Frority User suzukl =

Lol s e Colot o oLs

il I _>lJ
... I G P I Reiiuve I

Use Restriction [ -

Printing

Color Printing

Cnying

Color Copying

USE Memory bo Print

UISB Memory to Color Print

Scan ko Email

Sican ko Metwork PC

Sian Lu USE Meory

Fax Sending

SCan to Inkernet Fax

Scan to Fax Server

Motities botal result by e-mail

‘Nuf‘tﬁes b e-mail when Limik Values was exceeded

Set Up Refresh Service...

L off
Bd |

Selecting the

users to

apply settings to

Click [Apply] in the [Login name/Group
name which synchronizes with Active
Directory] window and the users/groups to
registered to the printer can be selected.

@ select the printer from the printer list
in the [Login name/Group name which
synchronizes with Active Directory]

window.

1 0gin nameroup name which synchranizes with Active Disectory E 2] x|

L — |

¥ Autn Avsign Job Account 10 Astign I
Evpent Ueses...

L — |
I
Sedect et |

@ Click [Select user].

1 agin name/Lroup name which synchronizes with Active Directory 3 2 x|
Logn rame/Group nome Ppininr
1 i, b [Priven. Ti
Sas Sachon Sblat Section Mo 1 1 150 Appled
inoue: 1235 incue
inasls TZH4 inasta
aaln 12341 w0
s 154G wauka
tabuahashi 12382 takahashi
Kl ] Ra——1] |
sop. | - sy |
FF e Assign Job Accout 1D s |
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@ Check the users/groups to register in
the printer in the [Select user which is
registered] window.

Select user which is registered

The user or group which is regi 1 o the printer iz sek |

Flease remove the check of the user or aroup which is not reqistered.
MHame Job Account 1D in Mame/ G Mame | Mumber
Sales Section Mo.1 Sales Section Mo.1 o
inaue 12345  inoue 1
murata 12344  wata 1
salo 12341 sato 1
suzuki 12343 suzuki 1
takahashi 12342 takahashi 1
J | B

I

O Click [OK].

Select user which is registered

The user or group which is regi 1 o the printer iz sek
Flease remove the check of the user or aroup which is not reqistered.

M ame Job Account I jin Mame/ & Mame | Mumber
Sales Section Mo.1 Sales Section Mo.1 o
inaue 12345  inoue 1
murata 12344  wata 1
sato 12341 sao 1
suzuki 12343 suzuki 1
takahashi 12342 takahashi 1

1 | i

(Note!) Users that belong to groups are not
displayed in the [Select user which is
registered] window.
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database

Configuring the database software settings
Settings for connecting to the database

Setting the printer for recording managed data
to the database

Exporting the fees to the database
Deleting fees from the database

Exporting the log to the database

Deleting logs from the database

Exporting the printer users to the database
Registering database connection users

Changing the permissions for database
connection users

Changing the password for database
connection users

Deleting database connection users
Updating the database to the newest version

Displaying error messages at server software
startup

Sending an error notification mail to the
administrator

Creating a website [Microsoft Windows 8.1]

Creating a website [Microsoft Windows
Server 2012 R2]

Creating a website [Microsoft Windows 8]

Creating a website [Microsoft Windows
Server 2012]

Creating a website [Microsoft Windows 7]

Creating a website [Microsoft Windows
Server 2008]

Creating a website [Microsoft Windows Vista]

Creating a website [Microsoft Windows
Server 2003]




7. Saving managed data to the database

7. Saving managed data to the database

This section explains how to export the log, Job Account ID, and fee charge definition to
the database, and how to browse the log, Job Account ID, and fee charge definition from a
web browser. The log can be exported to the database from the point at which it is obtained
from the printer. The Job Account ID can be exported to the database at the point when it
is registered to or deleted form the printer, or when the settings are changed. To export the
managed information to the database, the following settings need to be configured.

= Database software settings (page 146)

e Settings for connecting to the database (page 147)

In order to export the managed log and Job Account ID information to the database, the
following settings also need to be configured in addition to the settings listed above.

= Settings for recording information to the database of the printer that you want to export
managed information to must be enabled (page 148)

Configuring the database
software settings

Connecting to MySQL
Database

When using MySQL on a different computer
that contains the server software, libmysql.
dll needs to exist in the server software
installation folder.

(1) Copy libmysql.dll from the "bin" folder or
"lib" folder of the installation folder of the
MySQL installation to be used.

@ Paste the file into the installation folder of
the server software.
Depending on the MySQL version, the
administrator "root" permissions may not
be sufficient. In this case, increase the
permission level.

@ start [MySQL Server Instance Config
Wizard] and check the [Include Bin
Directory in Windows PATH] check box to
complete the settings.

O start the command prompt in Windows
Os.

@ Execute the following command.
Mysql —u root —p

@ Enter the administrator "root” password
that was set when MySQL was installed.

@ Execute the following command.
grant all privileges on *.* to
"root"@"%" with grant option;
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Settings for connecting to
the database

@ sStart the server software.

@ Click the [Option] menu > [Setup].

;_!;-; Print Job Accounting Enterprise
File Printer Log  Palicy | option  Help
[+ Printer

@ Display the [Database] tab.

2| x|
| Lo Storage | Change the cloring dfte (D863 foss |

Mad et | E-mal Addbess |
™ Recod loge in databass

Dot sbanea [Microrolt SOL Server =
B [Wiredionrs autiveniication =
hevesy JLocal dalabare T=|

Server Name |

]’:rmrn 1hckminiahator

o] o |

O Check the [Record logs in database]

check box.
Feton 2ix|
Database |Miciosolt SOL Serves =
uthanheation [Wirndows authveniication =]
Ageers [Local dotabare |
erves Nar ]
Lser Naene: 1srmrrm\m-inum
Basswed |
I Accassing datsbase fiom webiite
Tila deglayed on v {i';.ﬂ.lma.-r--.y.u..—gln:nm-»lm:mn:p
Wik to detebese e | P User |
Update the databass tobe | Ditabise uses regshaton |
;NMMWofmahmhgwm
I Display & message of tartup of this uilly
I Moty administystor by emad
I -

(Note!) If [Record logs in database] is disabled,
it is not possible to connect to the
database.

(5) Configure the settings for the database to
connect to.

Database

Select the type of database to connect to. The
types of database that can be selected are
Microsoft SQL Server, Microsoft SQL Server
Express Edition, Microsoft Access and MySQL.

Authentication
Select the authentication method used when
connecting to the database.
Windows authentication
Authenticated connection using the Windows
user permission registered in the database.

This can only be selected in Microsoft SQL
Server or Microsoft SQL Server Express Edition.

User authentication

Authenticated connection using the user
permission for User authentication registered in
the database.

Access

Specify whether the connected database is a
location connection or network connection.
Local database
Connect to a database that exists on this
computer.
Network database

Connect to a database that exists on a different
computer on this network.

Server Name

Specify the IP address or computer name of
the computer on which the database exists. A
maximum of 270 can be entered.

Path Name

Specify the path name where the database to
connect to exists. A maximum of 270 can be
entered. This can only be entered when Microsoft
Access is used.
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User Name

Specify the user name of the database to
connect to. A maximum of 80 can be entered.
When Windows authentication is selected for

[Authentication], specify a valid Windows account
that can connect to the database using Windows

authentication from the obtain log service. For
example, the computer administrator.

Password

Specify the password of the database to
connect to. A maximum of 80 can be entered.
When Windows authentication is selected for
[Authentication], specify the password for the
Windows account name.

0 Click [OK]. Connect to the set database,

and the settings are complete when the

connection is successfully established.

2ix|

Mai setup | E-mad Addsess | Mad detad setup | Log Storags | Change the closing date Datebase | Posts |
V Rgeord logt in database

Database [Microsoh SOL Sevver =l
Authenhcation [Usen ntbrerticaion =l
Agoess [Netwerk detabase |
Server Name B
Lsar Name: juml

Basswced |

I~ Accessing datsbase fiom webiits

Titla cheplaved on websre

]s'..ﬂ Jdoh Accounting Erterpise Datahate

Wils lo delabere Eev. | P User |

Update the databoss tope | Ditabase uses regshaton |

i~ Motitying adminiztiator of fsiue in sioing log to databare
T Display a mevsage o statup of this uily
I Moty sdministystor by emal

Setting the printer for
recording managed data
to the database

@ Check that the printer power is ON.
@ start the server software.

@ Double-click [Printer] in the selection
window. The registered printer list is
displayed in the details window.

™ Print Job Accounting Enterprise
File Printer Log Policy Option Help

= T
[+-Log

O sclect the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.

L_';.'_, Print Job Accounting Enterprise
File Log Policy Option Help

=-F  Add aPrinter...

Manage multiple printers as a group...
Delete a Printer Printer Group

-1 Change a Printer Group...

Start/End Log

Acquire a Log

Sething the Time

Define Fees...

Backup of printer setting...
Properties...
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@ Check the [Option] tab > [Record logs in @ When the window notifying the changed
a database] check box. setting items is displayed, click [Yes].
Properties of printer from which logs are acquired e 4| Properties of printer from which logs are acquired x|

Printerl Uzer  Option |
Acquire Logs
% |nterval
IU_ Hour IT Minutes Printer Item Pipsent seti Hew
CBAT(1921680.. Recordlogein., Invadly Effechve
" Time
Lhange Time... |
Fees CB41/C831/C822 j
Define fees... |
Operation at Lag Full IDeIete old logs j
Auto Export Logs IDo not automatically export j VIS ] NO |
Active Directory, i ml . . ..
: @ A window inquiring whether or not to
export the database to the Job Account

o | ety | ID registered in the printer is displayed.
Click [YES] to immediately export the
(Note!) If the settings for connecting to database. Click [NO] to not export the

a database (page 147) are not database.

implemented, [Record logs in a
database] is grayed out.

© Wwhen the window notifying that
the setting changes are complete is

@ Click [OK]. displayed, click [Close].

Properties of printer from which logs are acquired e B

Printer' Uzer  Option |

Acquire Logs
& |nterval
o Hour IW Minutes
= Time

Lhange Time... |

Fees C841/0831/C822 j

Define fees... |

Operation at Log Full IDeIete old lags j

Auta Expart Logs IDo hot automatically expart j

¥ Record logs in a database

Click [Detail zetting] to cooperate with Detail setting... |
Active Directory. E

i)
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Exporting the fees to the
database

The managed fee definitions are exported
to the database.

0 Start the server software.

@ Click the [Option] menu > [Setup].

% Print Job Accounting Enterprise

-- Prinkter
- Log

@ Display the [Database] tab.

O Check the [Record logs in database]
check box.

(5) Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 147).

@ cClick [Fee]. Connect to the set database,
and when the connection is successfully
established the fee export window is

displayed.
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@ Select the fee charges from [Fee], and Deleting fees from the
click [Add]. d b
2ix] atabase
Delete the fee definitions from the
[atabaze's fees
database.

[Delete |
@ Start the server software.

@ Click the [Option] menu > [Setup].

f;; Print Job Accounting Enterprise

File Printer Log P-:uli_n:';.-'|g|:|ti|:|n Help

-- Printer
Fees .. Lag

ES8140 =]
B720/E720/B710
MCEE1 MRS .
T © Display the [Database] tab.
Ca41/C831 i
ES8441/E58431 Matvwea| KAl e e |
MB4E1ME471MBEATT S
ES4161 MFP/ES4191 MFP - B
s I I K -:le'aba'.f: [Microzit SOL Serven =
Badhentication [Wirrdows autiveriication =
Exit | e [Cocal deteboare =]
Serve: Name r
(gt Hame W
(Note!) e Fees that already exist in the database |
are overwritten. I Accessing dhininee oy Bt
¢ Single quotation marks that exist in Tits dislayed on et et Aezenring Ertepren Dot
the character string are replaced with Wil Nt Eee. | [ iU |
space characters, and the information Upcte e debobnse bt || Detoinse warecegutntion |
IS saved In the database. :’No-i“ el administaton of fafire in #torng log to databars:
I Ditpley & reveage & statup of s oy
r '|'.‘.'\l erarstralor, L") e
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O Check the [Record logs in database] @ Sclect the fee charges from [Database's
check box. fees], and click [Delete].

Export Fees

==

3000
C7000
CE100
C5300
B4300/84200
C5200
C5400
B4350/B84250

(5) Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 147).

@ cClick [Fee]. Connect to the set database,
and when the connection is successfully
established the fee export window is
displayed.

Export Fees

CE41/C831

3000
7000
CH100
CH200
B4300/84200
CH200
CH400
B4350/B4250
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Exporting the log to the
database

The obtained log is written to the
database. In order to change the log items
written to the database, see "Changing the
log items to be exported" (page 212).

0 Start the server software.

@ Click the plus mark on the left side of
[Log] in the selected window. The log
tree opens.

™ Print Job Accounting Enterprise
File Printer Log Policy Option Help

[+~ Printer

I:T%Lng

® Using the same operation as step 2, open
the tree for [Printer] or [Date].

t__‘;’_, Print Job Accounting Enterprise

File Printer Log Policy Option Help

[#- Printer

El--Log

- Date

- 201008

) ] Group({Sales Department)
- C841(192.168.0.3)

_ L. MC561(192.168.0.2)

=1 2010/09

=8 Group(5ales Department)

- C841(192.168.0.3)
L. MC561(192. 168.0.2)

= Printer
El- Group(Sales Department)

O sclect the log to export, and select the
[Log] menu > [Export logs into the
database].

r_!;', Print Job Accounting Enterprise
File Printer | Log Policy ©ption  Help

[+ Printer Cisplay Logs

= Lag Display Tokal L4
=l Date Export Logs
L s 2[: Export Tokal 4
j Delete the log
=l Prinke Display Details k

ElC Display/Export [kem Settings  #

Export logs inko the database k
Delete logs from the database
Refresh Display

(Note!) ¢ Single quotation marks that exist in
the character string are replaced with
space characters, and the information
is saved in the database.

¢ Logs of printers whose database
recording settings are disabled are
not exported. For details on enabling
the database recording settings, see
"Setting the printer for recording
managed data to the database"
(page 148).
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De|eting |Ogs from the O select the log that you want to delete
from [List of logged months and years].
database 21
Delete a log from the database. List of panters being logged List ot logged moniths and years
CB41[192.168.10.3) 2012/m

0 Start the server software.

@ Click the [Log] menu > [Delete logs from
the database].

g.'_, Print Job Accounting Enterprise 00 s | By manth and year

Eil=  Printer | Log Policy Option  Help

Ll ol bl alegsee-fougued murthe:

[#- Printer Display Logs _—
[#-Log [jsplay: Total ¢ —
Exporh Logs
Expath Tiatal ¥
[elete thelog
Display Details »
Display/Export Ikem Setkings #
Expatt [mgs inta e database
Celete logs from the database h
Refresh Display
@ cClick [Delete].
® Display the database logs using either e 4
the [By printer] or [By month and year] - L A
method CRAT[192.168.0.3) 201201
21|
List of pinters being logged List of logged months and years
CRAI[192.168.0.3) 201201
Dy prinker | By month and year |
Ll ol bl alegsee-fougued murthe:
Piintes Mame | Date I I_Q?lehe__i
LHA 191583 Anzan
Ll ol bl alegses-fouguend murthe:
Printer M | Dat | D]
wﬂus;t:au.;u zua131u1 _—Etel
Exit |
Exit |

By printer

Just the logged month and year of the printer
selected in [List of printers being logged] are
drawn from the database and displayed.

By month and year

Just the logged months and years selected in
[List of database-logged months and years] are
drawn from the database and displayed.
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Exporting the printer O Check the [Record logs in database]
check box.

users to the database

The managed Job Account IDs are
exported to the database.

0 Start the server software.

@ Click the [Option] menu > [Setup].

% Print Job Accounting Enterprise

-- Prinkter
- Log

@ Display the [Database] tab.

(5) Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 147).

0 Click [Printer User].
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@ When connection to the set database
is successfully established, a message
confirming whether or not to export
the Job Account ID to the database is
displayed. Click [YES].

(Note!) ¢ Job Account IDs that already exist in

the database are overwritten.

¢ Job Account IDs of printers whose
database recording settings are
disabled are not exported. For details
on enabling the database recording
settings, see "Setting the printer
for recording managed data to the
database" (page 148).

¢ Single quotation marks that exist in
the character string are replaced with
space characters, and the information
is saved in the database.

Registering database
connection users

Register database connection users.
@ Start the server software.

@ Click the [Option] menu > [Setup].

:__';',. Print Job Accounting Enterprise
File Printer Log Palicy | Opkion  Help

-- Prinker
[+-Lag

@ Display the [Database] tab.

| Change the chosing i

D atabase: [Microzit SOL Serven =
Badhentication [Wirrdows autiveriication =
Aprers JLocal databare T=|
Senver Name |

(gt Hame [ErvERN A

Baswerd |

IF'mI Jdob Accounting Eriempaze Datshase

[IpARte e databinee FRi | [etabnse et epattalion |

[~ Notiying administator of fafre i #torng log bo databare
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O Check the [Record logs in database]
check box.

(5) Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 147).

@ cClick [Database user registration].
When connection to the set database
is successfully established, the [Regist
user to connect with database] window is
displayed.

@ Click [Add].

Register user to connect with database

(5) Specify the [User Name],
[Authentication], [Password], [Repeat
Password] and permissions, and click
[Add].

Add user Lo connecl with database

If the users and user names duplicate
those that are already registered in the
database, they cannot be added.
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© Click [OK].

@ When the registration results notification
window is displayed, click [Close].

@ Users registered to a Microsoft Access
database only use authentication to
browse the database from a website.

Changing the permissions
for database connection
users

Change the permissions for registered
database connection users.

ﬂ Start the server software.

@ Click the [Option] menu > [Setup].

& Print Job Accounting Enterprise

[+]- Printer Setup...

-- Log
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O Check the [Record logs in database]
check box.

(5) Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 147).

@ cClick [Database user registration].
When connection to the set database
is successfully established, the [Regist
user to connect with database] window is
displayed.

@ Select the users whose permissions you
want to change in [List of users], and
click [Change Privileges].

Register user to connect with database

| Name | Authoriy | Authertic... |

© When the permission change results
notification window is displayed, click
[Close].
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Changing the password
for database connection
users

Change the password for registered
database connection users.

0 Start the server software.

@ Click the [Option] menu > [Setup].

L_',',. Print Job Accounting Enterprise
File Printer Log Palicy | Opkion  Help

-- Prinkter
- Lag

@ Display the [Database] tab.

2ix|
Ml setup | E-mai Addbess | ol detad setup | uslwaulaamlum; [Osiabase | eas |

™ Recod loge in databass

D3:abase [Microsolt SOL Server =]
asiantication [Wirrdows autiveriication =
hevesy JLocal databare T=|
Serve Name l

Lizer Name if.rmfrnlma.ﬁ;n.-m

Bassword |

I™ Aecessing datatia pehitien

Tite displayed on webshe ]'s'ml Joh Accounting Eriepnse Databate

O Check the [Record logs in database]
check box.

M 2x|
setup | Lo $torags | Change the closing dats Database | Postz |

[Microsolt SOL Server =]
[Wirdows autheniicstion =]
Agress |Loel dalabare |
Server Name [
Lser Hame [SERVERNAdminiser
Bassweed |
I~ hccassing databass hom websie
Tita displaysd on websre i'i'mi Joh Accounting Eriepne Datshate
Wile to dslabase Fols | P s |
Update the databass tobe | Ditabise uses regshaton |

;Hﬁum&mamhwm
T Display & mevsage o statup of this uilly
I Moty sdministyator by emal

[

(5) Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 147).

@ cClick [Database user registration].
When connection to the set database is
successfully established, the [Register
user to connect with database] window is

displayed.
I 20
M setup | E | | Log Storage | Change the closing date Dslabase | Posts |

¥ Rgcord loge in databass

Database [Miciorolt SOL Serves =

fuihenheahon [Usen sutheriicsion =]

Ageess [Network detabare =]

Seever Hame B

ser Name: iﬁml

Eatsweed |

™ Bccasing databace hom mabiits

Trda deplayed on websre i’F'ml Job Accounting Entempnse Datahase

Wil to detabsse Eee... I Pipnlei Usen |
psuntrs sonssergs | [(TEEE e

T Displap & mesvage ol staitup of this ity

™ Mol sdministsstor by el
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@ Select the users whose permissions you
want to change in [List of users], and
click [Change Password].

Register user to connect with database i |
List of users
MHame I Authority | Authentic. .. |
Lzer? Fiead orly User auth... Add

Delete |

LChange Privileges... |

@ Enter the [Password] and [Repeat
Password], and click [OK].

Password | T

Fepeat | [T

CAMCEL |

Deleting database
connection users

Delete registered database connection
users.

@ Start the server software.

@ Click the [Option] menu > [Setup].

f;; Print Job Accounting Enterprise
File Printer Log Palicy | Opkion  Help
[#]- Printer

- Log @

@ Display the [Database] tab.

Mai satup | E-mai.

™ Recod loge in databass

I -:n atabase [Microzit SOL Serven =
Badhentication [Wirrdows autiveriication =
Aprers JLocal databare T=|
Senver Name |
(gt Hame [ErvERN A
Easswoed |

T~ secesting datatines from webitin

Trda deplayed on websre IF'mI Job Accounting Entempnse Database

Wwiile fo databare Esp | Priiles U |
Uipcihte fhie databinge fabis | DIAhAe (e Fagiittation |
|
[~ Notiying administator of fafre m gtonng log bo databare

= | Divpley & revsage ol st

o i Okl

r oty st eleaton e s
|
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O Check the [Record logs in database]
check box.

(5) Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 147).

@ cClick [Database user registration].
When connection to the set database
is successfully established, the [Regist
user to connect with database] window is
displayed.

@ Select the users whose permissions you
want to delete in [List of users], and click
[Delete].

Register user to connect with database

@ when a window confirming whether or
not to delete the user is displayed, click
[YES].
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Updating the database to
the newest version

If a new format of database can be used
due to an update to the server software,
the database format can be updated to the
newest version. Data that already exists in
the database is retained.

@ Start the server software.

@ Click the [Option] menu > [Setup].

t,-; Print Job Accounting Enterprise
File Printer Log Palicy | Option  Help
[#]- Prinker

- Log @

@ Display the [Database] tab.

Mail setup | E-mai Adchess | Mai detal sstup | Log Storage | Change the closing 4 bt

D3:abase [Microsolt SOL Server =]
Baanheation [Pwirndioms utenstication =
hevesy JLocal databare T=|
Senver Name l

Lizer Name 1’.rr1vrn 1\Adkminishiator

Passwerd |

T | s psting NARARS o sk

]'s';ni Joh Accounting Entepite Databae

| |

Lipciate Hie datatinge Eabile I [Ieatinse sps regutrahon I

ofited log to databare

O Check the [Record logs in database]
check box.

seton 2%

Database |Miciosolt SOL Serves |
Authenhcation [wirrdows atentications =l
Agress |Loel dalabare [ |
Serves Name ]

Lizer Hame 1$Ean|\Amiimm

Bansweed |

™ Bccasing databace fhom mabiits

Tida displayed on webshe ]s'mi Joh Accounting Eriepne Datshate

Wil to dssbsse fee. | Pimum |
Update the databass tobe | Ditabise uses regshaton |
.’Hﬂhﬂuﬁiwnwfunhmhwm
I Display & message of tartup of this uilly
I MNotily administiator by emal
(oK ] _coen |

(5) Configure the settings for the database to
connect to. For details on the settings of
the connected database, see "Settings for
connecting to the database" (page 147).

@ cClick [Update the database table]. When
the connection to the set database
is successfully established, a window
inquiring whether or not to update
the database to the newest version is
displayed. Click [YES].

Seton 2ix|
Mad setup | E | | Log Storags | Change the closing dats Database | Posts |
¥ Rgcord loge in databass

Daabase [Miciosolt SOL Serves =
Authenhcation [Usen anbrerticion |
Ageess [Netwrk debase - |
Server Name B
Lser Name: iﬁml

Basswced |

I Accessing datsbase fiom webiite

Tia cieplayed on websre

]s'mi Joh Accounting Erterpite Datahae
Eee.. | P User |
] Database uses agubahon I
~ Motifying administiator of falare in storing log to datsbace

T Display a mevsage o statup of this uily
I Moty sdministystor by emal

I = |
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O cCheck the [Record logs in database]
check box.

seton 2ix|
e k. gati setup | Log Storage | Charge the closing date Dslabase | Pogts |

Displaying error messages
at server software startup

A message can be displayed at startup if
additions to the log database fail.
|Miciosolt SOL Serves =
© start the server software. [Wadons sbenicaion |
(2] Click the [Option] menu > [Setup]. Gt l
o . . w EErrr—
fy Print Job Accounting Enterprise i .
Basawced |
Eile Prinker Log Paolicy | Opkion Help S
" PrirltEr Tila deglayed on websne i'i'mi Joh Accounting Eriepne Datshate
- Lag Wil to dssbsse fee. | Pipeus |
Update the databass tobe | Ditabise uses regshaton |
©® Display the [Database] tab. [ i
2x| ™ Moty administsalor by el
M sp | E-med Adchess | M detal s | mswmlmumq [Oors5sse | fors |
™ Recod loge in databass
-Ee'-lba'.f: - [Miciosa SOL Server = Cancel_|
Baanheation [Pwirndioms utenstication =
== oot disbens - (5] Configure the settings for the database to
Server Name I

connect to. For details on the settings of
the connected database, see "Settings for
connecting to the database" (page 147).

Lizer Name i’.rrﬁrn 1\Adkminishiator

Bassword |
T -

]'s';ni Joh Accounting Entepite Databae

()

[etabnse et epattalion |

O check the [Display a message at startup
| of this utility] check box, and click [OK].
When connection to the set database is

successfully established, the settings are

Update the dstahns bl |

e in o log o databars

kil saved.

st 2ix|

Mal setup | E | | Log Storags | Change the closing dats Database | Postz |
¥ Rgcord logs in datsbase

o ] _com | e
Database [Mictozait SOL Server |
Aufhanhcahon iUmuﬂm’ o =]
Ageess [Network detabare |
Server Name j1ms&um
Lsar Name [SERVERNAdminise
Eassweed | e
™ Accasing databace fhom mabiits
Tida cisplayed on websie ]r'mi Joh Accounting Entsrpnte Datahate
Wile to dslabase Fools | |
Update the databose tage | Ditabise uses egshaton |

I Diisplay & mersrage ol startup of this uilly
I Nolify sdministystor by emal
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Sending an error O cCheck the [Record logs in database]
-gn - - check box.
nOtlﬁcatlon mall to the N 2ix]
administrator
If additions to the log database fail, a mail P 5 sere |
that contains the error details can be sent futheckcation [rr— |
once a day to the administrator. Ao JLocal desbare |
Server Name ]
@ start the server software. serbane Err—
@ Click the [Option] menu > [Setup]. o ]
™ Bccasing databace fhom mabiits

h_f."-‘ Print Juh Accuunting Enterprise Tila deglayed on websne ]ﬁ'urﬂ.ln.'m:mnl..—qln:rrnu;—l]nl.-hmp

Eile Prinker Log Policy | Opkion Help il cunses fee. | Prmum |

B Update the databass tobe | Ditabise uses regshaton |
[~ Prinker .
" LI:lg [~ Motiing administiator of fabusin storng log to databass ———————————————
I Display & message of startup of his uilly
I Nolily dministiator by emad

(3] Display the [Database] tab.

: 20 (oK ] _coen |
M sstup | E-mad Acess | Hiad detad sstup | Loa Shorage | Change the closing offe [Daatnis | b |

™ Recod loge in databass

e R (5] Configure the settings for the database to

L::C‘Ls j connect to. For details on the settings of
e 3 the connected database, see "Settings for
o I connecting to the database" (page 147).

It N A 1’.rr1vrn 1hckminististor

O check the [Notify administrator by
Basawoed |

e-mail] check box. When connection
to the set database is successfully
established, the settings are saved.

seton 2ix|
Mad setup | E | | Lop Storags | Change the closing dats Database | Posts |
¥ Rgcord logs in databass

]'s';ni Joh Accounting Entepite Databae

Database [Microzolt SQL Serves |
Buthenheahon 1me‘ =1 ﬂ
Ageens [Network detebare |
N 15216801
Cancel I Server Name 921620100
Lsar Name [SERVERNAdmnise
Eatswed |
™ Bccassing databace fom mabiite
Tia dieplayed on webere ]F'm{ Joh Accounting Eriepnss Databate
Wike to detabere Be. | Ppmuw |
Update the datobose tabe | Distabse uses reghaton |
.’Hﬂhﬂuﬁiwa«ofunhmhwm
i this ity
¥ Nolily dminististor by emad

_ Concel |

(Note!) The outgoing mail server, sender's
e-mail address, and administrator's
e-mail address need to be configured in
advance according to the "Setting the
outgoing mail function" (page 224).
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Creating a website
[Microsoft Windows 8.1]

You can create a website on Microsoft
Windows 8 by taking the same steps as
those for creating a website using Microsoft
Windows 7 as the server software.

For the steps in creating a website

using Microsoft Windows 7 as the server
software, refer to “Creating a website
[Microsoft Windows 7]” (page 166).

Creating a website
[Microsoft Windows
Server 2012 R2]

You can create a website on Microsoft
Windows Server 2012 by taking the same
steps as those for creating a website using
Microsoft Windows Server 2008 as the
server software.

For the steps in creating a website using
Microsoft Windows Server 2008 as the
server software, refer to “Creating a
website [Microsoft Windows Server 2008]”
(page 169).

Creating a website
[Microsoft Windows 8]

You can create a website on Microsoft
Windows 8 by taking the same steps as
those for creating a website using Microsoft
Windows 7 as the server software.

For the steps in creating a website

using Microsoft Windows 7 as the server
software, refer to “Creating a website
[Microsoft Windows 7]” (page 166).

Creating a website
[Microsoft Windows
Server 2012]

You can create a website on Microsoft
Windows Server 2012 by taking the same
steps as those for creating a website using
Microsoft Windows Server 2008 as the
server software.

For the steps in creating a website using
Microsoft Windows Server 2008 as the
server software, refer to “Creating a
website [Microsoft Windows Server 2008]”
(page 169).

Creating a website
[Microsoft Windows 7]

This section explains how to create a
website when Microsoft Windows 7 is used
as the software.

Installing the internet
information service

In order to create a website, internet
information service needs to be installed in
the computer.

(1) Select [Control Panel] > [Program and
Features], and select [Turn Windows
features on or off].

(2] Check all of the items in [Internet
Information Services] > [Web
Management Tools] > [IIS 6 Management
Compatibility], and check the [IIS 6
Management Console] check box.

G 2 - ]
e
Turn Windows features on or off @
To turn a feature on, select its check box. To turn a feature off, clear its
check box, A filled box means that only part of the feature is turned on.
I =] Fj -_ Web Management Tools -

=] 1) 156 Management Compatibility
) I56 Management Console
|| TS 6 Scripting Tools
IS 6 WMI Compatibility
[#] || TS Metabase and IS 6 configuration compatibility
m oS Management Console
[] L) OS Management Scripts and Tools
[] J) OS Management Service -
< 11 | v |

=
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© check the [ASP] and [ISASP Extensions]
in [Internet Information Services] >
[World Wide Web Service] > [Application
Development Features].

Turn Windows features on or off (7]

" Windows Features.

To turn a feature on, select its check box. To turn a feature off, clear its
check box. A filled box means that only part of the feature is turned on.

= W} World Wide Web Services 3
A
[EI .NET Extensibility
@) Asp
[F)) ASP.NET
[ cet
[¥]|}} ISAPI Extensions
[T] ) ISAPIFilters
D, Server-Side Includes -
4 T I

K|

O check [Windows Authentication] in
[Internet Information Services] > [World
Wide Web Service] > [Security].

[ Windows reate | e |

Turn Windows features on or off @

To turn a feature on, select its check box. To turn a feature off, clear its
check box. A filled box means that only part of the feature is turned on.

BRI security 7

= | Basic Authentication

[T] 1 Client Certificate Mapping Authentication

[]}! Digest Authentication

El 1 IS Client Certificate Mapping Authentication |a

[T11 1P Security

| Request Filtering

E 1 URL Authorization

1) Windows Authentication -
1 1 v

@ ciick [0K].
51 Windows Fesures —

Turn Windows features on or off @

To turn a feature on, select its check box. To turn a feature off, clear its
check box. A filled box means that only part of the feature is turned on.

=] I Security -
[T} Basic Authentication

Client Certificate Mapping Authentication

|| Digest Authentication

15 Client Certificate Mapping Authentication |?

IP Security

Request Filtering

URL Authorization

Windows Authentication -

E0EO000

4 1

Configure settings for
browsing a Microsoft Access
database

In order to browse a Microsoft Access
database from a website, "Authenticated
Users" need to be added to the
[Properties] and [Security] tab in the
following folder, and the "Authenticated
Users" permissions need to be raised to full
control.

(System drive) Windows\temp\

Configure settings for
browsing a MySQL database

To browse a MySQL database from a
browser, MySQL Connector/ODBC 5.1
needs to be installed. MySQL Connector/
ODBC 5.1 can be downloaded from the
MySQL website.

Checking the version of
Microsoft SQL Server or
Microsoft SQL Server Express

To browse a Microsoft SQL Server database
or Microsoft SQL Server Express Edition
database from a website, the database
version needs to be Microsoft SQL Server
2005 Service Pack 2 or higher, or Microsoft
SQL Server 2005 Express Edition Service
Pack 2 or higher.

Creating a website

0 Start the server software.

(0] Click the [Option] menu > [Setup].

5 pot ks Accmunto e )
Fie Prniee Log Pobey [Optien]| Hep
Proter . Pricser Addvess Group Sttt Las Acquisition Dite
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ata to the database

Accessing dilsbase from websie

Micrasolt SOL Server

Windoms suthenhc shon

Local datshase

SERVER1\Administistor

Pt Job Accounhng Erderpnse Database

Prindes Llger
Update the databare Lable Distsbare user tegistation
Notiyrg sdrmansbistor of laduie m slonrg log to databae
Diivplay & message l slailup of this ulilly
] Notily admirisiralos by emel

O check the [Record logs in database]
check box.

User Hame SERVER\Administistor
Pazaweed
[7] Aceessing dutabase from websie
Pt Job Accounhng Erderpnse Database
‘white Lo databare

[ Fee. | | Pimlm |

[u-a e clatabs

o | [ oudmemioen. |

] Motily sdmiristrston by evmsl

Notityrg sdrmnististor of fadure n slonng log to datsbate

I Divplay & mevsage sl slartup of this ulily

(5] Configure the settings for the database to
connect to. For details on the settings of
the connected database, see "Settings for
connecting to the database" (page 147).

O check the [Accessing database from
website] check box, enter the [Title
displayed on website], and click [OK].
[

Mai Exmai Address | Mad detel the dete | Database | Pods
V! Recaord logs in database
Riecord in the database
Databare [ Miciosot SOL Serves -
Aushentication [Lses suthechicnion |
Aecess | Nstwodk database bl
Server Name 1521680100
Uset Name Usenl
Pazawced —

[ [¥] Aceessing dutabase from websie I

Tite - Pirt Job Accouting Erlerpnse Datab

Fee. | | Pilelm |

[u-a e clatab u]ln._ TETEL ]

Notiyrg sdrmanstistor of ladure m slonrg log to databare
] Divplay & mevsage ol slartup of this ulily
] Motily scdmiristrston by evmsl

Co ] | o |

@ When the connection is established
successfully to the set database, the
[Selection of Web site] window is
displayed. Select the website, and click
[OK].

F fuk OK. oy
Click CANCEL in ordes bo discontinue creation of the website.

‘wieb site Name Port ‘wieb site Number
Defaull Web Sie 80
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Setting the website

Configure the settings for accessing the
created website from a web browser on
the computer. The setting methods differ
between when the Windows authentication
method is used from the web browser, or
the User authentication method is used to
access the website.

Accessing using the Windows
authentication method

O sclect [Control Panel] > [Administrative
Tools], and open [Internet Information
Service (IIS) Manager].

® Wwhen the window is displayed, select
the [JALogDB] website, and click
[Authentication].

® Disable [Anonymous Authentication], and
enable [Windows Authentication].

(Note!) Be careful when checking [Anonymous
Authentication], as any user can browse
the database.

Accessing using the User
authentication method

O sclect [Control Panel] > [Administrative
Tools], and select [Internet Information
Service (IIS) Manager].

@ When the window is displayed, select
the [JALogDB] website, and click
[Authentication].

O Disable [Windows Authentication].

Creating a website
[Microsoft Windows
Server 2008]

This section explains how to create a
website when Microsoft Windows Server
2008 is used as the software.

Installing the internet
information service

In order to create a website, internet
information service needs to be installed in
the computer.

O sclect [Administrative Tools] > [Server
Manager], and select [roles] > [Add
roles].

Osclect [Web Server (IIS)], and check all
of the [Administrative Tools] and [IIS 6
Management Compatibility] items.

O sclect [Web Server (IIS)], and check all
of the [ASP] and [ISASP Extension] items
in [Administrative Tools] and [Application
Development Features] items.

O sclect [Web Server (IIS)], and check the
[Security] and [Windows Authentication]
check boxes.

O cClick [Install].

Configure settings for
browsing a Microsoft Access
database

In order to browse a Microsoft Access
database from a website, "Authenticated
Users" need to be added to the
[Properties] and [Security] tab in the
following folder, and the "Authenticated
Users" permissions need to be raised to full
control.

(System drive) Windows\temp\
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Configure settings for
browsing a MySQL database

To browse a MySQL database from a
browser, MySQL Connector/ODBC 5.1
needs to be installed. MySQL Connector/
ODBC 5.1 can be downloaded from the
MySQL website.

Checking the version of
Microsoft SQL Server or
Microsoft SQL Server Express

To browse a Microsoft SQL Server database
or Microsoft SQL Server Express Edition
database from a website, the database
version needs to be Microsoft SQL Server
2005 Service Pack 2 or higher, or Microsoft
SQL Server 2005 Express Edition Service
Pack 2 or higher.

Creating a website

0 Start the server software.

@ Click the [Option] menu > [Setup].

%% Print Job Accounting Enterprise
File Printer Log Policy | Option  Help

-- Prinkter
- Log

(3] Display the [Database] tab.

Mad et | E-mal Addbess |
™ Recod loge in databass

Dot sbanea [Microrolt SOL Server =
& [Wirrdows edthenticatio =]
hevesy |Local dalsbare T=|

Server Name |

Lizer Name ]’:rmrn 1\Adkminithiator

O cCheck the [Record logs in database]
check box.

N 2ix|
cotip | E-mad Agiece | Mad detad setup | Log Storage | Change the closing date Datebacs | Pors |

Database [Microsolt SOL Server =l

Authanheation [ ——r——— =]

Ageers [Local dotabare |
e l

Lsar Name [SERVER 1 \drministiator

Passwoed |

™ Bccasing databace fhom mabiits

T y [Pt o Accounting Enterprizs Diatabs

Wils to database Bee. | P User |

Update the databass tobe | Ditabise uses regshaton |

- Motifying administrator of falwe in storing log to databare

I Divpley & mersvage of starup of s uilly

I Moty sdministyator by emal

[

(5] Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 147).

O check the [Accessing database from
website] check box, enter the [Title
displayed on website], and click [OK].
N x|

Mad setup | E-mal Addbess | I | Change the closing date Databace | Pors |
¥ Rgcord loge in databass
1~ Becord m the database
Databace [Microsoh SOL Sevver =l
uthantcabon [User sattrriicatin I~ |
Agcess | Networ: databave |
Seever Mame 152.163.0.100
Usar Narmne |I|ml
Pasword |
Ianﬁ-qwmmmm I
Tite ebche 1......- h g Erdarpnie Database
Wils to datebase Bee. | P User |
Update the databnss tabe | Ditabase uses regshaton . |
."Nﬂﬁ"l' administistor of falure in storing log to databace
I Divpley & merssage of startup of this uilly
I Moty sdministyator by emal
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@ When the connection is established
successfully to the set database, the
website selection window is displayed.
Select the website, and click [OK].

X

Please chick DK, lo create the webaite.
Click CANCEL in order to discontinue creation of the website.

‘Weh site Name [ Pont | wheh site Nurshes [
Defoul Web Ste 0 1
| Coel |

Setting the website

Configure the settings for accessing the
created website from a web browser on the
computer.

The setting methods differ between when the
Windows authentication method is used from
the web browser, or the User authentication
method is used to access the website.

Accessing using the Windows
authentication method
O sclect [Control Panel] > [Administrative

Tools], and open [Internet Information
Service (IIS) Manager].

® Wwhen the window is displayed, select
the [JALogDB] website, and click
[Authentication].

O Disable [Anonymous Authentication], and
enable [Windows Authentication].

(Note!) Be careful when checking [Anonymous
Authentication], as any user can browse
the database.

Accessing using the User
authentication method

(1) Select [Control Panel] > [Administrative
Tools], and select [Internet Information
Service (IIS) Manager].

@ When the window is displayed, select the
[JALogDB] website, and click [Authentication].

©® Disable [Windows Authentication].

Creating a website
[Microsoft Windows Vista]

This section explains how to create a
website when Microsoft Windows Vista is
used as the software.

Installing the internet
information service

In order to create a website, internet
information service needs to be installed in
the computer.

(1) Select [Control Panel] > [Program and
Features], and select [Turn Windows
features on or off].

@ Check all of the items in [Internet
Information Services] > [Web
Management Tools] > [IIS 6 Management
Compatibility], and check the [IIS 6
Management Console] check box.

= )

Turn Windows features on or off @

. ﬁ Windows Features

To turn a feature on, select its check box. To turn a feature off, clear its
check box. A filled box means that only part of the feature is turned on.

=1 (5§ Web Management Tools:

g [¥1 ) 156 Management Compatibility
[Z] }, IS6 Management Consele
] Ji IS6 Scripting Tools
[¥1 ) 156 WMI Compatibility
[#] | TS5 Metabase and II5 6 configuration compatibility
[#] }) TS Management Console
[} 1S Management Scripts and Tools
[} TS Management Service -
l m | »

] »

® Check the [ASP] and [ISASP Extensions]
in [Internet Information Services] >
[World Wide Web Service] > [Application
Development Features].

=

Turn Windows features on or off (2]

ﬁ Windows Features

To turn a feature on, select its check box. To turn a feature off, clear its
check box. A filled box means that only part of the feature is turned on.

= W), World Wide Web Services -

=) [#%% Application Development Features
[T, .NET Extensibility

W AsP

Ju ASP.NET

) ca

, ISAPI Extensions

, ISAPI Filters

J Server-Side Includes -

4 m | ¢

|

OoRoOE
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O check [Windows Authentication] in
[Internet Information Services] > [World
Wide Web Service] > [Security].

= =

Turn Windows fcatures on or off @

To turn a feature on, select its check box. To turn a feature off, clear its
check box. A filled box means that only part of the feature is turned on.

SR scurity -

] J. Basic Authentication

(& 1. Client Certificate Mapping Authentication

[T] ). Digest Authentication

[Z1 . TS Client Certificate Mapping Authentication

[l ). IP Security

V| |, Request Filtering

[T]J) URL Authorization

] 1 Winduwes Authenlivalivn -
2l m | »

O click [0K].
b g == o
Turn Windows features on or off @

To turn a feature on, select its check box. To turn a feature off, clear its
check box. A filled box means that only part of the feature is turned on.

2 W)l Security ~
[T1)} Basic Authentication
(& . Client Certificate Mapping Authentication
[T J. Digest Authentication
[T}, TS Client Certificate Mapping Authentication
Il 1P Security
V| |, Request Filtering
[T]J) URL Authorization

L Winduwes Authenlivalivn -

4 m

Configure settings for
browsing a Microsoft Access
database

In order to browse a Microsoft Access
database from a website, "Authenticated
Users" need to be added to the
[Properties] and [Security] tab in the
following folder, and the "Authenticated
Users" permissions need to be raised to full
control.

Window Vista

Select [Control Panel] > [Folder Options] >
[View] tab, and when the [Show hidden files,
folders and drives] check box is checked in the
detailed settings, the following folder is displayed.
(System drive) Windows\ServiceProfiles\
NetworkService\AppData\Local\

Window Vista SP1 and subsequent
versions

(System drive) Windows\temp\

Configure settings for
browsing a MySQL database

To browse a MySQL database from a
browser, MySQL Connector/ODBC 5.1
needs to be installed. MySQL Connector/
ODBC 5.1 can be downloaded from the
MySQL website.

Checking the version of
Microsoft SQL Server or
Microsoft SQL Server Express

To browse a Microsoft SQL Server database
or Microsoft SQL Server Express Edition
database from a website, the database
version needs to be Microsoft SQL Server
2005 Service Pack 2 or higher, or Microsoft
SQL Server 2005 Express Edition Service
Pack 2 or higher.
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Creating a website O Check the [Record logs in database]
check box.
© start the server software.
® Ciick the [Option] menu > [Setup].
e bt tog. Py [G5)
A::-u Setup I | Priemer Addeess Group States Las Acgustion Dute
User Hame SERVER T Admirishoior
Pasawoed
[7] Aceessing dutabase from websie
Wils 1o dulabars [ Fee. | | Pimlm |
- - '] * [ Upd e cladaks bl ] l [y = = ]
Motifyng sdminististor of Fadure i shonng log to datsbase
® Display the [Database] tab. S e
_ | Notily ademrastisioe by emal
(T

Micrasolt SOL Server -

Windoms suthenhc shon

(6 Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for

Local datshase -

SERVER1\Administistor

A connecting to the database" (page 147).

Pt Job Accounhng Erderpnse Database

O check the [Accessing database from

e website] check box, enter the [Title
hedeleittezidh | Dismeenmopen displayed on website], and click [OK].
Notiying scmishetor of e i toinglog ¥ detabase (S |
| Display & message ol sladup of iz ulily Msd Exned Address | Mod detad the. date | Dotabase | Ports
] Nl sdrivitate by wined | W Recodkogs in database
Record in the database
Detsbare [Mictosoh ST Serves |
o Authenvication [Uses suthociicaion v
Acoass [Netvwcek dstabase v
Server Marns 152162.0.100
User Hame Ussil
Pazawced —
Tite ebshe Print Job A e "e'_. re O alabs
Wiite 1o detabare [ Fee | | Pl |
[ Upd e cladaks L ] l Diatah z e ]
Motityng sdminishistor of Fadure m shonng log to datsbase
] Displey & mesage ot stailup of this ully
1 Ny adriristiaten by el
o | e ]
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@ When the connection is established
successfully to the set database, the
website selection window is displayed.
Select the website, and click [OK].

| Selection of Web site =
e _
Click CANCEL in order to di e creation of the
'Web site Name: Poit 'web site Number
Defaul Web Sie 80 1

Setting the website

Configure the settings for accessing the
created website from a web browser on
the computer. The setting methods differ
between when the Windows authentication
method is used from the web browser, or
the User authentication method is used to
access the website.

Accessing using the Windows
authentication method

O sclect [Control Panel] > [Administrative
Tools], and open [Internet Information
Service (IIS) Manager].

@ Wwhen the window is displayed, select
the [JALogDB] website, and click
[Authentication].

® Disable [Anonymous Authentication], and
enable [Windows Authentication].

(Note! Be careful when checking [Anonymous
Authentication], as any user can browse
the database.

Accessing using the User
authentication method

O sclect [Control Panel] > [Administrative
Tools], and select [Internet Information
Service (IIS) Manager].

@ When the window is displayed, select
the [JALogDB] website, and click
[Authentication].

© Disable [Windows Authentication].
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Cl’eating a Website (/) Check the [Record logs in database]

. . check box.
[I\/IICI’OSOft Windows ErE— 21

S e rV e r 2 O O 3] Mail setup | Email 4ddress | Mail detail setup | Log Storage | Change the closing date. Database | Pars |

This section explains how to create a Dot [Woroset 50 Sorven B
website when Microsoft Windows Server ulhentaion [iwindows sutentzation =
2003 is used as the software. In order ps b k
to create a website, internet information el I
service needs to be installed in the et =
computer. e |
™ #ceessing database from websits
- - Title isplayed o website |an| Job Accauniting Enterpiise Database
Creating a website _
Wil 1o detabase Bee | | Pinlelse |
Updaie the database table. | Database user regisistion.._ |

0 Start the server software.

~ Notitying administiator of failus in storing log to database

9 C“Ck the [Optlon] menu > [Setu p] . I Display a message at startup of this utiliy

T~ Wotify administrator by e-mail

:,;. Print Job Accounting Enterprise

File Printer Log Palicy | Option  Help —

[#]- Printer

- Log (5] Configure the settings for the database to
connect to. For details on the settings of
the connected database, see "Settings for

(3] Display the [Database] tab. .
connecting to the database" (page 147).

2]

s |

Mail setup | E-mail Adchess | Mail detail setup | Log Storage | Change the closing d

et O check the [Accessing database from

| Begond i the deabase | = website] check box, enter the [Title
atabiase Microsolt SOL Server ¥ R R )

o displayed on website], and click [OK].

uithertication [Windows authentication =l
et 2|
Apoess [Local database =
Mail setup | E-mail Addiess | Mail detail setup | Log Storage | Change the closing date. Database | Pars |

Seryefame [ ¥ Rgeord logs in database

Wser e SERVER1\Administratar [~ Becord in the database

Database [Mictosoft SL Server =
Eassuord [
Authentication [User authentication =
| £ccessing database fomwebsite
Beosss [Network database =
Title displayed oh website |F'rinl ‘Job Accounting Enterprise Database
Server Mame: |192.1 £8.0.100
Willeto datebiese e | PiterUser |
User Name |uSer1
Updare e databoso el | || Babose e e |
Password | i
I+ Hiiping edninistiatera talue instoing bato dataimse.— [¥ Accessing datsbase from website

I= | Dspley aimessane st starupaf this iy I

Title displayed on website int Job Accounting Enterprise Database

™| rdistifys admiristratar. by e-mail

Wiie to datbase Fee. | Pinter User |

Updale the datshase taple | Datahase user registation... |

~ Notitying administiator of faiurs in storing log to database

I Display a message at startup of this utiliy

T~ Wotify administrator by e-mail

Cancel
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@ When the connection is established
successfully to the set database, the
website selection window is displayed.
Select the website, and click [OK].

|
Please chick DK to create the website.
Click CANCEL in order to d e craation of the webeit
‘Weh site Name: [ Pont | wheh site Nurshes [
Defoul Web Site 00 1
e |

Setting the website

Configure the settings for accessing the
created website from a web browser on
the computer. The setting methods differ
between when the Windows authentication
method is used from the web browser, or
the User authentication method is used to
access the website.

Accessing using the Windows
authentication method

(1) Select [Control Panel] > [Administrative
Tools], and select [Internet Information
Service (IIS) Manager].

® Wwhen the window is displayed, select the
[JALogDB] website, right-click, and click
[Properties].

® when the [Directory Security] tab is
displayed, click [Anonymous access and
authentication control] > [Edit] button.

O Wwhen the window is displayed, uncheck
the [Anonymous access] check box, and
check the [Windows Comprehensive
authentication] check box.

(NOte!) Be careful when checking [Anonymous
access], as any user can browse the
database.

Accessing using the User
authentication method

(1) Select [Control Panel] > [Administrative
Tools], and select [Internet Information
Service (IIS) Manager].

® When the window is displayed, select the
[JALogDB] website, right-click, and click
[Properties].

® when the [Directory Security] tab is
displayed, click [Anonymous access and
authentication control] > [Edit] button.

O When the window is displayed,
uncheck the [Windows Comprehensive
authentication] check box.

Browsing the database from
the website

© Connect to the website URL from a web

browser. The following methods can be

used to specify the URL.

When the server software is installed on

the computer
http://localhost/JALogDB/

When the server software is installed on

a different computer
http://(Computer IP address)/
JALogDB

@ When the website is displayed, select
the authentication method. The following
authentication methods are available.

© W Act
ey Password [ Legi | G |
Window Auth

This is the Windows authentication method. This
can be used when connecting to Microsoft SQL
Server or Microsoft SQL Server Express Edition.
When [Window Auth] is selected, the PC in which
the server software is installed and PC in which
the database is installed need to be registered to
the same domain.

User Login

This method authenticates users that are
registered in the database. Enter the [Account]
and [Password].
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O Click the [Login] button.

© Window Auth

® User Login
Account [Usert Password [sassssss @ k-

O 1he display window of the log registered
in the database is displayed. The
following operations can be performed in
the log display window.

Log infomation
Printer:
CE841(192.168.0.
DATE:
2012/01
User infomation
C841(192.168.0.3)

Displaying a specific printer log

When the printer name (IP address) is clicked in
the [Printer] section of the selection window, the
log of the printer whose IP address is selected in
the details window is displayed.

Displaying a log from a specific obtain
date
When the date is clicked in the [Date] section

of the selection window, the log from the obtain
date selected in the details window is displayed.

Aggregating displayed logs by printer

Click [Printer] in the [Export by] section of

the detail window, and the displayed logs are

aggregated according to the printer.
Aggregating displayed logs by Job
Account IDs

Click [User ID] in the [Export by] section of

the detail window, and the displayed logs are
aggregated according to the Job Account IDs.

Aggregating displayed logs by user name

Click [User name] in the [Export by] section of
the detail window, and the displayed logs are
aggregated according to the user name.

Aggregating displayed logs by date

Click [Date] in the [Export by] section of the
detail window, and the displayed logs are
aggregated according to the date.

Displaying user information

When [User information] is clicked in the
selection window, the user information recorded
in the database is displayed.

Displaying fee information

When [Cost information] is clicked in the
selection window, the fee information recorded in
the database is displayed.
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8. Fees

8. Fees

Fees are used to request cost burdens from the user according to the status of use.
In the Print Job Accounting, fees can be defined in fine detail, such as the number of prints,

print paper size, and length of possession.

(Note!) The window and setting contents differ depending on the printer model.

Creating fee charge
definitions

Creating a definition

0 Start the server software.

® sclect [Printer] menu > [Define Fees].

File Log Policy Option Help

#F  AddaPrinter...

-1 Manage multiple printers as a group...
Delete a Printer Printer Group
Change a Printer Group...

Start/End Log
Acquire a Log
Setting the Time

Backup of printer setting... g

Properties...

O Click [Add].

The initial settings definition shows

a rough guide to the running costs
calculated from the standard prices of
various consumables and the number of
prints over the lifetime for each model.

Defined Fees

2024e - Add
3037e -
B400
Bi4300/84200 [elste
B4350/84250
B4500
Bi4600/8 4400
BE200/B6300
BE250 End

BESO0
R7IMRTATAN Ll

i

Broperties

@ Enter the name of the definition to be
created in [Name].

@ Click the tabs of the items that you want
to set, and configure the settings.

Page tab
X
Name Iscllinu‘l
Dinuen use amiount l Bl fuser ke amount
Finishet | Sze | Traw | MediaType
Fages 1ot uge amnnk

WV Eage

i, [ 00583 perpage

Mo I U003 ey s
White/Clear DO%3 ot page
Whit/Ulesr Unly 00563 ey page

[~ Shest

I U e shiest

The fees for one print based on the the total
number of prints and print pages can be set. In
the print pages, color printing and monochrome
printing and white/clear printing and white/clear
only printing can be set separately.

(D Check [Page], and then enter the fees
for [Color] and [Mono] and [White/
Clear] and [White/Clear Only].

(@ Check [Sheet], and enter the fees.
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Toner use amount tab
X

Name Ixcllinu‘l

Dinuen use amiount | Bl fuser ke amount I
Finishet | Sze | Traw | MediaType
Pages Tonet use amount
W Toner use amount

LevdlEnluI'eelerec \ﬂmul'eel

1] ] 1]

1]

1 0.0057 0.0026 0.0065
z 0017 0.0075 0.0205
3 0.0342 0ms? 0.0411
4 0.0685 00315 0.0822
5 0.0313 00421 0.1036

Charae..
A prntier uged hos hee automabe calculabon
|ra41197 162 100 20R) |

Cokoe Prica 137

Monn Frice 100

While/Chean Piice | 1

I~ Setting ife fugnmatic cakcdation
[Cofor [¥e lw Sherte

Pt Lile: I 37999 Shewy

/it Ciaar Life | 20000 Sheets

o] e |

Set to apply fees for the amount of toner used.
To apply fees for the amount of toner used, check
the [Toner use amount] check box, and set the
fee charges for the amount of toner used at each
level per page.

To set the fee charges per page for each level,
select the level that you want to set from the list,
click the [Change] button, enter the fee charge
per page in the [Color Fee] field and [Mono

Fee] field and [White/Clear Fee] field in the cost
change window, and click [OK].

To automatically calculate the fee charges, select
the printer in which automatic calculation will

be used from [A printer used for fee automatic
calculation], and enter the color toner price in the
[Color Price] field and monochrome toner price in
the [Mono Price] field and white/clear toner price
in the [White/Clear Price] field. When there are
two types of toner and the large capacity type of
toner is used, check the [Large Capacity] check
box and click [Automatic calculation].

According to the type of printer, the [Setting
life] check box is displayed instead of the [Large
Capacity] check box. To set the toner lifespan
and automatically calculate the cost, check the
[Setting life] check box, and enter [Color life] and
[Mono life]. When [Setting life] is not checked,
the [Do you want to acquire the information

of the toner installed in the printer?] message

is displayed. Check that the printer power is
ON, and click [Yes]. When [No] is clicked or if
information cannot be obtained from the printer,
toner information from when the printer was
registered is used for the automatic calculation.
When large capacity and standard toners are
mixed, calculations are based on the large
capacity toners.

For details on the toner usage level, see [Items
that can be aggregated] - [Toner].
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Drum use amount tab

X
Name Ixcllinu‘l
Finishes | Sze | Ty | Media Tye
Pages | Toner use amount
Dium use amount I Helt, huser wse amount

M D use amount

Coloe Fen 00050 per page
Morw Free LU e e

White/Cloar Foe 0.0030  dob(s) per page

A prinler wsed o fee automatic calculation
[ca411132. 162 100.208) =l

Lois Price | 200
Murw Piice 180
“white/Clear Price | 2

Automatic calculstion

o] e |

Set to apply fees for the amount of drum used.
To apply fees for the amount of drum use, check
[Drum use amount], and enter fees for color
drum use per 1 A4 size page in the [Color Fee]
field, and enter fees for the monochrome drum
use per 1 A4 size page in the [Mono Fee] field,
and enter fees for the white/clear drum use per 1
A4 size page in the [white/clear Fee] field.

To automatically calculate the fees, select the
printer to use from [A printer used for fee
automatic calculation], enter the color drum price
in the [Color Price] field and monochrome drum
(or 4-color combined unit drum) price in the
[Mono Price] field and white/clear drum price in
the [White/Clear Price] field, and click [Automatic
calculation]. For 4 color combined unit drum, the
[Color Fee] and [Color Price] fields cannot be
entered.

Belt, fuser use amount tab
x|

Name Is:ll'lu'l

 Fiisher | Soe | Tew | MediaTupe |
Pages | Tones use amount
D use amount Bel, fuser uge amount

¥ Belt, huter use amount
Red Fee 033 dnllas(s) pes page
3z

Fuser Fee dulbafs] per paue

A printer used for fee automatic calculation
[mrse10192 1680 7) =l
BehPics | 290 dolfs)

FusarPice | 20 golas)

[k ] Concel |

Set to apply fees for the amount of belt and fuser
used.

To apply fees for the amount of belt and fuser
use, check [Belt, fuser use amount], and enter
fees for belt use per 1 A4 size page in the [Belt
Fee] field, and enter fees for the fuser use per
page in the [Fuser Fee] field.

To automatically calculate the fees, select the
printer to use from [A printer used for fee
automatic calculation], enter the belt price in the
[Belt Price] field and fuser price in the [Fuser
Price] field, and click [Automatic calculation].
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Finisher tab
2%
Name Isdliu'l
Pages | Tones use amount
Dumuse smount | Dek, fuser use smount
Finisher | Spe | Ty | Meda e
IV Stapie
| 3 doilar(s) pes time
[ x| Concel |

When the optional finisher is installed, set the fee
for each time that the stapler is used.

@ Check [Staple], and enter the fees.

Size tab

Fees can be set for 1 page of each paper size.
Fees can also be applied just to specific sizes.
2

Name Isdliu'l

Pages | Tones use amount
Dumuse amount | Dl fuser use amount
Firushes Size | Ty | Meda lype

W Sie

0K canch |

@ Check [Size], and click [Change].

® 1n the [Detailed setting for fees]
window, select the size to apply fees to
from [Size], and enter the fee charges.

Click [Add].

® ©

Repeat steps ® and @, and add the
sizes that require fees.

When all required sizes are added,
click [OK].

(Note!) A4, A4 Wide(SRA4), B5, letter, 16K
184x260mm, 16K 195x270mm and
16K 197x273mm are different paper
sizes with longitudinal feed and cross
feed. When cross feed is used, add A4
horizontal, A4 Wide(SRA4) horizontal,
B5 horizontal, A5 horizontal, letter
horizontal, 16K 184x260mm horizontal,
16K 195x270mm horizontal, and 16K
197x273mm horizontal.
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Tray tab Media Type tab

Fees can be set for 1 page from each used tray. Fees can be set for 1 type of each paper size.

Fees can also be applied just to specific trays. Fees can also be applied just to specific paper

20 types.
Nome [ 21
Pages | Tones use amaunt Name Isdl'lu‘l
Drumuse amount | Dokt fuser use amourt |
Fiisher | sioe Ty | Meda Tye Pages | Tones use amount
Dumuse smount | Dek, fuser use amount
M Liay Frishes | Sme | Ty Media Type
T r 5] per sheet] ¥ Media
Media T: I 5] per sheet]
o« | Concd |
3 Concd |
M 5ET)
Lharge Dtyscts.
Trs | shaet]| peie |
Tragt 0125
Tug2 1%
Tray
- ==
i
I
}:2'5 0125
MuliPusposs Tisy
MubiPuepass Fondee
N I

® ©@

Check [Tray], and click [Change].

In the [Detailed setting for fees]
window, select the tray to apply fees
to from [Tray], and enter the fee
charges.

Click [Add].

Repeat steps @ and @, and add the
trays that require fees.

When all required sizes are added,
click [OK].

o | e |

@ Check [Media], and click [Change].

® 1nthe [Detailed setting for fees]
window, select the paper type to apply
fees to from [Media type], and enter
the fee charges.

Click [Add].

® ©

Repeat steps ® and @, and add the
paper types that require fees.

When all required sizes are added,
click [OK].

O click [0K].
@ Click [End].
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Setting printer fee definitions

0 Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

® Print Job Accounting Enterprise
File Printer Log Policy Option Help

-
(- Log

O seclect the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.
L_‘,-; Print Job Accounting Enterprise

File Log Policy Option Help
I_;l--F Add a Printer...
Manage multiple printers as a group...

Delete a Printer Printer Group
=1 Change a Printer Group...
Start/End Log

Acquire a Log

Setting the Time

Define Fees...

Backup of printer setting. ..

Properties...

O sclect the fee charges definition to be
used from the [Option] tab > [Fees], and
click [OK].

Properties of printer fro Eg:} 10 2| x|

| Printer | User ~ Option
Acquire Logs
& Interval

Fees

Auto Export Logs IDo not automnatically export ;l

Detad setting... I

T Berard lans in & dstahaze

Chck [Detad setting] to cooperate with
Active Directory.

o ]

Cancel |
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Changing fee charge
definitions
0 Start the server software.

® sclect [Printer] menu > [Define Fees].

© sclect the definition name that you want
to change, and click [Properties].

Defined Fees

PS5 4200mb -] Add. |
MP5420b —
tPS480mb

MPSE1Oc Delete |

MPSE150c
MP5710c
MP5711c

P55 9E50c

ErDSDEDF’ |

(/) Change the settings in the [Define Fees]
window, and click [OK].

For details on the setting items, see
"Creating fee charge definitions"
(page 180).

When the name is changed, it is
registered as a new definition. The
previous settings remain under the
former definition name.

O ciick [End].

Deleting fee charge
definitions

(Note! e Initial setting definitions cannot be
deleted.

e When the definition set in the current
printer is deleted, it is replaced with
the initial settings definition.

© start the server software.
® sclect [Printer] menu > [Define Fees].

© sclect the definition name that you want
to delete, and click [Delete].

Defined Fees

MPS 4200mb a

MPS420b _I B |
MPS 480mb
MPSE10c
MPSE150:
MPS710c .
MPS711c PFroperties |

MP5 3650

EIDSDEDF’ | End

O click [End].
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9. Operating the Log

9. Operating the Log

This section explains settings for acquiring the log, and operations such as displaying or
deleting the log.

What is the Log?

In Print Job Accounting, various information about print jobs such as who, when, and which
printer was used for print jobs is stored on the printer built-in hard disk or flash memory. This
information is called the log. The server software acquires the log from the printer according
to a set schedule.

By logging this information, it is possible to check how much individuals are printing, and how
much a specific printer is being used.

(Note!) ¢ A log entry is made when one or more sheets are printed. Furthermore, log entries are
made when printing is rejected, or when a job is cancelled because color printing is rejected.

e However, log entries are not made when the printer power is turned OFF during processing
or printing, or if printing cannot be performed because the printer has an error.

Acquiring the Log

Information that can be acquired

Information that can be acquired as a log is as shown below.

(Note!) The information that can be acquired differs depending on the printer model or whether
options are used.

Item Details

Printer The printer name and connection destination
displayed in the log. This is displayed when all printer
logs are displayed.

Date The date of the displayed log. This is displayed when
logs from all dates are displayed.

Log No. The log number. Assigned for each month starting
from 1.

Job Account ID The Job Account ID set in the client computer that

executed the printing job, or the PIN ID entered into
the control panel.

User User name set in the client computer that executed
the printing job.

Login Name Login name of the client computer that executed the
print job.

Document Name Name of the printed document. If the document

name contains a " symbol, the " symbol is replaced
with a one-byte space. In some cases, the correct
document name cannot be acquired.

Application Name of the application used to execute the print
job.
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Item Details

Fees Fees incurred for the print job.

Host Name Name of the client computer that executed the print
job.

Port Name of the port used for printing. When using over
a network, the IP address of the client computer is
displayed.

Total Sheets Number of sheets printed.

Pages Number of pages printed. When duplex printing

is used, one sheet is counted as two pages. This
number is the actual number of printed pages as
opposed to the document page number. For example,
when a 6 page document is printed using 2-UP
printing, the number of pages is 3 pages.

Status The job processing result.

e Completed: Job completed normally.

e Canceled: Job cancelled by user operation. (For
printing, when one or more sheets are printed)

e Aborted: Job cancelled by a reason other than the
user operation.

e Abnormal Completed: Job completed abnormally.

Detailed Status ¢ Log Buffer Full:
Job cancelled because the printer log buffer is full.

e Access Control: Job cancelled by use restrictions.
e Memory Over Flow:
Job cancelled by memory overflow.
¢ Color Control:
Job cancelled by use restriction (Disable Color
Printing).
e Mono Printing (Color limited):
Job printed in monochrome due to use restriction
(Disable Color Printing).
eLip Error:
Job cancelled by lip error.

Paper Size Size of the printed paper. If a there are multiple
paper sizes used in the same print job, this item is
displayed over a number of lines.

Media Type "1+ Type of the printed paper. If a there are multiple
paper types used in the same print job, this item is
displayed over a number of lines.

Media Weight 1+~ Thickness of the printed paper. If a there are multiple
paper thicknesses used in the same print job, this
item is displayed over a number of lines.

Duplex This distinguishes between single-sided or duplex
printing. If both single-sided and duplex printing used
in the same print job, this item is displayed over a
number of lines.
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Item Details

Sheets " When one print job is displayed over a nhumber of
lines, the number of printed sheets is displayed on
each line.

Color Number of color pages printed. When one print job
is displayed over a number of lines, the number of
pages is displayed on each line.

Mono * Number of monochrome pages printed. When one
print job is displayed over a number of lines, the
number of pages is displayed on each line.

N-up Displays how many pages of data are reduced and
printed within the printing range of 1 page.

Toner The level of toner (toner usage density for each A4
size page) used for each color is displayed as one of
the following 6 levels, from 0 to 5.

Level Density of the amount of
toner used

0 0%

1 ~5%

2 ~15%

3 ~30%

4 ~60%

5 61%~

Drum Amount of drum used for each color (converted to
amount of drum used for each A4 size page). The
amount of drum use of a 4-in-1 color drum unit is
displayed is drum (K).

Belt Amount of belt used (converted to the amount of belt
used for each A4 size page)

Fuser Amount of fuser used (amount of fuser used for each
page)

Staple When the optional finisher is installed, this shows the
number of times the stapler is used.

Log Acquire Time *2 The time at which the server software acquired the
log.

Start Time 22 Time at which the printer received the job.

Process Start Time 2+ Time at which the printer started processing.

Process End Time "2+ Time at which the printer ended processing.

Print Start Time 2 Time at which the printer started printing.

End Time =2+ Time at which the printer ended printing.

Processing Off-line Time =2 | The time during which printer processing stopped due
to an error such as a paper jam during processing,
paper size error, or no paper, or the amount of time
(seconds) the printer is set to offline on the control
panel.
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Item Details

Printing Off-line Time The time during which printer processing stopped
due to an error such as a paper jam during printing,
paper size error, or no paper, or the amount of time
(seconds) the printer is set to offline on the control

panel.

Trayl =2 Number of sheets supplied from tray 1.

Tray2 = Number of sheets supplied from tray 2.

Tray3 = Number of sheets supplied from tray 3.

Tray4 =2 Number of sheets supplied from tray 4.

Tray5 = Number of sheets supplied from tray 5.

Multi-purpose Tray 2 Number of sheets supplied from the multi-purpose
tray/manual feeding tray.

Multi-purpose Feeder =2 Number of sheets supplied from the optional multi-
purpose feeder.

300dpi 2 Number of pages printed at 300dpi.

600dpi 2 Number of pages printed at 600dpi.

1200x600dpi = Number of pages printed at 1200 x 600dpi.

1200dpi 2 Number of pages printed at 1200dpi.

2400x600dpi Number of pages printed at 2400 x 600dpi.

Color Scan Page Number of pages scanned in color.

Mono Scan Page Number of pages scanned in monochrome

Scan Page Print Status Indicates whether the scanned pages are printed.

e Scan Job Print:
Number of scan jobs that are accompanied with
printing.

e Scan Job No Print:
Number of scan jobs that are not accompanied with

printing.
Job ID Number used to identify the job. When multiple logs
are generated for the same job, the ID number is the
same.
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Item

Details

Function

e Print: Print job.
e Fax receive print: Fax receive print job.
e PC Scan: PC scan job.
¢ Push Scan: Push scan job.
e Scan to network PC:
Scan to network PC job.
e Scan to e-mail:
Scan to e-mail job.
e Fax send: Fax send job.
e Copy: Copy job.
e Scan to USB memory:
Scan to USB memory job.
e Scan to Internet Fax:
Scan to Internet fax job.
e Scan to Fax Server:
Scan to Fax Server job.
e Send Fax from PC: Send Fax from PC job.
¢ Printing from a saved Fax:
Printing job from a saved Fax.
e E-mail receive printing: Printing job for a received
e-mail.
¢ Printing from USB Memory: Printing job from USB
memory.
¢ Printing from Control Panel:
Printing job from the control panel.
e Other scans: Other scan jobs.

Service

Name of the service.
e Print: Print processing log.
e Scan: Scan processing log.
e Fax: Fax processing log.
e PC Scan: PC scan processing log.
e PC Fax: Fax send from PC processing log.
e E-mail: Receiving or sending e-mail processing log.
e Server:
Log of file save process to network PC.
e USB memory:
Log of file save process to USB memory.

Scan Page Size

Size of the scanned document.

Communication Time

Time required to send or receive a fax.

Destination

When the service is Fax or PC Fax, this is one of the
following: Telephone number of the Fax source or
destination, recipient ID, or equipment information.
If the service is a server, this is the file save
destination folder.

When the service is a USB memory, this is fixed as
USBMEMO1.

When the service is an e-mail, this is the e-mail
address of the sender or receiver.
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Item

Details

Communication Mode

This is the type of communication, Fax or e-mail.

e Send: Fax send job.

e Receive: Fax receive job.

e Send to multiple recipients: Fax send job to
multiple recipients.

e Send from PC: Fax send job from a PC.

¢ Send to multiple recipients from a PC:

Fax send job to multiple recipients from a PC.
e E-mail send: E-mail send job.
e Send e-mail to multiple recipients:

E-mail send job to multiple recipients.

Manual

Turns "ON" when a fax is transmitted manually.

Time Specified

Turns "ON" when the time is specified in a fax.

Polling Turns "ON" when polling transmission is used in a
fax.

F-Code Turns "ON" when F code transmission is used in a
fax.

Call/Receipt Call: Indicates when the receiver is called by fax.

Receipt: Indicates when a call is received from the
sender fax.

Fax Forwarding

Turns "ON" when a fax is forwarded.

Communication page

Number of pages sent or received by fax.

Service Code

Fax transmission error code.

White/Clear =

This is the number of pages printed in White/
Clear color and other colors. For a print job that is
displayed in multiple lines, the number of pages is
displayed in each line by page size and counter.

White/Clear only =

This is the number of pages printed only in White/
Clear color. For a print job that is displayed in
multiple lines, the number of pages is displayed in
each line by page size and counter.

*1 When multiple lines are displayed, items other than this main item are displayed as blank

spaces in the second and subsequent lines.
*2 This item is not displayed in the default settings.
*3 If the time is not notified to the printer, this remains blank.
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Changing the log acquisition
interval and time

The interval and time at which the server
software acquires the log can be changed.

0 Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

® Print Job Accounting Enterprise
File Printer Log Policy Option Help

[#-Log

O seclect the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.

t__';'_, Print Job Accounting Enterprise
File Log Policy Option Help

=-F  Add aPrinter...
Manage multiple printers as a group...
Delete a Printer Printer Group

=l Change a Printer Group. ..

Start/End Log

Acquire a Log

Setting the Time

Define Fees...

Backup of printer setting...
Properties...

O 1n the [Option] tab, change [Acquire
Logs].

(Note!) Always set a time when the computer in
which the server software is set up and
printer power are both switched ON.
The log cannot be acquired if the power

is not ON.
2ixi
Priter | Uses  Option |
Acquie Logs
-
e N o (T
& Tam
Eees [settngt 1|
Detrfliess. . I
&uoBrpotlogs [0 net automaticaly expost =l
I Recod ki in a dtabisse
ek e e
_of | cned |

Time To Acquire Logs

1200 [Defete |

Time

I'I 2 Hours
IDD tinutes

Ok | Cancel

Interval

Set the interval when the log is acquired over a
fixed time. The maximum interval time that can
be set is 24 hours. The default setting is set as
an optimized value detected from the state of
the printer. If the interval is set to a time that is
longer than the default settings, some of the logs
may not be acquired.

Time

Set the specific time. Click [Change Time], and
add the time to the [Change Time To Acquire
Logs] window. Up to 5 acquisition times can be
added. After adding, click [OK].

O ciick [0K].
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Changing the deadline

The deadline date on which the log is collected can be set.

The log contents up to the set deadline date are counted for the month.

E.g) If the deadline is set for the 15th, the contents from the 16th of the previous month to
the 15th of this month are collected in the log.

sewr T

Mail setup | E-mail Address | Mail detail setup | Log Storage Change the closingdate | Database | Ports |

Cloging date
Day

[~ Count logs after the closine date as logs for this moath

1/15 For February 2/15 For March 3/15

I — I
When [Count logs after the closing dates as logs for this month] is checked, the logs for the
day after the set deadline are counted in the current month.

E.g) When the deadline is set for the 15th and [Count logs after the closing dates as logs for
this month] is checked, logs from the 16th of this month to the 15th of the following
month are collected in the log for this month.

e

' Mail setup | Email Address | Mal detail setup | Log Storage  Changs the closing dats | Database | Ports |

Cloging date

Day Iﬁ

@Count loge after the closing date as logs for this month

1/|15 For January 2/15 For February 3/15

O sclect [Option] menu > [Setup].

® Ciick the [Change the closing data] tab.
© Enter the date that you want to set as the deadline date.
O ciick [0K].
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Immediately acquiring the
log

The log can be acquired immediately
irrespective of the log acquisition schedule.

© Check that the printer power is ON.
@ start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

O sclect the printer, and then select the
[Printer] menu > [Acquire a Log].

Multiple printers can be selected.

t__‘_;'_, Print Job Accounting Enterprise
File Log Policy Option Help

=-F  AddaPrinter...
Manage multiple printers as a group...
Delete a Printer /Printer Group

Bl Change a Printer Group...

Start/End Log

Setting the Time !

Define Fees...
Backup of printer setting...
Properties...

O ciick [Close] in the acquisition results

window.
|
The g
ProderName | Resuk [Detai [ Mumbeot oflogs [
CB41(192168.0.3) Succeeded 4

When the log is being displayed, select
the [Log] menu > [Refresh Display] to
refresh the log display.

Notifying the printer of the

time
As some printer models do not have a
built-in clock, the server software notifies
the printer of the time every hour when
the log is acquired. Therefore, when the
printer power is turned OFF/ON, the time
information cannot be logged until the
printer is notified of the time. In this case,
the time can be notified manually to the
printer.
The time notified to the printer is the
time in the computer in which the server
software is set up.

© Check that the printer power is ON.
(2] Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

O sclect the printer, and then select the
[Printer] menu > [Setting the Time].

t__‘;.'_, Print Job Accounting Enterprise
File Log Policy Option Help

=-F  Add aPrinter...

Manage multiple printers as a group...
Delete a Printer Printer Group

#l  Change a Printer Group...

Start/End Log

Acquire a Log

Define Fees... [g

Backup of printer setting. ..
Properties...

O ciick [OK] in the completed window.
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Changing the log save
location

The folder in which the acquired log is
saved and the folder to which the log is
automatically written can be specified.

2x|
Mad setup | Emad Address | Mad detad setup  Log Somge | Changs the closng date | Database | Porie |

[0:\S slesDrepantment
Browse...
[ Ling duta gapating foldes
[0:\5 slecDrepanmentiReport
T

© Start the server software.

® sclect [Option] menu > [Setup].
O Ciick the [Login Storage] tab.

O ciick [Browse].

@ sclect the folder that you want to save,
and click [OK].

O ciick [0K].

Displaying the Log

The log can be displayed according to
printer or date. One log is divided by each
category and displayed, so you can display
or delete logs according to requirements.
When printers are managed in groups, the
log can be displayed as a group.

Displaying the Log

1] Start the server software.

@ Click the plus mark on the left side of
[Log] in the selected window.
The log tree opens.

;__'_;',. Print Job Accounting Enterprise
File Printer Log Policy Option Help

-- Printer

DS

(3] Using the same operations as in step 9,
open [Printer] and [Date] in the tree.
Displaying logs

by date
™ Print Job Accounting Enterprise

File Printer Log Policy| Option Help
--Printer
=] L:_)g
El Date
i [E-2010/08

=8 Group(Sales Department) Di Splayl ng IOgS Of a I
i CB41(192.168.0.3)

; printers belonging to
- MC561(192.168.0.2)
. B-2010/09 a group

=3 Group(Sales Department)
i CB41(192.168.0.3)

: Displaying individual
L. MC561(192.168.0.2)

Eprinter —— printer logs
=8 G_roup(SaIes Department)

Display logs by
printer group or by
individual printer
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O sclect the log that you want to display,
and select the [Log] menu > [Display

@ Displaying all logs for a specific printer
group

Logs]. In the selection window, select [Log] >
(Printer] > [Group Name] to display the
File Printer Policy Option Help log.
[~ Printer Display Logs @ Displaying all logs for a specific printer
SRE Display Total » group in a specific month
H-Date | Exportl
E‘..printe E tTZg; . In the selection window, select [Log] >
=R Delete the log [Date] > [XXXX/YY] (XXXX is the year,
5 Display Details > YY is the month) > [Group Name] to
Display/Export Item Settings display the log.
Export lags into the database i . i
5 Delete [ogs From the database ¢ LOgS th_at are acquired W_hlle alogis
Refresh Display being displayed can be displayed by
selecting the [Log] menu > [Refresh
Display].
File Printer Log Policy Option Help ¢ At the top of the details window, the
jjf:;“f’ date and printer name or group name
(D———1— I Date of the currently displayed log is shown.
©; &1 2010/08 ) . ) .
® E}- Group(Sales Department) e When the title section of each item is
@ T C841(192.168.0.3) clicked, the order is sorted (changed)
I g s according to the item contents. When
B} Group(Sales Department) clicked again, the items are sorted in
- CB41(192.168.0.5) reverse order.
i MC581(192.168.0.2)
@ —— EI- Printer Date of the Printer name or group name
® - Group(Sales Department) displayed log of the displayed log
@— El-C841(192. 168.0.3)
@— — .. 2010/08
© L-2010/09 =laoix
El-MC561(192. 168.0.3) o (o) )
- 2010/08 S T — TN S T —
i 2010409 ; : takaashi SeesDetads | Chentl nLie0s o4 1 : m
: = T S— T =

@ Displaying all logs for all printers

In the selection window, select [Log] >
[Printer] or [Log] > [Date] to display
the log.

@ Displaying all logs for specific printers

In the selection window, select [Log] >
[Printer] > [Printer Name] to display the
log.

@ Displaying all logs for a specific month

In the selection window, select [Log] >
[Date] > [XXXX/YY] (XXXX is the year,
YY is the month) to display the log.
@ Displaying all logs for specific printers in a
specific month

In the selection window, select [Log] >
[Printer] > [Printer Name] > [XXXX/YY]
(XXXX is the year, YY is the month), or
select [Log] > [Date] > [XXXX/YY] >
[Printer Name] to display the log.
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Displaying all log items
(detail display)
© start the server software.

@ sclect the [Log] menu > [Display
Details], and check the [Log] check box.

E,J Print Job Accounting Enterprise

File Printer Policy Option Help

- Printer Display Logs er | Address

[-Log Displary Tatal b1 192.188.0.
Exzport Lags 192.168.0.
Export Total ¥ b Sales Depa
Delete the log

Display/Export Item Settings »| Total !

Export logs into the database:

Delete |ogs from the database
Refresh Display

I
If the log is being displayed, the display is

updated and all of the items are displayed.

Changing log items to be
displayed
© start the server software.

@ sclect the [Log] menu > [Display/Export
Item Settings] > [Log Display Items].

% Print Job Accounting Enterprise

File Printer Poicy Option Help

[#-Printer Display Logs Group

= 0
bl 192.168.0.2 Sales D

--LDg [isplay Total r
Export Logs 192.168.0.3 Sales D
Esport Total ¥ b Sales Department

Delete Ehe [og

Luy Display Ilems..

Export logs into the detabase
pelete logs from thedatabase
Refresh Display

© Check the items that you want to display,
and uncheck items you do not want to
display.
The display order is the same order as
that in the details window log. You can
change the order by selecting an item,
and clicking [Up] or [Down].

Itz List
Log No. ﬂ 0K
Account [D
User Cancel

Login Mame
Document M ame
Application
Hesst Mame T
Part j =

Jaads

Drefault

O ciick [0K].

When the log is displayed, the display is
updated.

(Note!) In the detailed display, all of the items
are displayed irrespective of these
settings.
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Deleting the Log

(Note!) e As one log is displayed in both the
printer and date trees, if a log is
deleted from a printer tree, the
corresponding section is also deleted
from the corresponding log in the date
tree.

e Deleted logs cannot be recovered.

0 Start the server software.

® Click the plus mark on the left side of
[Log] in the selected window.
The log tree opens.

(3] Using the same operations as in step @,
open [Printer] and [Date] in the tree.

O sclect the log that you want to delete,
and select the [Log] menu > [Delete the
log].

L_‘=.'_, Print Job Accounting Enterprise

Outputting the Log as a
CSV file

Outputting as a CSV file

The acquired log can be output as a CSV
format file, and used in commercially
available spreadsheet software.

0 Start the server software.

@ Click the plus mark on the left side of
[Log] in the selected window.
The log tree opens.

(3] Using the same operations as in step 9,
open [Printer] and [Date] in the tree.

O sclect the log that you want to export,
and select the [Log] menu > [Export
Logs].

L_‘=.'_, Print Job Accounting Enterprise

File Printer Policy Option Help
(- Printer Display Logs
El--L:_:g Display Total »
+-Date | ExportLogs
=l-Printsl  Export Total "
-G

E Display Details g 3

Display/Expart Item Settings  #
Export lags inko the database
elete logs franm the database

Refresh Display

(5 Click [Yes] in the confirmation window.

File Printer Policy Option Help
(- Printer Display Logs
=8 Log Display Total »
o oot T
El-Printe Export Total »
EGl pelete the log
E Display Details 3

Display/Expart Item Settings  #
Export logs inta the datatbase
[elete lags fram the database
Refresh Display

(5] Specify the folder and file name to be
saved, and click [Save].

Items within the exported items that
are not numbers are enclosed in ""
marks.
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Changing log items to be
exported

1] Start the server software.

® sclect the [Log] menu > [Display/Export
Item Settings] > [Log Export Items].

L_‘,', Print Job Accounting Enterprise

Fle Printer Policy Option Help

- Printer Displav Lags i | Address | Group
i-Log [ijsplay Total 51 192.168.0.2 Sales Dt
ExpartLogs 192.168.0.3 Sales Dt
Expart Total Fb  SalesDepartment
[EletE bieog
Display Details J

Display/Export Item Settings a0 EyRLi=
Total Display Items. .

Expart|agsinto the database

[Elete Iogs fram e database m
Refresh Display Total Export Items. .,

© Check the items you want to export, and
uncheck the items you do not want to
export.
The items are exported in the displayed
order. You can change the order by
selecting an item, and clicking [Up] or
[Down].

Item List
Log Mo, il 0K I
Account 1D
|ser Cancel |
Lagin Marme
Diacurnent Narme U
Application
Host Mame D |
Paort =l

Default |

O ciick [0K].

Automatically outputting the
Log as a CSV file

The acquired log can be automatically
output as a CSV file.

e A folder of the printer connection

destination (IP address or port name)
is created in the folder specified in
[log auto exporting folder] explained
in "Changing the log save location"
(page 197), and the log is exported to
a file named okrptXXXXYY.csv (where
XXXX is the year and YY the month)
within that folder.

e The items exported in the log can be
changed in "Changing log items to be
exported" (page 201).

0 Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

O sclect the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.

O 1n the [Option] tab, change [Auto Export
Logs] to [Automatically export logs].

Properties of printer from which logs are acquired I _?IZI

| Printer | User  Option |

Acquire Logs
& Interval
I? Hour IU Minutes
! Time
Chiznge Time.. I
Fees settingl ;I
Lelne tees... I
Auto Export Logs I Do niot autornatically export ;I
IT Fecnmd lans it id-tE
Click [Detad setting] to ctoperan
Active Directory.
OK I Cancel
O click [0K].
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Sending a mail to the log Exiting log acquisition
administrator Log acquisition can be exited and
Acquired logs can be automatically output restarted.
to CSV files, and the output file can be © Check that the printer power is ON.
sent as an e-mail attachment every month
to the administrator. @ start the server software.

(Note!) The outgoing mail server, sender's ® Double-click [Printer] in the selection
e-mail address and administrator's window. The registered printer list is
e-mail address need to be configured in displayed in the list view of the details
advance according to the "Setting the window.

outgoing mail function" (page 224).
O sclect the printer, and then select the

e The mail is sent of the day after the [Printer] menu > [Start/End Log].
deadline (default setting is end of
the month) set in the "Changing the Multiple printers can be selected.

deadline" (page 195).

e The items exported in the log can be

t__‘;.'_, Print Job Accounting Enterprise

changed in "Changing log items to be 3. o Fibey ol Hel
exported" (page 201). E-f  AddaPrinter... ter
Manage multiple printers as a group... 561
0 Start the server software. Delete a Printer/Printer Group 1
Change a Printer Group... Lp
® Double-click [Printer] in the selection "lw
window. The registered printer list is Acquire a Log
displayed in the list view of the details Setting the Time
window. e
Backup of printer setting...
O select the printer, and then select the Properties...
[Printer] menu > [Properties]. |
Multiple printers can be selected. O ciick [Yes] in the confirmation window.

i i DFi ¥
O 1n the [Option] tab, change [Auto Export Print Job AcCCINSIESEE—_ —I

Logs] to [Mail logs to administrator].

#1x -
Printer | User  Option | Do you want to continue?
Acquire Logs
& Interval
l?_ Haur EU Minutes
C Time Mo
Chizanges Time.. I
Fees settingl ;I
Uetne tees... I

Auto Export Lags I Do not automatically export ;I

= Beram langs inja e

Click [Detal setting] to ctop
Active Directory.

O ciick [0K].
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@ When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

(Note!) Depending on the printer, this may not
be displayed.

Print Job Accounting Enterprise ﬂﬂ

Pleaze enter the administrator passward of the printer.

Pazzword IT
Cancel |

(Note!) When the following window is displayed,
a connection cannot be made to the
printer.

In this case, always click [No] and
connect to the printer before trying
again.

Print Job Accounting Enterprise '= ll

Unable to connect with a printer.
The configuration on the printer will not be changed, changes wil
only apply on the PC. Is it OK?
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Memo
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10. Aggregating logs

10.Aggregating logs

Acquired logs can be aggregated by printer, user ID, user name, or month. Also, aggregation
results can be exported as a CSV file.

Aggregating logs

Items that can be aggregated

Items that are displayed for aggregation are as shown below.

(Note!) The items that can be aggregated differ depending on the printer model or whether options

are used.
Item Details

Printer Name of the aggregating printer. This is displayed when
logs are aggregated by printer.

Address The connection destination of the aggregating printer. This
is displayed when logs are aggregated by printer.

Name Name of the aggregating user ID. This is displayed when
logs are aggregated by user ID.

Job Account ID This is the aggregating user ID. This is displayed when logs
are aggregated by user ID.

User Name of the aggregating user. This is displayed when logs

10 are aggregated by user name.
. Date Date of aggregation. This is displayed when logs are

aggregated by date.

Group The name of the group that the aggregating printer or user
belongs to.

Fees The total fees.

Jobs The total number of jobs.

Sheets The total number of sheets printed.

Pages The total number of pages printed.

Color The total number of color pages printed.

Mono The total number of monochrome pages printed.

Printer Use Time The total time the printer was used.

Completed ™ The total number of jobs that completed normally.

Canceled The total number of jobs cancelled by user operation. (For
printing, when one or more sheets are printed)

Aborted The total number of jobs cancelled by reasons other than
user operation.

Abnormal completed " The total number of jobs that completed abnormally.

- 206 -



10. Aggregating logs

Item

Details

Detailed Status

e Log Buffer Full:
The total number of jobs cancelled because the printer
log is full.

e Access Control:
Total number of jobs cancelled due to use restrictions.

e Memory Over Flow:
Total number of jobs cancelled due to memory overflow.

e Color Control:
Total number of jobs cancelled due to use restrictions
(Disable Color Printing).

e Mono Printing (Color limited):
Total number of jobs printed in monochrome due to use
restrictions (Disable Color Printing).

e Lip Error: Total number of jobs cancelled due to lip error.

A4~ Total print number for each paper size.

A5

A6

Simplex " The total number of sheets printed for simplex printing.

Duplex The total number of sheets printed for duplex printing.

Toner (C) Total number of pages for each level of used cyan toner.

Toner (M) Total number of pages for each level of used magenta
toner.

Toner (Y) Total number of pages for each level of used yellow toner.

Toner (K) Total number of pages for each level of used black toner.

Drum (C) Total amount of use of cyan drum.

Drum (M) Total amount of use of magenta drum.

Drum (Y) Total amount of use of yellow drum.

Drum (K) Total amount of use of black drum and 4-in-one color
drum.

Belt Total amount of use of belt.

Fuser The total amount of belt and fuser used.

Staple When the optional finisher is installed, this shows the
number of times the stapler is used.

Plain *1+ Total print number for each paper type.

Letter Head

Transparency

Auto "2 Total print number for each paper thickness.

Light

Medium

Trayl 1= Total number of sheets supplied from tray 1.

Tray2 "1+ Total number of sheets supplied from tray 2.

Tray3 =12 Total number of sheets supplied from tray 3.

Tray4 =1+ Total number of sheets supplied from tray 4.
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Item

Details

Tray5 =1+

Total number of sheets supplied from tray 5.

Multi-Purpose Tray "t~

Total number of sheets supplied from the multi-purpose
tray/manual feeding tray.

Multi-Purpose Feeder -1

Total number of sheets supplied from the optional multi-
purpose feeder.

300dpir 2 Total number of pages printed at 300dpi.
600dpi~ -2 Total number of pages printed at 600dpi.
600x1200dpi- - Total number of pages printed at 600 x 1200 dpi.
1200dpi~ -2 Total number of pages printed at 1200dpi.
2400x600dpi* - Total number of pages printed at 2400 x 600 dpi.

Color Scan Page

The total number of scanned color pages.

Mono Scan Page

The total number of scanned monochrome pages.

Scan Job Print =

Total number of scan jobs that are accompanied with
printing.

Scan Job No Print =

Total number of scan jobs that are not accompanied with
printing.

PC Print =
Fax To Print =
PC Scan

Total log number for each function.

Print =
Scan
Fax

Total log number for each service.

Communication Time *

Total time required to send or receive faxes.

Send

Total number of jobs sent by fax.

Receive "

Total number of jobs received by fax.

Multi-cast Send =

Total number of jobs sent by fax to multiple recipients.

Send on PC =

Total number of jobs sent by fax from a PC.

Multi-cast Send on PC =

Total number of jobs sent by fax to multiple recipients from
a PC.

Email Send *:

Total number of jobs sent by e-mail.

Multi-cast Email Send *:

Total number of jobs sent to multiple recipients by e-mail.

Communication page *

Total number of pages sent and received by fax.

White/Clear

Total number of pages printed in White/Clear color and the
other colors.

White/Clear only

Total number of pages printed only in White/Clear color.

Toner(W/L) Total number of pages of each level corresponding to
White/Clear toner usage.
Drum(W/L) Total usage of the White/Clear drum.

“If the aggregate result for this item is 0, it is not displayed.
“2This item is not displayed in the default settings.
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Displaying the aggregate
0 Start the server software.

® Ciick the plus mark on the left side of
[Log] in the selected window.
The log tree opens.

% Print Job Accounting Enterprise
File Printer Log Policy Option Help

[+~ Printer

%Lng

(3] Using the same operations as in step @,
open [Printer] and [Date] in the tree.

t__‘;'_, Print Job Accounting Enterprise
File Printer Log Policy Option Help

[#]- Printer
Bl Log
[ Date
El Printer
=- G_ruup{Sales Department)

O sclect the logs to aggregate, and in the
[Log] menu > [Display Total], select [By
Printer], [By Job Account ID], [By User
Name], [By Month], [By Printer Group] or
[By User Group].

% Print Job Accounting Enterprise

File Printer W@ Policy Option Help

[#- Printer Display Logs
El-Log Display Total By Printer
5 et | Exparttoss [ 3o Accunt |
El-Printsl Export Total By User Name
=Gl Delete the log By Month
Display Details By Printer Group
Display/Export Item Settings By User Group
Export: [ogs into the database By Login Name

Delete logs fram the database:
Refresh Display

® Aggregating all logs for all printers
In the selection window, select [Log] >
[Printer] or [Log] > [Date] to
aggregate the logs.

® Aggregating all logs for specific
printers
In the selection window, select [Log]
> [Printer] > [Printer Name] to
aggregate the logs.

©) Aggregating all logs for a specific
month
In the selection window, select [Log] >
[Date] > [XXXX/YY] (XXXX is the year,
YY is the month) to aggregate the
logs.

@ Aggregating all logs for specific
printers in a specific month
In the selection window, select [Log] >
[Printer] > [Printer Name] [XXXX/YY]
(XXXX is the year, YY is the month), or
select [Log] > [Date] > [XXXX/YY] >
[Printer Name] to aggregate the log.

® Aggregating all logs for specific
groups
In the selection window, select [Log] >
[Printer] > [Group Name] to aggregate
the logs.
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® Aggregating all logs for specific
groups in a specific month
In the selection window, select [Log] >
[Date] > [XXXX/YY] (XXXX is the year,
YY is the month) > [Group Name] to
aggregate the log.

File Printer Log Policy Option Help

[ Printer

E--Log

(O)———F— = Date

5 2010/08

B Group{Sales Department)

: L £841(192.168.0.3)

: L..MC561(192. 168.0.2)

® =- 2010409
® =] G_roup[Sales Department)

®  C841(192.168.0.3)
.- MC561(192.168.0.2)

(O—1—=-Printer

=- Group(Sales Department)

@————— - C841(192.168.0.3)
@————— 2010/08

e The dates and printer names of

the currently aggregated logs are
displayed at the top of the details
10 window.

e When the title section of each item is
clicked, the order is sorted (changed)
according to the item contents. When
clicked again, the items are sorted in
reverse order.

Dates of the Aggregated printer

aggregated logs names
=lo=|
[otal_ (2010009 Cleaa(92.1630.3 D
Printer Fees P Color Mong
Cad1 192.168.0.3 N.08R82 & & & o [

Displaying all aggregated
items (detail display)
© start the server software.

@ sclect the [Log] menu > [Display
Details], and check the [Total] check box.

L_'_j_, Print Job Accounting Enterprise

File Printer Policy Option Help

- Printer Display Logs [i]

[-Log Display Takal 3 @
Expart ogs 2 3k
Expart Tatal r 2tk

[elete the lag

Logs
Display,/Export Item Settings  »
Export |ags into the database

[elete |mas from the database
Refresh Display

If the aggregate is being displayed, the
display is updated and all of the items are
displayed.
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Changing aggregate items

0 Start the server software.

® sclect the [Log] menu > [Display/Export
Item Settings] > [Total Display Items].

E,, Print Job Accounting Enterprise

File Printer Policy Option Help

- Printer Display Logs

E-Log Wispl ey Tiatal e
Expork Logs
Expart Tobal F 2 | takahashi
[Delete the log

4  murata

Display Details 3
Display/Export Item Settings
Export [ogs into the database
[elete logs From the database
Refresh Display

Total Display Items. ..
Log Export Items...
Total Export Items...

© Check the items that you want to display,
and uncheck items you do not want to
display.
The display order is the same order as
that in the details window aggregate
items. You can change the order by
selecting an item, and clicking [Up] or
[Down].

Ibem List

Group ﬂ k. I

Fees

Jobs Cancel |

Sheets

Pages WUp

Color

Mana Down |

Pritter Uze Time ;I

Drefault |

O ciick [0K].

When the aggregate is displayed, the
display is updated.

(Note!) In the detailed display, all of the items
are displayed irrespective of these
settings.

Outputting the
aggregation results as a
CSV file

Outputting as a CSV file

The aggregated results can be output as a
CSV format file, and used in commercially
available spreadsheet software.

ﬂ Start the server software.

® Ciick the plus mark on the left side of
[Log] in the selected window.
The log tree opens.

(3] Using the same operations as in step 9,
open [Printer] and [Date] in the tree.

O sclect the logs whose aggregates you
want to export, and in the [Log] menu
> [Export Total], select [By Printer], [By
Job Account ID], [By User Name], [By
Month], [By Printer Group] or [By User
Group].

_E,', Print Job Accounting Enterprise

File Printer Policy Option Help

[ Printer Display Logs Log 201110

=~ L?g Display Total 3 Log No. Rl
&-Date Export Logs 1

By Printer

E-G Delete the log
E Display Details 4 By User Name
Display/Export Item Settings  » By Month

Export [ogs into the database By Printer Group
Delete logs from the database By User Group
Refresh Display By Login Name

(5] Specify the folder and file name to be
saved, and click [Save].

Items within the exported items that
are not numbers are enclosed in ""

marks.
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Changing the log items to be

exported

1] Start the server software.

@ sciect the [Log] menu > [Display/Export
Item Settings] > [Total Export Items].

l_',) Print Job Accounting Enterprise

File Printer Policy Option Help

[#- Printer Display Logs

Export logs
Esxport: Total

- Log Djsplay: Tatal

[elete thellog
Display Details
Display Export Item Settings
Export [pgs into the database
Delete logs From the database

Refresh Display

0
2 | takahashi B
2 | takahashi 5
4  murata E
4 | murata =]
Log Display Items...
Total Display Items...
Log Export Items...
Total Export Items...

9 Check the items you want to export, and
uncheck the items you do not want to

export.

The items are exported in the displayed
order. You can change the order by
selecting an item, and clicking [Up] or

[Down].

2%
Item List
Group ﬂ 0K I
Fees
Jobs Cancel |
Sheets
Pages U
Color
Maono [ |
Printer Uze Time LI

Diefault |

O ciick [0K].
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11.Client Software

This section explains the Job Accounting Mode set by the client software.

Changing Job Accounting
Mode

Job Accounting Mode is a method of setting
the user name and Job Account ID in the
Windows client computer. There are 4
modes.

(Note!) The Job Accounting Mode cannot be
changed in MacOS or Mac OS X.

Job Accounting Mode settings can only
be configured in a print driver that
supports Print Job Accounting.

Types of Job Accounting
Mode

Tab

The tab for setting the User Name and Job
Account ID to the print driver properties is
displayed.

It is used by the user themselves to set or
change the User Name and Job Account ID.

Popup

A pop-up window for setting the User Name and
Job Account ID to be sent for each print job is
displayed.

It is used when 1 computer is used by multiple
users.

(Note!) Even if printing is performed on the
shared printer client side, the input
window is not displayed. Use the hide
mode for shared printers.

Hide

Even if printing is performed on the shared
printer client side, the input window is not
displayed. Use the hide mode for shared printers.
The system administrator creates an ID file that
contains the Job Account ID and User Name that
correspond to the Windows login user in advance.
By specifying this file with the client software, the
user that performed the printing is identified, and
the corresponding Job Account ID is automatically
acquired. Furthermore, the same Job Account

ID can be set for all login users. The users do

not need to configure settings or to know their
own Job Account ID. When using the Windows
computer as a print server and the printer as a
shared printer, install and use the client software
onto the computer to be used as a print server.

Not supported

Users identification is not performed, and all
jobs are recognized as unregistered ID. The User
Name is the user name used to login to windows,
and the Job Account ID is 0. Used when user
recognition is not needed.

(Note!) When the printer drivers are updated
or reinstalled, the mode returns to
unsupported mode. Therefore, you need
to set the Job Accounting Mode again.
However, when using the function that
sets all printer drivers to the same
mode, it is not necessary to re-set the
mode settings.
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Using Tab Mode

o Select [Start] > [All Programs] > [Oki
Data] > [Print Job Accounting Client] >
[Change Job Accounting Mode].

When the [User Account Control] window
is displayed, click [Yes] or [No].

(2] Select the printer driver of the printer
that will acquire the log from the [Driver]
list. To set all printer drivers to the same
mode, check the [Set the same mode for
all drivers] check box.

© select [Tab], and click [Change].

File Hide Mode Help

~Job Accounting Mode

I™ et the same mode for all drivers.

Dirivver

| oKl MC3B1PCL) =

i Tab

) Eopup

€ Hide

" Mot supported

LChange |

O click [OK] in the change notification
window.

O sclect [File] menu > [Close].

O in Windows 8.1/Server 2012 R2/8/Server
2012/7/Server 2008 R2/Vista/Server
2008, select [Start] > [Control Panel],
and click [Printer]. (For Windows Server
2003, select [Start] > [Printers and FAX].)

o On the printer driver icon, right-click the
mouse button and select [Properties].

(5] In the [Job Accounting] tab, enter the
User Name and Job Accounting ID, and
click [OK]. In the default settings, the
User Name is the user name used to login
to Windows, and the Job Account ID is 1.

=
" Generdl | Shamng | Pois | Advanced |
Color Management Job Accounting | Security | Device Option

Uszer Details

Ulzer Name [up to 80 characters)
Isato

Job Account ID (1-993933339)
[1

[ ok | Cancel Boply

o Print from the application.
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Using Popup Mode

o Select [Start] > [All Programs] > [Oki
Data] > [Print Job Accounting Client] >
[Change Job Accounting Mode].

When the [User Account Control] window
is displayed, click [Yes] or [No].

(2] Select the printer driver of the printer
that will acquire the log from the [Driver]
list. To set all printer drivers to the same
mode, check the [Set the same mode for
all drivers] check box.

O select [Popup], and click [Change].

% Print Job Accounting Client
File Hide Mode Help

—Job Accounting Mode

I Set the zame mode for all drivers.

Dirivver

| oK Meas1(PoL) |

" Mot supported

Lhange |

O ciick [OK] in the change notification
window.

(6 Select [File] menu > [Close].
(6 Print from the application.

@ When the popup window is displayed,
enter the User Name and Job Accounting
ID, and click [OK].

When [Cancel] is clicked, the user name
is blank and Job Account ID is O in the
log. The print job is not cancelled.

Job Accounting

Uszer Details

Uzer Hame [up ta 80 characters]
| sata |

Job Account 1D [1-939999999)

L |
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Switching each user for a Job Account ID in hidden mode

O Create an ID file using software such as Notepad or Excel etc.

<For Notepad>

@D The login user and Job Account ID are included for each user individually on a separate line.
The login user name and Job Account ID are separated with a comma (,).

Login user name:

User name entered when logging in to Windows
Job Account ID:

Job Account ID that corresponds to the login user name
User name:

User names used in Print Job Accounting
The user name can be omitted. When omitted, the login user name is used as the user name.

£ | untitled - Notepad £ | untitled - Notepad

File Edit Format Wew L File Edit Format WView L
—— —
—(satn),lﬁ%#:g}i sato,1
hdshi;Z,takaha takahashi,?2

suzuki, 3, suzuki suzuki,3
muratd,d4d ,murata murata,4
inoue |5, inoue inoue, 5
«| 1|

Login user

hame Job Account ID User name

@ Save in text format with the extension "CSV".
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<For Excel>

‘H] Fle Edit View Insert Format ‘] FHle Edit Vew Insert Format
NEH S Q| Vi Gad NEH S B VR Gad
AG - i3 AB - i
e B | ¢ | 2l B | ¢ |

| 1 |sato 1sato | 1 |sato 1
| 2 |takahashi 2 takahashi | 2 |takahashi 2
| 3 |suzuki 3 suzuki | 3 [suzuki 3
| 4 |murata 4| murata | 4 |murata 4

5 |inoue 5 inoue 5 |linoue 5

G | 6 |
| 7 | | £
| 8 | | 8 |
| 9 | | 9

AN 1N

M4 4 » H[ySheetl  sheetz { cheet3 / M 4 b M| Sheetl {Sheetz [/ Sheetd /
Ready Ready

® The login user and Job Account ID are included for each user individually on a separate line.

@ Save in CSV file format.

@ select [Start] > [All Programs] > [Oki Data] > [Print Job Accounting Client] > [Change
Job Accounting Mode]. When the [User account management] window is displayed, click
[Continue] or [Yes].

(3] Select the printer driver of the printer that will acquire the log from the [Driver] list. To set
all printer drivers to the same mode, check the [Set the same mode for all drivers] check
box.

(Note!) When the shared printer is used, do not use the function that sets all printer drivers to the
same mode. When using a shared printer on the client side to print, the account information
11 is not output.
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O select [Hide], and click [Change].

% Print Job Accounting Client 1 2l
File Hide Mode Help

—Job Accounting Mode

I™ Set the same mode for all drivers.

Dirivver

| 0K MC3B1PCL) =

" Tab
i)

Lhange |

@ Click [OK] in the change notification
window.

O select [Hide Mode] menu > [Import ID
File].

Display registered Job"Account IDs. ..
Get user information from a file...
Set fixed Job Account ID for all users
Setup Fixed Job Account ID...

OIS T L]

" Tah
= Eopup
 Hide
" Mot supported

LChange |

/] Specify the ID file created in 0, and click
[Open].

(8] If [Hide Mode] menu > [Set the same
mode for all drivers] check box is
checked, uncheck it.

O select [File] menu > [Close].

0 Print from the application.

(Note!) When printing is performed after
logging into Windows as a login user
that is not registered, the user name
is the current login user name, and the
Job Account ID is O in the log.

Select [Display registered Job Account
IDs] in the hide mode menu, and you

can authenticate Job Account IDs that
have already been registered, delete
unneeded Job Account IDs, and import
1D files.

Acquiring user information
from files in hide mode

User information can be acquired from a
specific file. The file created in "Exporting
data for client software" (page 130) can be
specified.

(1) Select [Start] > [All Programs] >
[Okidata] > [Print Job Accounting Client]
> [Change Job Accounting Mode]. When
the [User Account Control] window is
displayed, click [Continue] or [Yes].

(0] Select the printer driver of the printer
that will acquire the log from the [Driver]
list. To set all printer drivers to the same
mode, check the [Set the same mode for
all drivers] check box.

(Note!) When the shared printer is used, do
not use the function that sets all printer
drivers to the same mode. When using
a shared printer on the client side to
print, the account information is not
output.

(3] Select [Hide], and click [Change].

¥ Print Job Accounting Client
File Hide Mode Help

—Job Accounting Mode

[ Set the same mode for all drivers.

Criver

|oKI caarPL) |

 Tab
i B

 Hide

| Change i

O ciick [OK] in the change notification
window.
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(5] Select [Hide Mode] menu > [Get user
information from a file].

' gl’ﬁ:ﬂ Job Accouniing Client -m = | i
File [ Hide Mode | Help

Import ID File...

Display registered Job Account IDs...
Get user information from a file...
Set fixed Job Account ID for all users l} -—_]
Setup Fixed Job Account ID... =
Lo Tab
" Popup
& Hide
" Waot supported

| Change i

O check the [Get user information from a
file] check box, and click [Change].
g ‘

Login Name | User Name | Job Account 1D |

LF/‘ Giet user information from & h\e!

P oK
Change i

Another mode is presently enabled, Cancel

(7] Select the file used to obtain the user
information, and click [OK].

Get user information from s file
Login Name [ User bame | JabAccount 1D |
inoue inoue 12341
muata s 12342
salo salo 12343
suzuki sLizuki 12344
tekahashi  takahashi 12345

[¥ Gt user information from a file

i~ User information file storage folder

C:AProgram FilestOkidataPrint Job AccountingtClient - -
Change | : <

Cance!

Another mode is presently enabled

Using the same Job Account
ID for all users in hide mode

© sclect [Start] > [All Programs] > [Oki
Data] > [Print Job Accounting Client] >
[Change Job Accounting Mode]. When the
[User account management] window is
displayed, click [Continue] or [Yes].

® sclect the printer driver of the printer
that will acquire the log from the [Driver]
list. To set all printer drivers to the same
mode, check the [Set the same mode for
all drivers] check box.

(Note!) When the shared printer is used, do
not use the function that sets all printer
drivers to the same mode. When using
a shared printer on the client side to
print, the account information is not
output.

© sclect [Hide], and click [Change].

File Hide Mode Help

—Job Accounting Mode

™ Set the same mode for all drivers.

Diriver

| OKI MC38T(PCL) l

" Tab

LChange |

O ciick [OK] in the change notification
window.

O 1n the [Hide Mode] menu, check the [Set
the same mode for all drivers] check box.

% Print Job Accounting Client - 2] =]

Import ID File...
Display registered Job Account IDs...
Get user information from a file...

Setup Fixed Job Account ID. ..
IUI\I MCABTIFCL]

' Mot supparted

LChange
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O select [Hide Mode] menu > [Setup Fixes Using in an unsupported
Job Account ID. mode

% Print Job Accounting Client i _Qlll

Import ID Fie... O sclect [Start] > [All Programs] > [OKki
Display registered Job Account IDs...

ol e Data] > [Print Job Accounting Client] >

ot [Change Job Accounting Mode]. When the
: [User account management] window is

displayed, click [Continue] or [Yes].

;Hmsuppmd ® sclect the printer driver of the printer
' e | that will acquire the log from the [Driver]
= list. To set all printer drivers to the same
mode, check the [Set the same mode for
(7 all drivers] check box.
Enter the User Name and Job Account ID,
and click [OK].

O sclect [Not Supported], and click

[Change].
When the user name is omitted, the

login user name is used as the user Fle HdeMods Help

name. —Job Accounting Mode
[~ Set the zame made for all drivers.
J3 B2 D
User Deetails [0k ME381 PCL) =
Usger Mame [up to 80 characters]  Tab
|Sales Section Ma.1 i

& Eopup
Job &ccount 1D (1-999339939) .

i '

cut; | C
O sclect [File] menu > [Close]. O ciick [OK] in the change notification

window.
(9] Print from the application.

O select [File] menu > [Close].

(6] Print from the application.
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Memo
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12. Operation and Management

12.0peration and Management

This section explains how to move the printer or change the server, and how to delete Print
Job Accounting.

Operation and Management

Setting the outgoing mail function

Configure the settings for using the mail send function. The outgoing mail server, outgoing
mail format, sender mail address and administrator mail address settings can be configured.

0 Start the server software.

® sclect [Option] menu > [Setup].
Configure the [Mail setup] tab settings.
sep 2=

Mol sotup | Exmai Address | Mai detal selup | Log Stovage | Change the closing dete | Database | Purs |

- Mail server 1SMIP] setup
Ml grrven rismne [.&im.. @
Port number ] ®
(B)————— Enable SMTP Auhenlication
Lsrs name [u&il.-m i @
Pasaword [ ] ®
Send mail |
(B)————Mossage to bo sent wth logs =
Tk Send logs = - : i @
Heaulen
Sendlog data. |
®
Eooter
©
[~ Uther setup
" N ! il iniric by el Segding Test

o] e |

Enter the mail server (SMTP) used by the job account server. If you do not know the
server name, contact the network administrator.

Enter the port number. This is usually [25].
Check to perform user authentication when sending mail.
When user authentication is used, enter the login user name.

When user authentication is used, enter the password.

@060 e O

Select the content to send.
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Message to be sent with
logs

This is the content of the mail sent using the function
to e-mail the log to the administrator.

Message to be sent when
the Limit Value was
exceeded

This is the content of the mail sent to the user or
user group when the limit value is exceeded.

Message to be sent when
printing is permitted

This is the content of the mail sent to the user or
user group when the limit value is reset and printing
can be performed.

Message to be sent with
total result

This is the content of the mail sent using the function
to notify the aggregate results by e-mail.

Message to be sent with
log acquisition status

This is the content of the mail sent using the function
to notify the log acquisition status by e-mail.

Message to be sent when
the size of attachment
files exceeded limit value

This is the content of the mail sent when the size of
1 attachment file exceeds the size set in the function
for limiting the size of attachment files.

Message to be sent when
failing in log preservation
to database

This is the content of the mail sent by the function
that notifies when the log fails to be saved to the
database. (Only Enterprise edition)

Message to be sent when
failing in transmitting
card table

This is the content of the mail sent by the function
that notifies when the IC card compatibility table
cannot be sent. (Only Enterprise edition)

Message to be sent when
the card information
doesn't exist in table

This is the content of the mail sent by the function
that notifies when there is no IC card information
in the IC card compatibility table. (Only Enterprise
edition)

Message to be sent when
the card information
overlaps in table

This is the content of the mail sent by the function
that notifies when the IC card information in the
IC card compatibility table is duplicated. (Only
Enterprise edition)

Message to be sent when
the number of users

in card table exceeded
maximum value

This is the content of the mail sent by the function
that notifies when the maximum number of
registered users in the IC card compatibility table is
exceeded. (Only Enterprise edition)

@ Enter the mail title.
Enter to include a header in the mail body.

@ Enter to include a footer in the mail body.
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(3] Configure the mail address tab settings.

@ Enter the name of the mail sender.
@ Enter the mail address of the mail sender.

@, @  set the name and e-mail address of the person you want to send the log to using the
function to send log to the administrator. Enter the recipient's name in @ and email
address in @, and click [Add].

To send to multiple recipients, repeat this operation.

® Check that the recipient is displayed, and click [OK].
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Sending print prohibited/
permitted by mail

When [Notifies by e-mail when Limit Value
was exceeded] is checked, users are

notified by mail when the use limit value is
exceeded and printing cannot be executed.

Printing is now forbidden because the Limit Yalue was exceeded.

Frinter MCEE1(1592.168.0.2)

User  takahashi
Job Account ID 2

Also, users are notified by mail when the
limit value is reset and printing can be
executed.

Printing i= now permitted because the usagze status was reset.

Frinter MC3B1(192.168.0.2)

User  takahashi
Job Account ID 2

2]
Job Accourt ID | Use Restrictions | Limit Value | Usage Status |
Mame |takahashi
Job Account I 2
Status Enable Printing
E-mail address Italr.ahaehi@okicm
Uszcr Group ISaIu Scchion Ha 1 j

™ Mosifics total scault by c mal

[V Hinkifies: by r-mad when | Valie was mreeded

[~ Do not process Limit Vaue a3 a goup

[ o ] comea |

(Note!) The outgoing mail server and sender's
e-mail address need to be configured in
advance according to the "Setting the
outgoing mail function" (page 224).

0 Start the server software.

® Click the plus mark on the left side of
[Printer] in the selected window.
The printer tree opens.

O sclect the printer or printer group that
you want to configure from the selection
window, and then select the [Printer]
menu > [Properties].

O ciick the [User] tab.
@ sclect the user to set, and double-click it.

O check the [Notifies by e-mail when Limit
Value was exceeded] check box, and click
[OK].

(Note!) Users are not notified when the mail
address is not entered. Enter the mail
address.

To seémultiple users, repeat steps (5
a )

nd

@ cClick [OK].

O 1n the [Registration of Job Account ID]
window, click [OK].

O 1n the [Properties of printer from which
logs are acquired] window, click [OK] to
close the printer properties.
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Notifying the log acquisition
status by email

The administrator can be notified of the log
acquisition status by e-mail once a day.

HNotifies log acquizition status.

Printer MCIBE1 (192, 168.0.2)
Status Acquired

Last Acquizition Date 201009530 11:86:18
Printer CT11(192.168.0.3)

Status Acquired

Last Acquisition Date 2010/09/30] 11:28:49

2x|
Mad setup | Emad Adress | Mad detad setuo | Log Siorage | Changs the closng date | Database | Poris |

[ Mail server [SMTF) sotup
Ml gerver name |uiim
[Eort numbes I?l‘»
[# Enabls SMTP Authertication
Vs niaime [okitero
Password | mmmmm
+ Sered mal
[Message 10 be sert it logs J
L |Send logs Detadt |
Header
Send kg data.
[Eooter
Sepding Test
[

(Note!) The outgoing mail server, sender's
e-mail address and administrator's
e-mail address need to be configured in
advance according to the "Setting the
outgoing mail function" (page 224).

0 Start the server software.

@ sclect [Option] menu > [Setup].

O 1n the [Mail setup] tab, check the
[Notifies log acquisition status to
administrator by e-mail] check box.

O ciick [0K].

Limiting the size and number
of attachments

The size and number of attachments can
be limited, and sent separately in different
e-mails.

2%
Mad petup | Emad Address  Mad detad st | Log Sicrage | Changs the closng date | Databaes | Pors |

1 Setup of fie:
[¥ The size and the rumber of attachment fies are fmited
Lk e
Ll v of fles 0 e

© start the server software.
® sclect [Option] menu > [Setup].
O Ciick the [Mail detail setup] tab.

O check the [The size and the number of
attachment files are limited] check box,
and enter the [Limit size] and [Limit
number of files].

O ciick [0K].

(Note!) When the limit size is exceeded for 1
file, a mail is sent notifying that the
attachment cannot be sent.
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Carrying over the unused
print limit quantity

2ix
" Job Accourt D | Use Restrictions ~ Limit Value | Usage Status |
¥ Pinted Sheets |10‘J sheets
I~ Fees |D Anas]
I™ | Staple ID staples
~Valid Pesiod
|ty month =l
To 10/31/2011
W Lany over unused value to the next valid penod

[ox ] _cancd |

When the [Carry over unused value to the
next valid period] check box is checked,
and the printer use limit value is not
exceeded, the unused amount can be
carried over to the next valid period.

In the example in the figure, if a user who
has a limit of 1,000 sheets per month only
prints 500 sheets, they can then print
1,500 sheets the following month.

/‘_“

Unused value

Limit value 500 sheets 1,500 sheets
1,000 sheets Printed value
500 sheets '

Current month Next month

(1] Start the server software.

@ Click the plus mark on the left side of
[Printer] in the selected window.

The printer tree opens.

O sclect the printer/printer group to be set
in the selection window, and double-click
it.

O Click the [User] tab.
@ sclect the user to set, and double-click it.

O check [Carry over unused value to the
next valid period], and click [OK].

To seémultiple users, repeat steps 3

and

@ Click [OK].

(8] Click [OK] in the [Job Account ID
registration] window.

O 1n the [Properties of printer from which
logs are acquired] window, click [OK] to
close the printer properties.
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Deleting a registered printer

To remove a printer from management by
Print Job Accounting because the printer
is to be moved or scrapped, delete the
printer from the server software before
moving or scrapping it.

© Check that the printer power is ON.
@ start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

t_f_;',. Print Job Accounting Enterprise

Fie Printer Log Policy Option Help

O sciect the printer that you want to
delete, and then select the [Printer]
menu > [Start/End Log].

Multiple printers can be selected.

t__';'_, Print Job Accounting Enterprise

File Log Policy Option Help

=-f  AddaPrinter...

Manage multiple printers as a group...
Delete a Printer /Printer Group

G- Change a Printer Group. ..

Acquire a Log t!

Setting the Time

Define Fees...
Backup of printer setting...
Properties...

O ciick [Yes] in the end log acquisition

confirmation window.

(Note!) When the following window is displayed,
a connection cannot be made to the
printer.

In this case, always click [No] and
connect to the printer before trying
again.

Print Job Accounting Enterprise i ll

W% Unable to connect with a printer.
L ) The configuration on the printer will not be changed, changes will
= only apply on the PC. Is it OK?

@ When the "Please enter the administrator

password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

(Note!) Depending on the printer, this may not
be displayed.

Print Job Accounting Enterprise ﬂﬂ

Pleaze enter the adminiztrator pagzword of the printer.

Fazzword IT
Cancel |

@ Check that the printer [Status] field in

the details window is [Not acquired].
[ 2 Pl Job Acvmmtima bnterprne -1

Prver | Addvess | ol [ Siwks I I

MCS61{192. 368.0.7) WCEEL 190.168.0.2 I Mobsopared  ME2011 93448 PM
5 Log
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O select the printer you want to delete,
and select the [Printer] menu > [Delete a
Printer/Printer Group].

t__‘;’_, Print Job Accounting Enterprise
File Log Policy Option Help

I_;l--F Add a Printer...
Manage multiple printers as a group...

Delete a Printer Printer Group h
F-I' Change a Printer Group...
Start/End Log

Acquire a Log

Setting the Time

Define Fees...

Backup of printer setting...
Properties...

O ciick [Yes] in the delete printer
confirmation window.

(0] Specify the items to delete, and click
[OK].

@ When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

(Note!) Depending on the printer, this may not
be displayed.

@ 1n the user ID delete confirmation
window, click [Yes] to delete the Job
Account ID from the registered printer, or
click [No] to keep the Job Account ID for
the registered printer.

® 710 delete the logs acquired until now by
the server software, click [Yes] in the log
delete confirmation window, or click [No]
to keep the logs in the server software.

Changing the printer
connection destination or IP
address

To change the printer connection
destination or IP address, change the
server software settings.

© Check that the printer power is ON.
@ start the server software.

O Click the plus mark on the left side of
[Printer] in the selected window.

The printer tree opens.

O sclect the printer, and then select the
[Printer] menu > [Properties].

O 1n the [Printer] tab, click [Change Address].
2|

Priter | User | Option |

Pinter Name |mC3st
Address 192.168.0
Log Acquired
Printer Group INot in a group ;l
Acquire Infomation. .. |
ok | Canced |

0O 1 change the connection destination,
select the connection destination from
the list and click [OK].

To change the IP address, enter a new IP
address, and click [OK].

Change Address x|

Acddress [ TCP/IP Network |

P Address

|1E|2.1EB.D.3

Cancel |

@ 1n the [Properties of printer from which
logs are acquired] window, click [OK].
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Automatically reconnecting
when the printer IP address
is changed

When the printer IP address is changed,
the new IP address can be automatically
connected, and the log can still be
acquired. This is effective when the

IP address is dynamically assigned in
the DHCP environment, or when the
administrator changes the IP address.

O sclect [Option] menu > [Setup].
@ Ciick the [Ports] tab.

© Check the [Auto Reconnect] check box.
21|

Mad petup | Emad Adress | Mad detad setwn | Lo Sterage | Changs the closng date | Database Pots |

HTTPW'HIIM-' IECI
|2,| How Scops... I
1~ Othes setup
Huribeet of printers connected ol the same e |1w 1100)
] o= |

O Enter the interval (unit: hours) at which
the IP change is checked.

O click [0K].

Perform the following steps to change
the range in which a printer whose IP
address is changed is searched for.

(1) Click [Scope].

® o add a search range, enter the
broadcast IP address of the search range
you want to add into [New Scope], and
click [Add].

21|
Mew Scope;
T30 1601 255 ........... e
Scope:
[Elete
Ok
Cancel

¥ Dizcover the local subnet

® 7o delete a search range, select the
search range that you want to delete
from [Scope], and click [Delete].

o To search the local subnet, check the
[Discover the local subnet] check box.

O ciick [0K].
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To change the server to a
different computer

To change the server that acquires the
current log to a different computer, delete
the printer on the current server, and then
re-add it to the new server.

If the current server cannot be used due
to a malfunction etc, perform the following
operations on the new server.

© Check that the printer power is ON.

(2] Start the server software on the new
server.

O sclect the [Printer] menu > [Add a
Printer].

@ Follow the instructions on the screen to
add the printer.

@ Wwhen the server ID input window is
displayed, enter the server ID of the
server that acquires the current log, and

click [OK].
Print Job Accounting Enterprise 2%
i i ot o St e o903 e et 110 a0 1 i srver o
Server 10 l—
=] _owes |

O continue setup by following the
instructions on the screen.

Checking the server ID

0 Start the server software.

® sclect [Help] menu > [Server ID].

Pie Printer Log Polcy Opson
= i [roal 00000 icaume 1803
i Leg | e

| o B Loz . L]

2] —

3 il

|

® Check the server ID, and click [OK].
X

Server ID is "19365". This ID will be required if a printer is added to this
utility on another PC before being deleted from this PC. Please take a note
of the ID.
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Installing/Zuninstalling a
built-in hard disk or SD
memory card to the printer

O sce "Deleting a registered printer"
(page 230), and delete the printer
registered in the server software.

@ A built-in hard disk or SD memory card
can be installed/uninstalled to the printer

O Add the printer again to the server
software.

Prohibiting initialization of the
built-in hard disk, SD memory
card, or flash memory

When the built-in hard disk, SD memory card,
or flash memory of the printer are initialized,
previous log obtained from the server
software is deleted. Also, as user information
is also deleted from the printer, the server
software cannot acquire the correct log. When
Print Job Accounting is used, it is necessary to
configure the settings so that the built-in hard
disk, SD memory card, and flash memory
cannot be initialized.

© Check that the printer power is ON.
@ start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

O sclect the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.

O 1n the [Option] tab, check the [Inhibit the
initialization of the Hard Disk and Flash
Memory] check box.

Properties of printer from which logs are acquired ] _?lll
Acquire Logs
& |nterval
IS Haur 0 Minutes
" Time
Lhiznge Time... I
Fees settingd ;I
LDetne fees.. I
Operation &t Log Ful | pejete old logs ;I
[ {inkibit the iritialization of the Hard Disk and Flash Memons
Auto Export Logs I Do not automatically export ;I
T Berardlans in & dstahaze
Chck [Detad setting] to cooperate with Dietal setti
Active Di & l setting... I
ok | Canced |

O ciick [0K].
The printer built-in hard disk, SD memory
card, and flash memory can no longer be
initialized.
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Operations when the log is
full

The processes when the printer log buffer
is full before the log is acquired by the
server software can be set.

© Check that the printer power is ON.
(2] Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

O sclect the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.

O 1n the [Option] tab, change [Operation at
Log Full].

Properties of printer from which logs are acquired _?IZI

| Printer | User  Option |

Acquire Logs
& |nterval
IS Haur ]U Minutes
! Time
Lhznge Time:. I
Fees settingl ;I
LDetne fees.. I
Dperation at Log Full I Delete old logs ;l
¥ Inhibit the initializatiol D & ot acquire the log
Delete old logs
Auto Export Logs I Do not automatically export ;I
IT Brenrd lags it~ datahase
Chick [Detad zetting] to cooperate with Dietad setti
pli . d setting... I
ok | Cancel |

Delete old logs

The oldest log is deleted, and the new log is
received.

Cancel the job

All subsequent print jobs are cancelled.

Do not acquire the log

The log is not obtained for subsequent print jobs.

O ciick [0K].

Updating setting information
when an option is installed
(Only Enterprise edition)

When an option is added to a printer,
information can be acquired from the
printer, and the setting information
updated. When an SD card is installed
in the printer for receiving the IC card
compatibility table after the printer

is registered in the server software,

it is necessary to update the setting
information in the server software.

© Check that the printer power is ON.
(0] Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the details window.

t__'_;',. Print Job Accounting Enterprise

File Printer Log Policy Option Help
..

[+-Log

O sclect the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.
t__';; Print Job Accounting Enterprise

File Log Policy Option Help
=-F  Add a Printer...

Manage multiple printers as a group...
Delete a Printer Printer Group

G- Change a Printer Group...

Start/End Log

Acquire a Log

Setting Ehe Time

Define Fees. ..

Backup of printer setting. ..

Properties...
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(5] Display the [Printer] tab, and click
[Acquire Information].

O ciick [OK]. To browse the updated setting
information, repeat the steps from 0w

inter from which logs are acquired

Changing the number of
printers connected at the
same time

The number of printers connected at the
same time can be changed. When the
number of printers connected at the same
time is set to a small value, the amount of
processing done by the computer for this
software is reduced.

0 Start the server software.

® Click the [Option] menu > [Setup].

% Print Job Accounting Enterprise

-- Prinker
[+ Log
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(4] Change [Number of printers connected at
the same time].
T JETE

Mailsetup | E‘mail Addiess | Mail detall setup | Log Starage | Change the closing date | Database Farts |

~ BB200/B6300 sstting

HTTF port number 20

[~ #uto Reconnect

™ Auto Reconnact

et 5 Heur Seeen |
|- Other setup
MNumber of printers conrected at the same time [1~100]
-

O ciick [0K].
sere 2l

Mail setup | E-mail Addiess | Mail detail setup | Log Storage | Change the closing date | Database  Ports |

[~ BE200/BE300 setting

HTTF port number 20

[~ Auto Reconnect

I Auto Reconnect

Chech liervel 24 Hour Seope
-~ Other setup
Murnber of printers connected at the sams time 100 [~100)

Export job information in
a file if this utility acquires
logs

Job information in a log can be recorded
in a file when the log is acquired from the
printer. This setting is required to add job
information from the log (pages 77, 84,
87 and 91) if use restrictions are set for
the job information. When this setting

is disabled, the load of processing by

this server software on the computer is
reduced.

“ Start the server software.

(2] Click the [Option] menu > [Setup].

%% Print Job Accounting Enterprise
File Printer Log Policy | option Help

-- Prinker
+-Log

(3] Display the [Ports] tab.

2

Mail setup | E-mail Address | Mail detail setup | Log Storage | Change the closing date | Databafle FPorts |

[~ BE200/BE300 setting

HTTP port number 20

[~ Auto Reconnect

™ Auto Recornect

[Chesk Iteryal 24 Hiur, Scope..
[~ Other setup
Mumber of printers connected at the same time 100 [1~100)

™ Export job infamation in a file if this utiliy acquitss logs

Cance
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O cCheck the [Export job information in a file
if this utility acquires logs] check box.

@ ciick [0K].
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Uninstalling software

Uninstalling server software

When uninstalling the server software,
always delete the registered printers first
before uninstalling the server software.

0o See "Deleting a registered printer"
(page 230), and delete the printer
registered in the server software.

9 Exit the server software.

(3] Select [Start] > [All Programs] >
[Oki Data] > [Print Job Accounting] >
[Uninstall Print Job Accounting]. When
the [User account management] window
is displayed, click [Continue] or [Yes].

(Note!) When the following window is displayed,

the printer is not deleted. Always click
[No] to cancel the uninstallation, then
delete the printers before uninstalling
the server software.

Eror £

W% A printer registered for log acquisition stil exists, If Uninstallation
L ) is executed now, the information will be left in the printer. Do you
—  want to continue?

9 Follow the instructions on the screen to
uninstall.

@ ciick [Finish].

Uninstalling the client
software (Windows)

O i the client software is running, exit it.

(2] Select [Start] > [All Programs] > [OKki
Data] > [Print Job Accounting Client] >
[Uninstall Print Job Accounting Client].
When the [User account management]
window is displayed, click [Continue] or
[Yes].

9 Follow the instructions on the screen to
uninstall.

O ciick [Finish].

Uninstalling plugins (MacOS)

When the printer drivers are uninstalled,
the plugins are also uninstalled.

Uninstalling client software
(Mac OS X)

Delete the Print Job Accounting icon that
was copied to the desired location during
installation.
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Memo
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13. Troubleshooting

13.Troubleshooting

This chapter explains some of the problems that could possibly occur when using Print Job
Accounting, and provides hints to their solutions.

Item Details
Cannot find the printer e Check that the printer power is ON.
even when searching e Check whether the printer is processing or offline,
using [Add a Printer]. or whether an error has occurred (no paper etc).
Check that the printer is online, and click [Start new
search].

= Click [Back], and check that the correct search
option check boxes are checked.

=\When the search target is [TCP/IP Network], check
whether the broadcast address is correct. If it is
unknown, contact the network administrator.

* The printer does not support Print Job Accounting.
Check the type of printer connected to the
connection destination.

= If the [Do not allow exceptions] check mark is
checked in the Server 2003 SP1 or later firewall
settings, printers cannot be searched beyond
the router segments. Therefore, in the Add log
acquisition printer wizard, select [Specify the printer
by address], select [Address] > [TCP/IP Network],
and enter the IP address directly.

When a printer connection | The printer does not support Print Job Accounting.
destination is specified Check the type of printer connected to the connection
using [Add a Printer], the | destination.

error "Printer does not
have the log acquisition
capability" is displayed.

When adding a printer, There is not enough free space in the printer built-in
"There is no sufficient hard disk, SD memory card or flash memory.
capacity to store a log" Secure the appropriate amount of free space.

error is displayed.

When adding a printer = Check that the printer power is ON.

or changing settings, e Check whether the printer is processing or offline,
or when immediately or whether an error has occurred (no paper etc).
acquiring a log, the Check that the printer is online and try again.

"Cannot connect to the
printer. Wait for a while
and try again.", "Unable
to communicate with the
printer. Please check the
printer.” or "The printer
is busy. Wait for a while
then try again” message
is displayed.
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Item

Details

When creating a CSV file
to register Job Account
IDs and Names in a
batch, "An error was
found in the import

file" error message is
displayed.

e Check whether the CSV file format is correct.

* Check that the names and Job Account IDs do not
exceed the registration range. The Job Account ID
is registered from 1 to 999999999, and the User
Names within 80 characters.

= Check that the " symbol is not included in names.
Names that include " cannot be registered.

When the ID file for
setting the hide mode
in the client software

is imported, "An error
was found in the import
file" error message is
displayed.

e Check whether the CSV file format is correct.

* Check that the User names and Job Account IDs do
not exceed the registration range. The Job Account
ID is registered from 1 to 999999999, and User
Name within 80 characters.

= Check that the " symbol is not included in user
names. Names that include " cannot be registered.

When printing, the print
job is automatically
cancelled and cannot be
executed.

e Check whether the Job Account ID of the print job is
"Disable Printing" or "Disable Color Printing".

* Check whether the limit value for the Job Account
ID is exceeded, and check the limit values and valid
period.

= The operation when log is full is set to "Cancel
the job", and the printer log buffer is full. Select
the printer, and then select the [Printer] menu >
[Acquire a Log] to acquire the log. Next, reset the
log acquisition schedule to a shorter time.

The log cannot be
acquired according to the
set schedule.

Select the printer, and then select the [Printer] menu
> [Acquire a Log]. When an error is displayed, check
that the printer power is ON. Also, check whether the
printer is processing or offline, or whether an error
has occurred (no paper etc).

When the log is acquired correctly, check the log
acquisition schedule. Check that the acquisition time
is at the same time as when the printer and server
power are usually ON. If there are no problems in the
above settings, restart Windows.

Not all of the logs are
acquired.

The printer's log buffer is full when the operation
for when the log is full is set to "Delete old logs" or
"Do not acquire the log”, Reset the log acquisition
schedule to a shorter time.

Some logs are not
displayed at the start time
or end time.

If the printer model does not have a built-in clock,
when the printer power is switched OFF/ON, time
information cannot be stored in the log until the
printer is notified of the time. For details on how

to notify the printer of the time, see "Notifying the
printer of the time" (page 196).

For models that have a built-in clock, the time needs
to be set in the printer.

- 243 -




13. Troubleshooting

Item

Details

When attempting to
delete a printer, "Cannot
delete while log is being
acquired" message is
displayed.

A printer cannot be deleted while the log is being
acquired. Select the printer that you want to delete,
select the [Printer] menu] > [Start/End Log] to end
acquiring the log, and then delete the printer.

When [Acquire a Log]

is performed, "Select

to start log before
attempting to acquire a
log" message is displayed.

The log is in the unacquired state. Select the printer
whose log you want to acquire, and select the
[Printer] menu > [Start/End Log] to start acquiring
the log. Logs can be acquired after starting.

When [Acquire a Log]
is performed, "This task
cannot be performed
while acquiring a log"
message is displayed.

The log is acquired according to the log acquisition
schedule.

Wait for a while to check whether the log is acquired.
If "Log acquisition schedule..." is shown for a long
time, restart Windows.

In the printer [Log] field
of the details window,
[Acquire from different
server] is displayed.

Either the log is set to be acquired by a different
server, or the printer flash memory was initialized.
Select the printer, and then select [Printer] menu >
[Delete a Printer/Printer Group] to delete the printer,
and then follow the steps in [Printer] menu > [Add a
Printer] to re-add the printer. If the printer is set to
acquire the log from a different server, see "To change
the server to a different computer” (page 233).

Cannot perform menu
printing or demo printing
from the control panel of
the printer.

= Check whether the local printer is set to printing
prohibited or color printing prohibited.

= Check the limit values and valid period to ensure
that the local print limit values are not exceeded.

Cannot initialize the flash
memory from the printer
control panel. Also, the
hard disk or SD memory
card cannot be initialized
for models equipped with
an internal hard disk or
SD memory card.

When using the Print Job Accounting, check the
[Inhibit the initialization of the Hard Disk and Flash
Memory] check box in the server software. In this
state, the flash memory, built-in hard disk and SD
memory card cannot be initialized. Follow "Deleting a
registered printer" (page 230) to delete the printer,
and then initialize the flash memory, built-in hard
disk or SD memory card. After initializing, select the
[Printer] menu > [Add a Printer], and follow the steps
to re-add the printer.
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